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Preface

Intended Audience
Welcome to Release 12.1 of the Oracle Depot Repair User Guide.

See Related Information Sources on page xii for more Oracle E-Business Suite product
information.

Deaf/Hard of Hearing Access to Oracle Support Services

To reach Oracle Support Services, use a telecommunications relay service (TRS) to call
Oracle Support at 1.800.223.1711. An Oracle Support Services engineer will handle
technical issues and provide customer support according to the Oracle service request
process. Information about TRS is available at

http://www fcc.gov/cgb/consumerfacts/trs.html, and a list of phone numbers is
available at http://www.fcc.gov/cgb/dro/trsphonebk.html.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation accessible
to all users, including users that are disabled. To that end, our documentation includes
features that make information available to users of assistive technology. This
documentation is available in HTML format, and contains markup to facilitate access by
the disabled community. Accessibility standards will continue to evolve over time, and
Oracle is actively engaged with other market-leading technology vendors to address
technical obstacles so that our documentation can be accessible to all of our customers.
For more information, visit the Oracle Accessibility Program Web site at
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The

Xi



conventions for writing code require that closing braces should appear on an otherwise
empty line; however, some screen readers may not always read a line of text that
consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

Structure

This documentation may contain links to Web sites of other companies or organizations
that Oracle does not own or control. Oracle neither evaluates nor makes any
representations regarding the accessibility of these Web sites.

1 Introduction to Oracle Depot Repair

This chapter discusses the key concepts, features, and process flows of Oracle Depot
Repair.

2 Overview of Using Oracle Depot Repair

This chapter provides an overview of the user interface and the major tasks that you can
perform using Oracle Depot Repair.

3 Oracle Depot Repair Business Scenarios

This chapter describes working with different service depot repair business scenarios.
4 Depot Workbench

This chapter describes task-based procedures for different processes that a user can
perform to fulfill responsibilities.

5 Repair Manager Portal

This chapter outlines the broad set of capabilities that a repair manager performs in the

course of normal repair center operations.

6 Recalls
7 Returns Dashboard
8 Receiving Returns using the Bulk Receiving Module

This chapter describes how to easily receive items into the depot that arrive with or
without an RMA.
9 Executing Repairs using the Repair Technician Module

This chapter describes an enhanced set of operations to process repair items.

Related Information Sources

Oracle Depot Repair Implementation Guide

Integration Repository

xii

The Oracle Integration Repository is a compilation of information about the service
endpoints exposed by the Oracle E-Business Suite of applications. It provides a
complete catalog of Oracle E-Business Suite's business service interfaces. The tool lets



users easily discover and deploy the appropriate business service interface for
integration with any system, application, or business partner.

The Oracle Integration Repository is shipped as part of the E-Business Suite. As your
instance is patched, the repository is automatically updated with content appropriate
for the precise revisions of interfaces in your environment.

Do Not Use Database Tools to Modify Oracle E-Business Suite Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle E-Business Suite data
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as
SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of
your data and you lose the ability to audit changes to your data.

Because Oracle E-Business Suite tables are interrelated, any change you make using an
Oracle E-Business Suite form can update many tables at once. But when you modify
Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you
may change a row in one table without making corresponding changes in related tables.
If your tables get out of synchronization with each other, you risk retrieving erroneous
information and you risk unpredictable results throughout Oracle E-Business Suite.

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite
automatically checks that your changes are valid. Oracle E-Business Suite also keeps
track of who changes information. If you enter information into database tables using
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
record of changes.

xiii
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Introduction to Oracle Depot Repair

This chapter discusses the key concepts, features, and process flows of Oracle Depot
Repair.

This chapter covers the following topics:
*  What is Oracle Depot Repair?

® Oracle Depot Repair Key Features

* Business Process Flows

® Setup Parameters

¢ Integration with Other Oracle Modules

What is Oracle Depot Repair?

Oracle Depot Repair is part of the Oracle E-Business Suite and offers an enterprise-wide
solution for managing depot repair processing. It targets the repair business market
from simple, quick repairs to routine maintenance. Oracle Depot Repair integrates with
other Oracle E-Business Suite modules to provide an integrated comprehensive solution
for the repair business sector.

The depot repair process includes the return of broken and serviceable items, their
diagnoses and repair job estimates, customer approvals and repairs management, and
subsequent return of items to customers. You use the collection of charges for materials,
labor, and expenses for the repairs to invoice the customer.

The depot repair process also includes the processing of item refurbishments, where the
items either belong to an internal party, or the items are received from a field service
warehouse and then returned to the warehouse after repair.

Customers expect quick and seamless repair processing. Oracle Depot Repair provides
end-to-end repair management functionality for service organizations that are
committed to delivering a total service solution.

Oracle Depot Repair enables service organizations to meet customer expectations, and
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draw maximum benefit by improving service readiness.

Oracle Depot Repair Key Features
The major features of Oracle Depot Repair include:

¢ Customer Management, page 1-2
* Service Request Management, page 1-2
* Repair Type Processing, page 1-2
* Repair Job Management, page 1-2

¢ Repair Resolution Management, page 1-2

Customer Management

Oracle Depot Repair can use a call center environment to improve customer interaction
with service depots. Customers can use an access number to contact the relevant service
depot where they can log Service Requests. The primary focus of the service
representatives in the call center is to understand the customer's issue and resolve it on
the first call, if possible, thereby avoiding escalations or call transfers. This lets service
agency experts focus on their areas of expertise without the constant distraction of
explaining well-documented issues and solutions.

Oracle Depot Repair also supports scenarios in which customers walk in at service
depots for repair needs.

Oracle Depot Repair provides service organizations with the right tools and knowledge
for responding effectively to the repair issues that customers have.

Key customer management features include:

Oracle Depot Repair Workbench

The Repair Orders window in Oracle Depot Repair provides the service agent instant
access to information about the customer and enables the agent to effectively address
the needs of the customer. The customer Profile menu option enables service agents to
view the number of open Repair Orders, open Service Requests, active contracts, and
other details for a selected customer. In the Find Repair Orders window, service agents
can query for Repair Orders, to see the Repair Order statuses, repair jobs, and repair
tasks.

Relationship Management

Oracle Depot Repair lets service agents capture the contact's relationship with others in
the concerned organization, or other organizations, enabling service agents to engage
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knowledgeably with customers and other service agencies.

Customer Data Store

Oracle Depot Repair enables service agencies to maintain a comprehensive database of
all customer interactions with the agency. Oracle Depot Repair maintains detailed
service history to trace the origin of a repair issue and the follow up actions that solved
it.

Service Request Management

Oracle Depot Repair enables service agencies to offer customers the convenience of
accessing service through telephone or over the counter. Key Service Request
management processes include:

¢ Entering Service Requests

® Searching the Oracle Knowledge Management Database

Service Request Builder

Oracle Depot Repair lets you enter new Service Requests to gather appropriate data. It
lets service agents record customer information and attempt problem resolution to solve
issues in the very first interaction.

Searchable Oracle Knowledge Management Database

Oracle Depot Repair makes available a database of solutions, which the service agents
can search with a view to solving the problem while the customer interaction is in
progress. The Oracle Knowledge Management database can also provide information,
such as guides, policies, procedures, and FAQs.

Where the problem affecting the current Repair Order item is matched up with the
solution in the Oracle Knowledge Management database of a similar problem, Oracle
Knowledge Management can assist in the Repair Order processing, by providing charge
lines for WIP and Task estimates, and Bills and Routings for WIP Repair Jobs.

Repair Type Processing

Oracle Depot Repair provides Repair Types that enable service providers to be more
efficient in managing the repair through process automation. Repair Types help to
classify the Repair Order and determine the repair management processes and logistics
to fulfill the repair process.

Oracle Depot Repair supports the following Repair Types:
¢ Repair and Return, page 1-2

* Loaner, Repair and Return, page 1-2
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e Exchange, page 1-2

¢ Advance Exchange, page 1-2
* Loaner, page 1-2

* Replacement, page 1-2

¢ Standard, page 1-2

® Refurbishment, page 1-2

Repair and Return

Use this Repair Type when a customer returns the broken or damaged item to the
service depot for repair. After completion of the repair, you return the repaired item to
the customer. This Repair Type requires:

e A return materials authorization (RMA), or Return line, to receive the customer's
broken or damaged item.

e A Sales Order, or Ship line, to ship the repaired item and invoice the customer.

Loaner, Repair and Return

This Repair Type combines two Repair Types, the Repair and Return, with the Loaner.
The loaner concept indicates that service depot sends the customer the loaner before the
receipt of the customer's broken or damaged item. To track the shipping and return of
both the loaner and the broken or damaged item, the system creates four charge lines.
This Repair Type requires two RMA Orders and two Sales Orders. Use this Repair Type
when a customer uptime is critical.

Exchange

This Repair Type represents a scenario when the service depot sends an exchange item
to the customer after receiving the customer's broken or damaged item. The Exchange
Repair Type assumes that the repaired item does not return to the customer. The system
can generate an internal Repair Order for the returned item, but there is not necessarily
an association between the repaired item and the original exchange item.

Advance Exchange

This Repair Type is the same as the Exchange Repair Type except that the service depot
can send the item to the customer before the service organization receives the
customer's broken item.
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Loaner

Replacement

Standard

Refurbishment

Use this Repair Type when the service depot sends an item to the customer solely for
the purpose of renting. This Repair Type requires a Sales Order to ship the loaner item
to the customer and to create an invoice, and an RMA order to track the return of the
loaner item. A deposit and return due date may be a requirement. The customer has no
expectation of repairs.

A Replacement Repair Type refers to a scenario when the service depot sends an item to
the customer without expecting a return. In this scenario, the service provider sends the
customer an item to replace the customer's item. The service organization can:

* Link the replacement item to the original item in the Installed Base.

¢ Change the status of the replaced item to indicate that it is out of service and that
the new item has replaced it.

Use this Repair Type when the service agent is uncertain about the customer's needs.
This Repair Type is flexible however, and requires the manual creation of RMAs and
Sales Orders.

A Repair Order and its associated Service Request can be created in the Spares
Management of Oracle Field Service as a result of a demand for refurbishment or
replenishment. The Repair Order has a Repair Type of Refurbishment, and has two
transaction lines, Move In and Move Out.

The Move In line tracks the shipment of the defective item from Spares Management,
and its reception into the depot. The Move Out line processes the shipment of the
repaired item back to Spares Management.

The processing of Move In and Move Out lines leverages existing Internal Order and
Internal Requisition functionality. From the depot's perspective, defective items are
received via the Internal Requisition, and usable/repaired items are shipped via the
Internal Order.

Repair Job Management

Use either of the following repair modes to manage repair jobs:

e WIP (Work In Process): Recommended for use when the repair jobs require a series
of sequential steps and materials management. The WIP mode leverages the costing
of items through Oracle Costing.
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e Task: Recommended for use when the repairs require minimal steps that do not
necessarily require a series of sequential steps. In contrast to WIP mode, Task mode
does not integrate with Oracle Costing.

You implement and manage either of these repair modes on separate tabs in the Oracle
Depot Repair area.

During implementation, you associate the WIP or Task mode with Repair Types.
Though a service organization can have different Repair Types associated with different
repair modes, it is recommended that a service organization select only one repair mode
for all Repair Types to enhance usability.

Repair Resolution Management

Oracle Depot Repair improves operational efficiency by providing the following key
repair resolution management features:

® Repair job search functionality.

® Process automation based on Repair Type, such as automatic creation of charge
lines.

* Estimate creation and approval.

® Leveraging of the service depot knowledge base throughout repair processing.
® Repair job creation and release to shop floor.

* Flexible options for receiving items and shipping items.

¢ Invoicing of final charges.

Business Process Flows

Oracle Depot Repair supports the following business process flows:

* Logistics and Maintenance with Call Center Facility, page 1-6

* Logistics and Maintenance without Call Center Facility, page 1-6

* Internal Repairs, page 1-6

You can use either Oracle Work In Process (WIP) or the Task Manager (in Oracle
Common Application Components) to manage the repair process. Based on your

choice, the Repair Type for a given Repair Order determines which repair management
process to use.
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Logistics and Maintenance with Call Center Facility

This business flow starts with a Service Request, where the call center service agent
records a problem. If the service agent cannot resolve the problem using information in
Oracle Knowledge Management, the service agent refers the Service Request to a
service depot repair agent. The service depot agent can then create a Repair Order and
an estimate (if required) and seek approval from the customer for further processing.

Depending on the Repair Type, the service depot repair agent completes the different
RMA and Sales Order lines to assist the completion of the repair process. The repair
mode (associated to the Repair Type) determines whether to use Oracle WIP or the Task
Manager in Oracle Common Application Components to manage the repair job. After
the repair completion, the service depot returns the repaired item to the customer. The
system captures the material, labor, and expenses that the repair needed as charges and
transfers that information to Oracle Order Management for invoicing.

Logistics and Maintenance without Call Center Facility

This process is similar to the Call Center, Logistics, and Maintenance business process
except that there is no call center.

Businesses that do not incorporate a call center facility, or those that integrate their call
center into the depot, can use this process, but it requires that their customers to send
serviceable items directly to a service depot.

Internal Party Repairs

You can refurbish items that your organization already owns or repair an item that your
organization took possession of through a field service agent instead of against an
RMA. Oracle Depot Repair lets you process internal repairs in such cases. The customer
is an internal party in the corresponding Service Request. RMAs and Sales Orders are
not required to process internal repairs. This is under the assumption that items already
exist in a subinventory within the organization letting you create repair jobs.

Setup Parameters

Depot Repair provides a setup screen that allows administrators to select application
configuration options using simple Attribute-Operator-Value (A-O-V) rules. The new
setup parameters allow administrators to default values and system behavior based on
A-O-V rules and not relying on fixed profile values. Explanatory text is available on the
page to make setup and maintenance easier. Dependencies between options are made
explicit and clear to understand.

As the Depot Repair application relies on integrations with many other CRM and ERP
applications, the setup parameters allow the administrator to setup profiles from other
applications that are required for successful depot business flows.
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Depot Repair provides the ability to automate the disposition of products and the
assignment of repairs to specific resources based on the following two customer defined
rules:

Defaulting Rules Engine

Repair queue, repair owner, priority and other repair order values default at the time of
repair order creation based on customer defined rules. The fields that default are:
Inventory Organization, RMA Receiving Organization, RMA Receiving, Subinventory,
Repair organization, Repair Owner, Repair Priority, Repair Type, Ship from
Organization, Ship from Subinventory, and Vendor Account. Rules are based on repair
item, repair location, customer, contract, and the like.

Setting up Defaulting Rules

To set up defaulting rules

1.

2.

3.

Navigate to the Defaulting Rules page. This page displays the summary of existing
defaulting rules.

ORACLE" DepotRepair

Home Logout Prefer

Defaulting Rules
= Indicates required field
save | | save search
Find Defaulting Rules
Note that the search is case insensitive Advanced search
Entity Q Rule Name Q
Attribute Q Frecedence
Go | [ clear
=Precedence = |“Name |pescription [Entity [*Defaulted Attribute [*value Type |Details Duplicate Remove
1||Deme Defaulting Rules Item = CSDO01 => repair priority = high Repair Order Repair Priarity Q [awibue @ B (=] o
1||Dema Defaulting Rules (duplicate) || Item = CSD002 => repair priority = high Repair Order Repair Priority Q awribue @ E [E] o
1|[ship from subiny ship from subinv Repair Order| Ship From Sub-Inventor] O [Atribute [ [ [[E] i}
1||vendor account Vendor account Repair Order Vendor Account Q (aribue @ E (] @
1| |vendor account SR item= CSD001 => vendor =1001 Repair Order Vendor Account Q (awribute @ E [FE] a
Add Another Row
save | | save Search

Home Logout Preferences

Privacy Statement Copyright (c) 2006, Oracie. Al right resenved.

To set up a new defaulting rule, click Add Another Row button.

Enter the values in the following fields:

® Precedence: Each rule is assigned a Precedence. Rules are evaluated in the order
of precedence - the smaller the number, the higher is the precedence. The
Precedence field accepts both positive and negative values.

¢ Name: Name of the defaulting rule
® Description: Description of the defaulting rule

e Entity: Defaults from the system

1-8 Oracle Depot Repair User Guide



e Defaulted Attribute: The value of this field defaults when a defaulting rule is
applied to a repair order.

The list of values for Defaulted Attribute are:

* Inventory Organization

¢ RMA Receiving Organization
* RMA Receiving Sub-Inventory
® Repair Organization

¢ Repair Owner

* Repair Priority

® Repair Type

e Ship From Organization

¢ Ship From Sub-Inventory

Vendor Account

* Value Type: It lists attributes whose values default using Defaulting Rules.
Valid list of values for Value Type are:

e Attribute: This enables the user to specify a value from a dynamically
generated list of values for the Defaulted Attribute. This list of values is
generated based on the selection in the Defaulted Attribute.

e PL/SQL API: This defaults the value returned from a call to the specified
PL/SQL API to the Depot Workbench when this rule is evaluated to be true.

e Profile: When you select profile as the value type and there are multiple
levels of profile setting (for example, profile values set at the User level and
at the Responsibility level), the system behaves the way it does for other
profile option selections. This means it defaults from the most specific level
that has been set (in this example, giving the User level setting precedence
over the Responsibility level setting).

4. Click the Details icon to navigate to the Update Defaulting Rule page.
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ORACLE Depot Repair

Defaulting Rules >
Update Defaulting Rule
The default vakie will be applied according 1o the Frecedence valke set for the defaulting rule. cancer] [save | | Agpt
Bl o} [CTEARRTET
* Rulle Name [Defaulting Rules Tt
Description [yendor account
* precedence [0
Defaulted Atrbute Vendor Account
Entity Repair Order
value Type  Attribute
* yendor Account 1000 Q
iorld of Business.
Defaulting Conditions
The rule atribute will only be defaulted if all of the conditions are true,
Name Details Remove
Mo results found,
Add Another Row
Cancel | [ save | [ Apply

Home Logout Preferences

This page displays the details of the defaulting rule you entered. Use this page to
specify a value for the defaulted attribute and the conditions to trigger the rule.

5. In the Defaulting Conditions region, click Add Another Row to enter a
self-explanatory name for the condition.
Defaulting Conditions region enable you to define one or more conditions for a
defaulting rule. All the conditions must evaluate to true to execute the defaulting
rule.

6. Click Apply to save your work and navigate back to the Defaulting Rules page.

7. Click Save to save the Defaulting Rule.

8. Duplicate icon duplicates the condition.

9. To delete a defaulting rule, click the corresponding Remove icon in the Defaulting
Rules page.

Using Defaulting Rules

To use defaulting rules

1. Navigate to the Depot Repair Workbench and click the New button to navigate to
the Repair Orders page.

2. Create a new Service Request and click Save. See: Create a Service Request, page 4-
12.

3. Create a new repair order for the item for which you have set the defaulting rule.

See: Create a Repair Order in the Depot Repair Workbench, to create a repair order.
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Eile Edit Wiew Folder Tools Data Window Help ORACLE
AP0 U LBaP L IDEL AO0H5% R 2

O Re ster =
Service Request Information
Customer Type |Organization  ~ Contact Type | Relation - Installed terns Only Reguest Mum 74596
Customer |Business World Contact Andre Beaulie-Bu lterm |CE0001 test =
Summary
Account 1608 Relationship |Contact Far Revision -
Phone |B50555 555 Teler Contact D 2817 Instance Request Type Depnt Repair
Bill-To 23971 L Street, S Phone |1800555-83 Teler Setial Num Severity  High
Ship-To [2391 L Street,, & Email |nobodyi@localhos Opened | 11-JUN-2008 21:2 Status  Open
Mew Contact... Closed Owner | Anderson, Steve
Repair Order Infarmation Repair Estimate
Repair Murn Repair Type ltem Itern Description UOmM Qty Status Anproved
Advance Exchangel - (CS0001 Standard ltem with Mo Control Each 1 =

Details Logistics Diagnostics Repair Estimate Repair Johs Repair Tasks Repair Actuals
Repair Num Installed Site Problem Description B
lter (CSDO01 Default Contract | OKSRTI210830875 -
Revision Currency S dollar Priority
Instance Default Price List Corporate Date Created
Serial Mum Default PO Num Resolve By Date |13-JUN-2008 09:00:00
Unit MNurn Repair Org  Repair Center-East Promise Date
Lot Mum Repair Owner  Abhatt, Mr. Henry John Date Closed
Repair Mode WIP Project Automatically Enter and Book RMA
Escalation Project Task v Estimate Approval Required I ]
hotes |Depot Repair < Go ) “iew Configuration | Update Counters | Update RO Status... )

4. Click in the Repair Type field, in the Repair Order Information region. Any field for
which rules have been created which evaluate to true defaults. You can overwrite
the default values till the repair order is saved.

Disposition Rules Engine

Repair type, repair location, repair organization, third party repair vendor, exchange
from location and other values default at the time of repair order creation based on
customer defined rules. Rules are based on repair item, repair location, customer,
contract, and the like.

Disposition implies a specific set of attributes related to where a product goes and what
is done to it, for example the shipping and receiving inventory organization,
subinventories, the repair type, and the like.

Integration with Other Oracle Modules

Oracle Depot Repair integrates with the following Oracle modules:

Advanced Scheduler

Oracle Advanced Scheduler enables optimal scheduling of tasks and trips for field
service business needs. While the Assignment Manager (in Oracle Common Application
Components) searches for qualified resources to complete a field service task (based
upon selection criteria set within the Assignment Manager), these qualified resources
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transfer to Oracle Advanced Scheduler to make the actual assignments based upon
previously defined constraints. Oracle Advanced Scheduler uses the Assignment
Manager to schedule Field Service tasks.

Assignment Manager

Oracle Depot Repair uses Assignment Manager to schedule technicians to all open and
planned repair tasks. This module permits the planner to use the Assignment Manager
in an assisted or unassisted mode. For more information, see the Oracle Common
Application Components User’s Guide.

Bills of Material

Oracle Bills of Material store lists of items that are associated with a parent item, and
information about how each item relates to its parent. Oracle Depot Repair uses Oracle
Bills of Material to create repair routers that the system uses for a submitted WIP repair
job, and to create a bill of materials for an item that is linked to a repair router.

Contracts (Contracts Core and Service Contracts)

Counters

Oracle Depot Repair integrates with Oracle Service Contracts to manage service
contracts associated with a customer's Installed Base item. Oracle Service Contracts
holds all service contracts centrally--including warranties, extended warranties or
complex service agreements--and provides the service provider visibility to all service
entitlement information. It leverages functionality that Oracle Contracts Core provides
to support common contract management activities, such as contract renewal,
versioning, article management, and change management.

Note: The Counters module is now incorporated in Oracle Installed
Base.

Counter events and alerts provide a valuable tool to track critical service events that can
affect a customer or items in the Installed Base. Oracle Depot Repair uses the Counters
module to update item counters periodically, whenever a service depot technician
performs work on the item, and saves it in the Installed Base record. The Counters
module also permits a service provider to set up logical or derived counters that use
formulas that incorporate calendar dates, time, and cycle counts to trigger an event,
such as a warranty or service contract expiration, or to alert the service provider when
to schedule preventive maintenance on a customer's Installed Base item. The system can
send alerts by the e-mail notification system to inform service personnel about warranty
or service contract expiration, or about a preventive maintenance requirement that is
due.
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Field Service

When an organization sells an item to a customer, service contracts or warranties are
often offered to the customer. Most companies offer on-site support for failures of the
item. This is where field service is significant. After the customer reports the problem,
the field service organization determines:

*  Who and when a field service agent should visit the customer.
*  What parts are needed to solve the problem.

If a field service agent cannot completed the repair on-site, the repair may need to be
transferred to the service depot for completion. Furthermore, internal order
refurbishments can be initiated in the Spares Management module within Oracle Field
Service.

General Ledger

Oracle Depot Repair integrates with Oracle General Ledger to provide the functionality
of recording and tracking all costs associated with every Oracle Depot Repair WIP
mode repair, and of creating general ledger accounts.

HRMS (Human Resource Management System)

Installed Base

Inventory

Oracle Depot Repair uses the Oracle HRMS module to define employees and locations
where you ship, deliver internally, or bill the ordered goods and services.

Oracle Installed Base is a repository that tracks all installed customer items. Oracle
Installed Base maintains and updates each item record to reflect the most current
configuration. Service organizations must rely heavily on their Installed Base to provide
accurate customer and item information. The Installed Base permits quick access to all
item records and information. Oracle Depot Repair leverages this information to
expedite the repair process when repairs involve incompatibility, configuration,
revision, or counter history issues. Oracle Depot Repair integrates with Oracle Installed
Base to assist accurate recording of all part and serial numbers that change during an
item's life. It retrieves all service contracts and warranties associated with an Oracle
Installed Base serialized item or component. Depending on the definition of Oracle
Installed Base transaction sub-types, the TeleService Charges APIs update the location
and instance ownership information.

Oracle Depot Repair uses the Oracle Inventory module to manage item and spare parts
inventory.
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iSupport

Self-Service Repair Order reporting is now supported in Oracle iSupport. Oracle Depot
Repair customers can now search for their Repair Orders through an Oracle iSupport
self-service user interface. Oracle iSupport will properly authenticate the user and
display only Repair Orders for accounts which the user is authorized to view.

Knowledge Management

Oracle Knowledge Management is an Oracle Service Core module that provides an
open architecture repository to store technical information or solution sets. Service
agents and technicians can retrieve this information to find a quick resolution to service
issues that customers are reporting, or provide assistance in an inspection or item
diagnosis. Oracle Knowledge Management provides a security feature that permits only
users with specific responsibility to contribute new information to the constantly
enriched active database.

Oracle Depot Repair uses the Oracle Knowledge Management Search Engine to find the
best possible solutions to resolve service issues. Agents can access the knowledge
repository from the Service Request or the Repair Order. You can search for solutions
by entering a Diagnostic Code or keyword string to query on statements that have links
to a symptom, cause, action, or fact solution set. A solution set can also include a Task
Template or set of objects that can automate or expedite the repair process.

Notes

A note records descriptive information, which users have created, about business
transactions to provide referencing. Oracle Depot Repair uses the Notes module to
access the comment log that relates to a specific transaction. The Notes module creates
and passes information to all other Oracle applications. Upon transmission and receipt
of a note, the system automatically sends an alert to the Oracle Depot Repair module to
signal that a new note is present. Service employees can pass valuable information that
can influence the repair process. The Notes module permits users to post both public or
private notes, where public notes can be published to a Web site, and private notes are
only accessible to employees that work inside the service organization. For more
information, see the Oracle Common Application Components User's Guide.

Order Management

Oracle Depot Repair uses the Oracle Order Management module to create RMA and
Sales Orders, validate customer accounts, and invoice customers for repairs.

Oracle Depot Repair integrates with Oracle Order Management Pricing to provide an
advanced, highly flexible pricing engine that executes pricing and promotional
calculations. It allows Oracle Depot Repair users to view and select a Price List while
charging a repair, and while receiving or shipping an item.
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Purchasing

For receiving, Oracle WIP uses Oracle Purchasing to perform outside processing of a
repair from the WIP Router.

Receivables

The Oracle Receivables module integrates with Oracle Depot Repair integrates to track
and maintain customer information such as customer name, account, customer contacts,
and location.

Resource Manager

Oracle Depot Repair uses Resource Manager to manage employees. The Resource
Manager permits a user to import employees and non-employees from HRMS into the
resource module. You can set up and manage resources as individual resources, or as a
team or group, and assign roles and skill sets to distinguish their qualifications. For
more information, see the Oracle Common Application Components User’s Guide.

TeleService (Charges)

With the Charges module, a service organization can bill customers for provided
services in response to support Service Requests, field Service Requests, and service
depot repairs. Charges also creates a return material authorization (RMA) to return a
defective item for repair, loan, or replacement. Returns from a customer occur for a
variety of reasons including damage, shipment error, and repair. With the Charges
capability of processing return material, you can manage customer expectations while
controlling inventory receipts and processing customer credit. Oracle Depot Repair uses
TeleService Charges APIs to automatically create the charge lines when the service
depot has determined the Repair Type.

TeleService (Customer Care)

The Customer Profile summarizes customer information and indicates if a customer is
critical. It can provide information such as the number of open Service Requests. A
system administrator sets up the profile entries, which contain a set of defined
verifications that you can configure. The Customer Profile engine displays these
verification results. Oracle Depot Repair uses this functionality for customer
management.

TeleService (Service Requests)

Service agents typically log a Service Request to record a service issue that a customer is
reporting. Oracle Depot Repair invokes Oracle TeleService APIs to automatically create
the Service Request after creation of the Repair Order header. The TeleService APIs
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populate the Service Request number into the Repair Order Header to permanently link
the two source documents with an internal form identity. Service depot business flows
always start with the creation of a Service Request.

Task Manager

Oracle Depot Repair uses the Task Manager to assist repair management. The Tasks
model leverages the core functionality that Oracle Depot Repair provides by its
integration with Resource Manager, Assignment Manager, and Oracle Calendar. The
Task mode provides an alternate repair process that is intended to manage simple
repair work that does not require extensive tracking or management processes. After
task completion, the technician uses the Debrief Report in Oracle Depot Repair to log
the material, labor, and expense transactions. For more information, see the Oracle
Common Application Components User’s Guide.

Note: Oracle Depot Repair provides E-records and E-signature (ERES)
functionality in Task mode via the Debrief screen for each Task.

Work in Process

Oracle Depot Repair uses Oracle Work in Process (WIP) to assist the repair of broken or
damaged items. Oracle WIP permits assignment of resources, material, and outside
processing. A WIP summary report tracks the associated costs with a completed WIP
repair job. You can submit WIP mode repair jobs with or without an assigned routing.

Note: Oracle Depot Repair provides E-records and E-signature (ERES)
functionality in WIP mode via Oracle WIP.
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2

Overview of Using Oracle Depot Repair

This chapter provides an overview of the user interface and the major tasks that you can
perform using Oracle Depot Repair.

This chapter covers the following topics:

Accessing Oracle Depot Repair

The Depot Repair Workbench

The Service Request Information Area

The Repair Order Information Area

Details Tab

Logistics Tab

Diagnostics Tab

Repair Estimate Tab

Repair Jobs Tab

Repair Tasks Tab

Repair Actuals Tab

Drill into Order Management

Depot Repair Workbench Tools Menu

Depot Repair Workbench Data Menu

Find Repair Orders for Job Submission Window
Submit Repair Jobs for Repair Orders Window
Define Triggers for Service Bulletins

Receive Unplanned Returns

Execute Repair
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Accessing Oracle Depot Repair

Module

Responsibility

Prerequisites

Navigation

Steps

At the core of Oracle Depot Repair is the Depot Repair Workbench that provides service
agents with instant access to customer and Repair Order information. You can access a
number of tabs from the Depot Repair Workbench. Some tabs show information about
the customer, the Service Request, and the service history of the item. Other tabs let you
process transactions, such as:

* Receipt or shipment.
* Creation and processing of Repair Jobs and tasks.

The Depot Repair Workbench also provide access to a knowledge base through Oracle
Knowledge Management.

The following procedures describe how to access the Depot Repair Workbench.

Oracle Applications Navigator

Depot Repair Super User

You need the navigation to Oracle Applications, and a registered and approved login to
Oracle Depot Repair from your system administrator.

Depot Repair > Repair Orders

1. In the Find Repair Orders window, if you click New, the Repair Orders window
opens and serves as the Depot Repair Workbench.

2. Alternatively, in the Find Repair Orders window, you can retrieve a specific Repair
Order by entering search criteria, and clicking the Find button.

Note: You can also open the Depot Repair Workbench from the
Service Request Quick Menu.
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The Depot Repair Workbench

The title of the main window in Oracle Depot Repair is Repair Orders. As most of the
Oracle Depot Repair user operations start in this window, it is generally referred to as
the Depot Repair Workbench.

In the Depot Repair Workbench you can perform all service depot repair functions,
including Repair Order creation, status monitoring, receiving, and shipping. From the
Depot Repair Workbench, you can create Repair Orders to track the activities on
customer or vendor items returned to service depot repair, for repair, upgrade, or
overhaul.

Using the Depot Workbench, you can capture a value for a Project, Task and/or Model
Unit Number on a Repair Order. The list of values for Project is restricted to those
Projects defined in Oracle Project Manufacturing. The list of values for Task is restricted
to the valid Tasks for the selected Project. When a Project, Task or Model Unit Number
is selected on the Depot Repair Workbench, the values are passed to Order
Management when an RMA or Ship line is created from Depot. Also, the values are
passed to any WIP jobs created from the Depot Workbench.

You can use the Depot Workbench to cancel an order line in Order Management to the
point of booking the order from the Depot Workbench. Select an RMA or Ship line in
the Logistics tab, and select Cancel Order from the Tools menu.

The Depot Repair Workbench provides integration with Oracle E-Business Application
Suite modules and components, such as Notes, Charges, Knowledge Management,
Install Base, Work in Process (WIP), Bills of Material (BOM), General Ledger, Inventory,
Shipping, and Receiving.

For more information, see Integration with Other Oracle Modules, page 1-11.

Service organizations can start their service depot business process from the Depot
Repair Workbench. When a service agent enters the customer and item information, the
Depot Repair Workbench automatically validates the customer and item in the Install
Base.

From the Depot Repair Workbench, you can:

¢ (Create new customers.
¢ Review your customer profiles.

* Automatically create Service Request and charge lines based on the selected Repair
Type selected.

® Access shipping and receiving areas.

® Access WIP or Tasks for repair management.
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For more information on the Depot Repair Workbench, see:

* The Service Request Information Area, page 2-5
® The Repair Order Information Area, page 2-8

® Details Tab, page 2-9

* Logistics Tab, page 2-12

¢ Diagnostics Tab, page 2-21

¢ Repair Estimate Tab, page 2-24

® Repair Jobs Tab, page 2-30

® Repair Tasks Tab, page 2-35
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Repair Actuals Tab, page 2-38
Depot Repair Workbench Tools Menu, page 2-41

Depot Repair Workbench Data Menu, page 2-46

The following features, that in previous versions were available through tabs in the
Depot Repair Workbench, are now accessible through menu options:

Coverage Window, page 2-41
Activity Window, page 2-48

Service History Window, page 2-47

For more details about these features, see Depot Repair Workbench Tools Menu, page
2-41 and Depot Repair Workbench Data Menu, page 2-46.

The Service Request Information Area

You can enter and view customer information in the Service Request Information area.
The fields in the Service Request Information area include:

Customer Information Fields, page 2-5
Contact Information Fields, page 2-5
Item Information Fields, page 2-5

Request Information Fields, page 2-8

Customer Information Fields

Fields in the Customer Information area include:

Customer Type: Caller types.

Customer: Customer names. The customer can also be the internal party. Validation
of items occurs against the party ID to assist the repair of internally owned items.

Account: Customer Account Number.
Phone: Customer's contact telephone number.
Bill-To: Bill-to address of customer or a related party.

Ship-To: Ship-to address of customer or a related party.
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Note: The Bill-To and Ship-To addresses always default to the
primary bill-to and ship-to addresses of the customer party, even if
you select a primary address for the Installed Base instance.

Note: Also, the list of values for the Bill-to and Ship-to fields
contains only the bill-to and ship-to addresses of the customer
party. The Bill-to and Ship-to fields do not contain the addresses of
the contact even if you have selected one.

Contact Information Fields

Fields in the Contact Information area include:

e Contact Type: Choose this value from the list of values.

Note: This field does not automatically default to a null value. If
you do not want to enter any contact information, then select the
blank value from the Contact Type list of values; the remaining
contact information fields that follow are disabled.

¢ Contact: Contact's name (customer account validation is required). Select from the
contacts that your organization defined during Oracle Depot Repair setup.

* Relationship: Specifies the contact's relationship with the customer, such as
Associate of, Child of, and Benefactor of. Select from the Relationship list of values.

e (Contact ID: Contact's Identification Number.

® Phone: Contact's telephone number.

Contact Information Area Buttons

The button in the Contact Information area is:

e New Contact: To create a new customer contact, click the New Contact button.

Item Information Fields

2-6

Fields in the Item Information area include:
¢ Installed Items Only check box: Validates the item against the Installed Base.

When the Installed Items Only check box is not set, the list of values for the Item
field displays both the Installed Base trackable items and the non-Installed Base
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trackable items.

When the Installed Items Only check box is set, the list of values for the Item field
displays Installed Base trackable items only, that is, those that have an Instance
value.

¢ Item: Specifies the Item Number for which there is a Service Request.
® Revision: Displays the item revision, if the item is revision controlled.

e Instance: Shows the Instance value of the item, and applies only to items that have
an Installed Base instance. If you choose to enter the Instance field for an item first,
the Item field becomes automatically populated when you select the Instance value
from the list of values.

e Serial Num: For serialized items, displays the Serial Number of the item.

If you have not already entered or selected the Item, and when both of the
following conditions occur:

e Installed Items Only is not checked
*  You choose to select or manually enter an already-existing Serial Number

then the Item field and the other item-related fields are automatically populated.
If you have already entered or selected the item:
e For serialized, Installed Base trackable items, you must enter or select a valid

Serial Number.

e For serialized, non-Installed Base trackable items, if you select a Serial Number
from the list of values, then other item-related fields are automatically
populated.

* For serialized, non-Installed Base trackable items, if you manually enter a Serial
Number, then, whether or not it already exists, no further item-related fields are
populated.

* Opened: Displays the date when the request was opened.

* C(Closed: Displays the date when the request was closed.

Request Information Fields

Fields in the Request Information area include:

® Request Num: Displays the system-generated Service Request Number.
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Summary: Enter or view a brief description for the request in the Summary field.
The Summary field is a text string field and is classified as a Note.

Request Type: Choose from the list of values that your organization defined. The
default value for this field comes from the profile option Service: Default Service
Request Type.

Severity: Choose from the list of values to assign a severity to the request. The
default value for this field comes from the profile option Service: Default Service
Request Severity.

Status: This defaults to Open when you create a Service Request, as specified by the
default value of the profile option Service: Default Service Request Status.

Owner: Assign a Service Request owner by selecting from the default the Price List
from the profile option CSD: Default Price List, and derive the currency. Definition
of the owners occur in Resource Manager. The default value for this field comes
from the profile option Service: Default Service Request Owner.

The Repair Order Information Area

The Repair Order Information area displays:

Repair Num: Read-only field that displays the system-generated Repair Order
Number.

Repair Type: A mandatory field that is part of the Repair Order line, that contains a
list of values of the user-defined Repair Types. A workflow supports each Repair
Type to automate the service depot business process. For more information, see
Repair Type Processing, page 1-2.

Item: An automatically populated field that shows the item that you specified in the
Service Request Information area. This field can be changed.

Item Description: An automatically populated field that shows the description of
the item that appears after you specify the item.

UOM (Unit of Measure): An automatically populated field that shows the unit of
measure after you specify the item. This field can be changed.

Qty (Quantity): Automatically defaults to 1, except for internal order refurbishment
repairs.

Repair Status: Status of the Repair Order.

Estimate Approved: Displays the associated estimate approval status value. Values
include Approved, Pending, Rejected, and null.
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Details Tab

Note: This is not the same as the Estimate Status which appears in
the Repair Estimate tab. For more information, see Obtain
Customer Approval for a Repair Estimate, page 4-63.

Service Request Information

(KA D8-Dec:a7E

Customer Type | Organization = Contact Type | E] [ nstalled ftems Only Request Num
Customer Eusmess W’Drld First [ ltem AS54888 test ]
Account 1605 Last | Revision SRy -
Phane 550555 555 Teler Contact D | Instance Reguest Type  Depot Repair
Bill-Ta 2391 L Street, = Phone Serial Mum Severity  High
Ship-To 2391 L Sirest, & Email | Opened |27-AUG-2009 14 Statys [Open
Iew Contac Closed Owner Anderson, Steve
Repair Order Inforrnation Reepair S
Repair Mum RepairType _Item Iterm Dee_scription — — uomM Ciy Status Approved
lf15752 Repair and Return-YIP ASH4EE5 Sentinel Btandard Desktop TRD Each 1 |Open =
_@_)ét:afj_lé \ Logistics Diagnostics Repair Estimate Repair Jobs Repair Actuals
Repalr Murn | Installed Site Prablem Description =
ltem |AS54888 Default Cantract 21918 -
Revision Currency (US dollar Priority
Instarice Default Price List |Corporate Date Created | 27-AUG-2009 14.21:31
Serial Nurn | Default PO Murm Resolve By Date [28-ALG-2003 142108
Unit Murn Repair Org |Repair Center-East Prarnise Date
Lot Mum Repair Owner Date Closed
Repair Mode  [WIF Project Auto ally Ent ook RMA
Project Task [” Estimate Approval Requirzd il
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The Details tab contains:

® Repair Num: A read-only field that displays the system-generated Repair Order

Number.

* Item: An automatically populated field that shows the item that you specified in the
Service Request Information area. If multiple Repair Orders have already been
created that are associated with a single Service Request, this field displays the item
in the Repair Order line that you selected in the Repair Order Information area.

® Revision: Displays the item revision residing in the Installed Base record, if the item

is revision controlled.

e Instance: Shows the Installed Base Instance value of the item, if the item is Installed

Base trackable.

® Serial Num: Displays the Serial Number of the item for which repair is requested, if

the item is serialized.
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®  Unit Num: Displays a list of values that includes Module Unit Numbers defined in
the Inventory Organization to which you are assigned.

¢ Lot Num: Displays the item Lot Number residing in the Installed Base record, if the
item is lot controlled.

*  Warranty Status: The list of values are part of an extensible lookup. The seeded
values are: In Warranty, Out Of Warranty, and Warranty Violated. These values are
editable. This attribute is used for businesses that have standard warranties but do
not want to use Oracle Service Contracts. You can use Personalization to default the
warranty status based on rules such as, 1 year from Sold On Date, 90 days since
Last Repaired Date and the like. This field is useful for companies which query
warranty status from a third party database.

¢ Installed Site: Displays the (current) location identifier for the Installed Base item.

¢ Promise Date: Specifies the date within which completion of the item repair should
occur. This date is a prediction only, and is derived after the service depot owner
has reviewed the activities and commitments of the service depot.

e Date Created: A read-only field that displays the system-generated date and the
creation date the Repair Order.

* Date Closed: A read-only field that displays the system-generated date and time
stamp when the Repair Order status is set to closed.

® Repair Owner: Service depot resource that is responsible for execution and
completion of the repair.

¢ Currency: Displays the functional currency of the repair organization, for example,
US dollar.

Note: Each Repair Order can have one currency only.

¢ DPrice List: Displays the Price List for the default contract of the Repair Order.

* For more information, see Contract and Price List Defaulting at Repair Order
Creation, page 4-8.

® Default PO Num: A free form text field to capture the Purchase Order Number.
This value, if entered, becomes the default value for the PO Num fields in the
Estimate Charge Line Details form, and the Logistics and Repair Actuals tabs.

® Resolve By Date: If a Service Contract exists, the Resolve By Date value defaults
from the contract. In the absence of a Service Contract leave the date as null.

The Depot Workbench supports integration with Project Manufacturing by enabling
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you to capture a Project ID, Task ID, and Unit Number on the repair order. While repair
orders are not recognized on a Project, you can track the RMA lines, ship lines, and WIP
jobs created as part of the repair on a Project. The following fields enable this
functionality in the Details tab:

Project: Displays list of values that show only the active Projects defined in the
Inventory Organization to which you are assigned.

Project Task: Displays only the active Tasks linked to the selected Project.

Note: Once you select values for Project, Task, and Unit Number any
RMA lines, ship lines, or WIP jobs created using the Depot Workbench
are stamped with the Project, Task, and Unit Number IDs. If these IDs
are changed on the Details tab, the values on the already created RMA
lines, ship lines or WIP jobs are not updated. Any lines or jobs created
after the updated Project and Task are stamped with the updated
values.

Details Tab Check Boxes

Details Tab DFF

Estimate Approval Required: Forces an approval step after a repair estimate or
diagnosis is performed, requiring the customer to approve the Repair Order before
the service depot can proceed with the repair.

Automatically Enter and Book RMA: Appears selected or cleared by default based
on setup of the Repair Type corresponding to the Repair Order. When you create a
Repair Order with this check box selected, the system automatically enters and
books an RMA line. You can manually override the default selection for individual
Repair Orders.

Descriptive Flex Field: Enter flexfield information associated with the Repair Order.
You cannot edit the DFF field after the Repair Order status is changed to Closed.

Details Tab Buttons

View Configuration: Displays item details for items that are Installed Base
trackable. Item details include the most recent item configuration and revision
status. The service depot can use this information when attempting to troubleshoot,
upgrade, or repair the item.

Update Counters: Displays the Counters Update window. In the Counters Update
window, repair technicians can update the present counters that are associated to a
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item.

e Update RO Status: Displays the Update Repair Order Status window where you
can change the status of a Repair Order.

* Notes: Displays the Notes window. On the Notes window, you can record and
share relevant information about customers and repair processes.

The Service Request option provides a filter that only permits a user to view notes
that someone created in the Service Request window. The Depot Repair option
provides a filter that only permits the user to view notes that someone created in
the Repair Order window.

Logistics Tab

On the Logistics tab, you process receiving or shipping transactions, for all types of
repair.

For general repairs, that is, repairs that are not internal order refurbishments, the main
operations that you can perform in the Logistics tab are as follows:

® Create and view RMA/Sales Order charge lines that are linked to a selected Depot
Repair Order.

¢ Edit or save an existing charge line.

* Book an RMA or Sales Order.

* DPick release a Sales Order.

® Receive a returned item and move it to a subinventory.

* Ship or issue a repaired, loaner, or exchange item.

¢ Default Logistics Lines for OSP Operations: This enables a technician to
automatically create a third party ship and RMA line on the Logistics tab whenever
an OSP operation is completed. Set the profile option, CSD: Create Logistics Lines

for OSP, to Yes to enable this functionality.

For internal order refurbishments, the main operations that you can perform in the
Logistics tab are as follows:

* Create and view the Move In and Move Out charge lines.
e Pick release the internal Sales Order.

® Receive the item for refurbishment and move it to a subinventory.
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®  Ship the refurbished item.

The main fields on the Logistics tab appear automatically in one of two different

multi-record layouts, depending on the Repair Type of the Repair Order:

1. A general layout for most of the Repair Types, page 2-12

2. A special layout for internal order refurbishment Repair Types, page 2-12, that is,
where the Repair Type has been set up as follows:

e The Repair Type has Repair Type Ref = Refurbishment.

* The Repair Type has the Internal Order flag set on.

For details of setting up Repair Types, see the Oracle Depot Repair Implementation
Guide.

Under the multi-record area of the Logistics tab are the elements common to all Repair
Types:

* Logistics Tab Check Box and Radio Buttons, page 2-12

¢ Logistics Tab Buttons, page 2-12

Logistics Tab General Multi-Record Area

The general multi-record area of the Logistics tab contains the following fields:

e Process Trans (check box): Selects the charge line for processing. When you select a
line, you can select the "Automate order processing steps through" check box and
one of its associated process stage options to set the parameters for processing the
charge line (see Logistics Tab Check Box and Radio Buttons, page 2-12.)

* Action Type:
In the Action Type field, select one of the following:

® Return option to receive customer or vendor items.

* Ship option to ship items to customers or vendors.

e Action Code: When the Action Code field is enabled, either leave the default value
or select one of the following:

e Customer Item option if the item belongs to the customer.
* Loaner option if the item is on loan to the customer.

¢ Exchange option if the item is an exchange.
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® Replacement option if the item is a replacement.

e Service Activity: Select the relevant Service Activity in this field, for example:
Return for Repair.

¢ Order Num: Displays the RMA/Sales Order Number that Oracle Order
Management returns.

e Line Num: Displays the Line Number in the Oracle Order Management order that
is specified in the Order Num field.

® Status: Displays the status of the active Order Management Order Number. The
status can be Entered, Submitted, Booked, Released, Received, or Shipped.

e Item: Choose the Item Number from the list of values.
e  Price List: Specifies an Order Management Price List to price the Charge line.

*  Qty: Specify the item quantity.

If the value of Action Code is Customer Item, then the Qty in the Logistics tab must
not exceed the Repair Order Qty, that is, the Qty in the Repair Order Information
area.

e UOM: An item's unit of measure.
® DPrice: Specifies a price from the Price List for the charge line.

® Rev: Displays the item revision, if the item is revision controlled.

Note: The Source fields that follow are based on item inventory
attributes. For more information, see the Oracle Inventory User's
Guide and the Oracle Depot Repair Implementation Guide

* (Source) Serial Num: If the Source Item (the Item that is currently being shipped or
received) is serialized, this field displays the Serial Number for the Source Item.

® (Source) Instance: If the Source Item (the Item that is currently being shipped or
received) is Installed Base trackable, this field displays the Instance value for the
Source Item.

For a ship exchange line, the Source fields are optional and the fields are blank by
default. You have two action items for the Source fields:

*  You can leave the Source fields empty if you do not know which instance is
being shipped out and let them get populated during shipping.
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* You can select the instance/serial being shipped out if you know exactly which
serial number is being shipped out.
If the list of values in the Source field is empty, then check the following:

* You have internally owned items.

* A value is specified for Service: Inventory Validation Organization.

Note: The Non Source fields that follow are based on attributes set
up in Installed Base transaction subtypes. For more information,
see the Oracle Depot Repair Implementation Guide.

(Non Source) Serial Num: If the Non Source Item (the Item that is currently being
replaced or exchanged) is serialized, this field displays the Serial Number for the
Non Source Item. This applies only for Ship lines.

(Non Source) Instance: If the Non Source Item (the Item that is currently being
replaced or exchanged) is Installed Base trackable, this field displays the Instance
value for the Non Source Item. This applies only for Ship lines.

For a ship exchange line, the Non Source fields are mandatory and the repair order
item information defaults. To enable entering the serial number in the Non Source
field, execute the following steps:

*  You need Non Source information for the Service Activities associated with the
Repair Types Exchange, Advance Exchange, and Replacement.

* The list of value for the Non Source fields is activated only when the Action

Type is SHIP or WALK_IN_ISSUE and Action code is EXCHANGE for product
transaction line.

Lot Num: Displays the item Lot Number, for lot controlled items.

Subinv:

¢ Displays the subinventory into which the item is received for Return lines.

¢ Displays the subinventory from which the item is shipped for Ship lines.

Locator: If the item is Locator controlled, displays the Locator information.
Return Reason: Specify a reason for returning the item from the list of values.

Return by Date: Specifies the date within which the item you need to return the
item.
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* Contract: Specifies the default Contract Number that applies to the charge lines.
For more information, see Contract and Price List Defaulting at Repair Order

Creation, page 4-8 and Coverage Window, page 2-41.

¢ PO Number: Specifies the Purchase Order Number corresponding to the order line
in this field. This field value is not mandatory.

® (Addresses) Bill-To: Specifies the customer's Bill-To address.
® (Addresses) Ship-To: Specifies the customer's Ship-To address.
¢ Item Description: The description of the item.

¢ Picking Rule: The Picking rule for the ship line. This can be changed until the ship
line is released.

® Add to Order: Displays the Order Management Order Number to which you want
to add the Return/Ship line.
If set, the two profile options:

¢ (CSD: Add to Order Num Within Repair Order Default

* (CSD: Add to Order Num Within Service Request Default
provide default values for this field.

If both are set, the default value comes from CSD: Add to Order Num Within
Repair Order Default.

* No Charge (check box): You specify the default selection of this check box during
implementation setup of the Service Activities and Billing Types. Selection of No
Charge implies that you are not charging the customer for that transaction.

After the charge line has been interfaced to Oracle Order Management, and an
Order Number appears in the charge line, you cannot update the No Charge check
box.

Note: It is recommended that you do not use the Logistics tab to
charge items for logistics-related transactions. Instead, enter
charges on the Repair Estimate tab.

Logistics Tab Multi-Record Area for Internal Order Refurbishments

The multi-record area of the Logistics tab that is specific to internal order (not internal
party) refurbishments contains the following fields:

® Process Trans (check box): Selects the charge line for processing. When you select a
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line, you can select the "Automate order processing steps through" check box and
one of its associated process stage options to set the parameters for processing the
charge line (see Logistics Tab Check Box and Radio Buttons, page 2-12.)

Action Type:
In the Action Type field, select one of the following:

* Move In option to receive items from a source organization, such as a Spares
Management site, and move them into a depot.

* Move Out option to ship items back to the source organization, such as a Spares
Management site.

Action Code: The Action Code field displays one of the following values:
e Defective, for the Move In line.

e Usable, for the Move Out line.

Order Num: Displays the internal Sales Order Number that Oracle Order
Management returns.

Line Num: Displays the Line Number and the Shipment Line Number in the Oracle
Order Management order that is specified in the Order Num field.

Status: Displays the status of the active Order Management Order Number. The
status can be Created, Entered, Booked, Released, Received, Shipped, or Issued.

Item: Choose the Item Number from the list of values.

(Allocation Qty) Line: Displays the number of units specified on the internal
refurbishment Repair Order. For serialized items, the value is always 1.

(Allocation Qty) Shipped: Displays the number of units shipped

¢ From the source organization for Move In lines.

¢ From the depot for Move Out lines.

(Allocation Qty) Received: Displays the number of units received

¢ Into the depot for Move In lines.

e The field is disabled for Move Out lines.

Requisition Num: Displays the Requisition Number from Oracle Purchasing.
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e Item Desc: Displays the description of the item.
e UOM: Displays the unit of measure of the item.

¢ Serial Num: Displays the Serial Number of the item for which repair is requested, if
the item is serialized.

¢ Lot Num: Displays the item Lot Number, for lot controlled items

® Locator: If the item is Locator controlled, displays the Locator information.
e Ship-To Address: Displays the address of the destination organization.

* Source Org: Displays the organization from which the item is moved.

® Source Subinv: Displays the subinventory from which the item is moved.

® Destination Org: Displays the organization to which the item is moved.

® Destination Subinv: Displays the subinventory to which the item is moved.

®  Order Type: Type of order from Oracle Order Management.

Logistics Tab Check Box and Radio Buttons

The fields under the multi-record area of the Logistics tab are as follows:
* Automate order processing steps through (check box)
Automates order processing steps through selected options for Repair Order lines.

If this check box is selected, you must also select one of the radio button options
below this check box, to determine the default processing option for the Repair
Order line.

e Enter Order (radio button)
e Book Order (radio button)
e Pick Release (radio button)

e Ship Confirm (radio button)

Some of these radio buttons are disabled depending on a variety of factors,
including the Action Type of the line, the Status, whether the repair item is
serialized, and the type of serialization.

2-18 Oracle Depot Repair User Guide



Comments

The following provides a list of the main conditions that affect the visibility and usage
of the radio button options on the Logistics tab:

1.

For Return lines, you can select only the Enter Order or the Book Order radio
button.

For Ship lines, you can select any of the four radio button options.

For Move In and Move Out lines, the Enter Order and Book Order radio buttons are
disabled.

For Move In and Move Out lines, the Pick Release radio button is always enabled if
the Status is Booked.

For Move In and Move Out lines, the Ship Confirm radio button is disabled in
either of the following cases:

e When the serialized item is serialized at Sales Order Issue.

* For partial shipments.

Logistics Tab Buttons and Actions Field

The buttons on the Logistics tab include the following;:

Refresh Logistics: Used to update the shipping or receiving information in the
Depot Repair application. This only updates the information for the current line.

Process: Submits the transaction lines, whose Process Trans check box is selected, to
Order Management and returns a system-generated Order Number to the Order
Num field.

The Actions field, accompanied by a Go button, contains a list of the operations
available for processing logistics lines. Select an action and click Go to perform the
corresponding operation. Depending on the Action Type and Status of the current
logistics line, some options may be disabled, and you may not be allowed to perform
some operations.

The list includes the following values:

Edit Transaction Details: Displays the Transaction Details window. Service depot
managers can edit the transaction details of the charges created for the customer
item.

This option is not available for Move In and Move Out lines.

View Line Status Details : Displays the view-only Logistics Line Status Details
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window, that relates the Status for the current logistics line to the statuses in the
corresponding Order Management, Shipping, and Receiving lines as maintained by
the other, integrated Oracle applications.

* Inspect/Move: Used to perform inspection and moving of items to inventory during
the receiving process.
This option is only available for Return lines with a Status of Booked, and for Move
In lines with a Status of Shipped.

® Receive: Displays the Oracle Receiving window to receive the item and place it in a
subinventory.
This option is only available for Return lines with a Status of Booked, and for Move
In lines with a Status of Shipped.

* Ship: Displays the Order Management Shipping Transactions window to ship the
item to the customer.
This option is only available for Ship, Move In, and Move Out lines, when their
Status is Released.

e Transact Move Order: Enables you to set up a serial number for an item about to be
shipped or moved.
This option is only available for Ship, Move In, and Move Out lines, when their
Status is Booked.

e Cancel Order Line: Allows you to cancel an order line, if the line processing has not
gone beyond the booking stage.

This option is available for Return lines before the Status becomes Received, and for
Ship lines before the Status becomes Released. It is also available for Move In and
for Move Out lines.

To cancel an order line:

1. Navigate to the Depot Repair Workbench.

2. Create a Repair Order. Alternatively, you can search and retrieve an existing
repair order. The Repair Orders page opens.

3. Click the Logistics tab.

4. Select the line you want to cancel and select Cancel Order Line from the Actions
list of values.

5. Click Go. The required order line is cancelled.

® Project Details: Displays the Project Details window. It enables you to select a
different Project, Task ID, and Unit Number for a specific RMA line or ship line and

2-20 Oracle Depot Repair User Guide



override the value that defaults from the Details tab. The Project, Task, and Unit
Number LOVs under Project Details have the same values and constraints as the
LOVs on the Details tab.

Once an RMA line, ship line or WIP job is created, the Project, Task, and Unit
Number information cannot be changed from the Depot Workbench. However, it
can be changed from the Order Management or WIP application screens. Project,
Task, and Unit Number information are not passed to Estimate or Actuals lines.

Diagnostics Tab

The Diagnostics tab has the following layout:

Diagnostic Codes Area, page 2-21

In the Diagnostic Codes area, you enter Diagnostic Codes and perform searches for
solutions in Oracle Knowledge Management based on the selected Diagnostic
Codes. You can also search for solutions without specifying any Diagnostic Codes.

Solutions Area, page 2-21

In the Solutions area, you view matching potential solutions in Oracle Knowledge
Management, determine which ones that you want to add as charge lines to the
estimate or as Bills and Routings to the WIP Repair Job or both, and indicate the
usefulness of the solutions.

Service Codes Area, page 2-21

In the Service Codes area, after you perform a solution search in Oracle Knowledge
Management, linked solutions will be returned with associated Service Codes (if
any exist). These associated Service Codes will be populated automatically in the
Service Codes area, if the linked solution Status is Useful. When your implementor
sets up Service Codes, your implementor associates material or labor costs or both
to each Service Code. For more information on setting up Service Codes, see the
Oracle Depot Repair Implementation Guide.

Note: If Oracle Knowledge Management is not installed or if the
profile option CSD: Enable Knowledge Management is set to No,
then Oracle Knowledge Management related elements will be
disabled in the Diagnostics tab.

Diagnostics Tab Button, page 2-21

The Search Solutions button enables you to search for solutions in Oracle
Knowledge Management.
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Diagnostic Codes Area

The Diagnostic Codes area contains the following elements:
® Select (check box): Selects the Diagnostic Code to be included as a parameter in the

Oracle Knowledge Management search.

® Code: Choose the Diagnostic Code from the list of values. This list includes only
those Diagnostic Codes whose domains include either the Item or the Item
Category of the Repair Order Item, as set up in Oracle Inventory.

For more information on setting up Diagnostic Codes, see the Oracle Depot Repair

Implementation Guide.

* Name: This read-only field specfies the name of the chosen Diagnostic Code.

Diagnostics Codes Area Buttons
* Select All: Selects all the Diagnostic Codes in the Diagnostic Codes area.

® Deselect All: Deselects all the Diagnostic Codes in the Diagnostic Codes area.

Solutions Area

The Solutions area displays the solutions that have been given feedback in Oracle
Knowledge Management and have been linked to a Repair Order in Oracle Depot
Repair.

The Solutions area contains the following elements:

*  Number: The Oracle Knowledge Management Solution Number.
e Title: The Oracle Knowledge Management solution title.
e Status: The status indicates the usefulness of the solution. The values for Status

correspond to the question posed in Oracle Knowledge Management: Is this
solution useful in resolving your question or problem?

e If the answer was Yes, the Status is Useful.
e If the answer was Maybe, the Status is Possibly useful.

e If the answer was No, and the value of the profile option Knowledge: Action for
Negative Feedback Solution is Linked Solution as Not Solved, the Status is Not
useful. If the profile option does not have the value Linked Solution as Not
Solved, then the solution does not appear in the Solutions area.

You may change the Status value by clicking the Status field, selecting a different value
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from the list of values, and then clicking Update Status.

Solutions Area Buttons

® Details: Launches the window in Oracle Knowledge Management that displays the
solution details.

¢ Update Status: In order to update the status of the solution, you must click the
Status field that you want to change, select a new value from the list of values, then
click Update Status.

Note: After you have brought back a solution from Oracle
Knowledge Management, you can only change the status of the
solution in Oracle Depot Repair. You cannot delete a solution from
the Solutions area; however you can change the status of a solution
to "Not useful".

Service Codes Area
The Service Codes area contains the following elements:
* Applicable (check box): Enables the Service Code and its associated elements to be

included in the subsequent creation of estimate lines and WIP Repair Jobs.

e Code: The Service Code that is associated to WIP and Task elements, such as Bills,
Routings, and Task Templates, to assist in the creation of estimate lines and WIP
Repair Jobs.

This field is filled in either automatically or manually.

After performing a solution search in Oracle Knowledge Management, linked
solutions which have associated Service Codes will populate automatically in the
Service Codes area, if the linked solution Status is Useful.

You may choose Service Codes manually, whether you have any automatic entries
or not.

For manual selection, select from the Code list of values. This list displays those
Service Codes whose domain includes either the Item or the Item Category of the
Repair Order Item, as set up in Oracle Inventory.

For more information on setting up Service Codes, see the Oracle Depot Repair
Implementation Guide.

* Name: This read-only field specifies the name of the selected Service Code.

e Solution Number: This read-only field specifies the identifying number of the
Oracle Knowledge Management Solution associated with the chosen Service Code,
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if any.

Diagnostics Tab Button

The Diagnostics tab contains the following button that lies outside the three main tab
areas:

e Search Solutions

When you click the Search Solutions button, you initiate a search for solutions in
Oracle Knowledge Management.

Repair Estimate Tab

The Repair Estimate tab provides a summarized view of the repair estimate transactions
needed to complete the repair. You can launch an estimate "worksheet" window that
allows changes to charge lines that you entered on the Repair Estimate tab.

Note: The CSD: Enable Estimates profile option, set up during
implementation, lets your organization specify whether to enable or
disable the Repair Estimate tab in the Depot Repair Workbench.

The Repair Estimate tab performs the following functions:

* It uses Order Management Price Lists to determine the selling price for each item
selected in the charge line.

¢ It obtains the Item Cost from the inventory Item Master list.

e It copies in charge lines associated with the applicable Service Codes selected in the
Diagnostics tab.

e [t calculates the profit margin for each of the charge lines as a percentage and actual
dollar amount.

* [t provides a summary of estimated charges, with subtotals for Material, Labor, and
Expenses charges.

e It provides an estimate cost analysis, which lets you compare your estimated
margins and profitability based on estimated costs and estimated charges.

Repair Estimate Tab Header Fields

The Repair Estimate tab header fields and functionality include:

* Status: Select a status from the list of values. Estimate statuses in Oracle Depot
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Repair include:

® Accepted: An estimate that the customer has approved.
* Bid: An estimate that is awaiting customer approval.
¢ Cancelled: A cancelled estimate.

* Drafted: An estimate with information, but not ready to be revealed to the
customer.

e New: An estimate with no entered information.

* Rejected: An estimate that the customer did not approve.

Date: Select a date from the Calendar to enter the creation date of the Repair
Estimate.

Reason: Select a Reason Code from the list of values that best describes the reason
for performing the repair estimate process. This field is enabled when the Status is

Accepted or Rejected.

Summary: Enter a free text work summary or problem description that best
describes the repair diagnosis or symptom of the broken or damaged item.

Lead Time: Enter the number of units required to complete the item repair.
UOM: Select a unit of measure to describe the lead time units required.

Descriptive Flex Field: Enter flexfield information associated with the repair
estimate header. You cannot edit the DFF field after the Repair Order status is
changed to Closed.

Repair Estimate Tab Multi-Record Fields

Fields and functionality in the Repair Estimate multi-record area include:

Source Type: Displays the source of the estimate charge line. Possible values are
Manual, Service Code and Solution.

Billing Category: Displays the categories of Material, Labor, or Expense.

Item: Displays the selected Item Number from inventory

Note: Items for estimates must be defined in the organization
specified by the profile option Service: Inventory Validation
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Organization.

¢ Contract Number: Displays the Contract Number that is applicable to the estimate
charge line.

e  Price List: Displays the selected Order Management Price List.

e Pricing Attributes: Enter the appropriate Pricing Attribute flexfield information for
the Price List.

¢ Qty: Displays the quantity if items for which service is being requested.
e UOM: Displays the unit of measure.
®  Unit Price: Displays the item's selling price from the selected Price List.

e Estimated Charge: Displays the charge after the contract entitlement has been
applied.

® Override Charge (check box): Select this if you want to change the Estimated
Charge field.

Note: This field is only enabled if the profile option CSD: Allow
Charge Override for Estimates is set to Yes.

Note: When you change the Estimated Charge, any discount
associated with the contract is ignored.

¢ No Charge (check box): Discounts the charge line amount to zero or no charge.

Summary of Estimated Charges Fields
The Summary of Estimated Charges area displays:

® Material: Displays the subtotal of the estimated material required.

e Labor: Displays the subtotal of the estimated labor required.

¢ Expenses: Displays the subtotal of the estimated expenses required.

e Total: Displays the combined subtotal of the material, labor, and expenses.

® Currency: Displays the currency for the Repair Order, for example: US dollar.
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Note: A Repair Order supports only a single currency. The system
supports different currencies for different Repair Orders within a
Service Request.

Repair Estimate Tab Buttons

Buttons on the Repair Estimate tab include:

e Estimate Notes: Enter justification notes that describe the estimated transaction line.

® Costs: Launches the Estimated Costs versus Estimated Charges window.

¢ Line Details: Displays the detailed estimate worksheet.

¢ Add Lines from Diagnostics: Copies charge lines into the Repair Estimates tab from
the Service Codes marked as applicable in the Diagnostics tab, and their associated

Oracle Knowledge Management solutions, if not added already.

* Save Estimate: Records estimate header and charge line details.

About Estimate Charge Line Details Window

On the Estimate Charge Line Details window, you can edit details of charge lines that
you had entered on the Repair Estimate tab.

Note: You cannot add new charge lines or delete existing charge lines
using the Estimate Charge Line Details window. To add a new charge
line or delete an existing charge line, return to the Repair Estimate tab.

In the multi-record area, the Estimate Charge Line Details window displays, as
read-only fields, most of the charge line fields that appear in the Repair Estimate
Multi-Record Fields area of the Repair Estimate tab, namely:

¢ Source Type

¢ Billing Category
e IJtem

e Contract Number

e Price List

° Qty
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UOM

Unit Price

Estimated Charge

Override Charge (check box)

No Charge (check box)

When you select one of the charge lines in the multi-record area, the Estimate Line
Details region shows more details of the selected charge line.

Of all the fields that appear in the Estimate Line Details region, you can edit or enter the
following field values.

Billing Category
Item

Resource: Displays the resource type that was selected from the item master. This
field is enabled when Billing Category = Labor.

PO Num: Enter the customer or vendor Purchase Order Number to validate the
acceptance of the repair estimate or customer's approval to proceed with the
pending repair. This field value is not mandatory.

Price List

Pricing Attributes

Quantity

UOM

Quantity

(Contract Information) Number

Estimated Charge: You can edit this field if you set the check box Override Charge.

Override Charge (check box): To be able to change this field, the profile option CSD:
Allow Charge Override for Estimates must be set to Yes.

Note: When you change the Estimated Charge, any discount
associated with the contract is ignored.

No Charge (check box): If No Charge is checked, then Override Charge is disabled.
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When you update these field values, the application automatically updates any
associated fields.

The Number field in the Contract Information area of the Estimate Line Details region
displays the default Repair Order contract. This contract could be the best contract, the
contract associated at the Service Request level, or the contract selected manually from
the Coverage window that you can access using the menu option path Tools >
Coverage.

For more information, see Contract and Price List Defaulting at Repair Order Creation,
page 4-8 and Coverage Window, page 2-41.

The default Repair Order contract populates the Number field in the Contract
Information area for each estimate charge line. You can override this default value at
the estimate line level by entering a different contract by selecting from the list of
values.

Other fields include:

* Revision: Displays the item Revision Number if the item is revision-controlled.
e Unit Price: Displays the unit price of the item.

¢ Extended Price: Multiplies Quantity by Unit Price to display the extended price.
¢ Item Cost: Displays the inventory cost for the selected item.

e Extended Cost: Multiplies Quantity by Item Cost to display the extended cost.

® (Contract Information) Description: Displays the Contract name for the selected
Contract Number.

¢ Discount: Displays the discounted charges by applying the selected contract.

¢ Profit Margin: Displays the profit margin as a dollar value, for example, Profit
Margin = $128.45.

* Profit Margin%: Displays the profit margin as a percentage, for example, Profit
Margin% = 30%.

¢ Descriptive Flex Field: Displays the flexfield information associated with the repair
estimate line. You cannot edit the DFF field after the Repair Order status is changed
to Closed.

Estimate Charge Line Details Check Boxes

Check boxes in the Estimate Line Details region include:

e Override Charge: Select this if you want to edit the charges in the Estimated Charge
field.
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Note: To be able to change this field, you must set the value of the
profile option CSD: Allow Charge Override for Estimates to Yes.

No Charge: Discounts the charge line amount to zero or no charge.

Estimate Charge Line Details Buttons

Buttons on the Estimate Charge Line Details window include:

Save: Saves the repair estimate charge lines.

Close: Closes the Estimate Charge Lines Details window.

Repair Jobs Tab

Note: Oracle Depot Repair provides E-records and E-signature (ERES)
functionality in WIP mode via Oracle WIP.

Access the Repair Jobs tab from the Depot Repair Workbench. The Repair Jobs tab
displays details of WIP Repair Jobs pertinent to the Repair Order.

The Repair Jobs tab displays:

Job Name: The system shows the Repair Job name after you have created the Repair
Job.

Item: Displays the item for which the Repair Job has been created.
Organization: Displays the name of the repair organization.
Created: Displays the job quantity created.

Completed: Displays the job quantity completed.

(Allocated) Created: If the Repair Job is created for more than one Repair Order,
displays the quantity created for this Repair Order.

(Allocated) Completed: If the Repair Job is created for more than one Repair Order,
displays the quantity completed for this Repair Order.

Job Status: Displays the current status of the WIP Repair Job.

(Routing) Reference: Refers to the routing used for the Repair Job.

You create Routings in BOM. WIP uses Routings to assist the repair process. Each

2-30 Oracle Depot Repair User Guide



routing contains the operations and resource requirements for the Repair Job.

¢ (Routing) Alternate: Refers to the alternate if an alternate routing was used for the
Repair Job.

® Source Type: Displays Service Code or Manual, depending on how the Repair Job
was created

® Source Name: If Source Type is Service Code, the Source Name is the name of the
Service Code. If Source Type is Manual, the Source Name has no value.

Buttons and Actions field

Buttons on the Repair Jobs tab include:

¢ Refresh Job: Updates the Repair Job information in Oracle Depot Repair.

* Create Job: Launches the Submit Repair Jobs window.
For more information, see Submit Repair Jobs Window, page 2-30.
The Create Job button is disabled in the following situations:
¢ The profile option CSD: Allow Creating WIP Job Without RMA is set to No and

nothing has yet been received against the Repair Order.

e Estimate approval is required, and the estimate has not yet been approved.

The layout of the rest of the foot of the Repair Jobs tab depends on the value of the
profile option CSD: Repair Execution Mode.

If the value is WIP, the Repair Jobs tab contains an Actions field and a Go button. The
Actions list of values contains the following entries, which trigger the corresponding
operation when you click the Go button:

* View Job: Displays the WIP View Discrete Jobs window in a read-only mode to
show details of the Repair Job.

¢ Execute Move: Displays the WIP Move Transactions window, which enables you to
move the repair item through the operations.

e Transact Materials: Displays the Oracle Inventory Material Transactions window,
which enables you to issue the broken or damaged items and needed material for

the WIP Repair Job.

¢ Transact Resources: Displays the Resources window, which enables you to transact
resources to the WIP Repair Job.

e Complete Job: Displays the Oracle WIP Completion Transactions window, which
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enables you to complete the WIP Repair Job.

If the value is Depot Repair, the Repair Jobs tab contains the following button:

Execute Job: Launches the Repair Order page, in the Repair Execution tab. For more
information, see Using the Repair Execution tab.

Submit Repair Jobs Window

On the Submit Repair Jobs window, you can submit one or more WIP Repair Jobs for a
given Repair Order.

The Submit Repair Jobs window includes:

Repair Job Parameters Area Fields, page 2-30
Repair Order Area Fields, page 2-30
Service Codes, Bills and Routings Area Fields, page 2-30

Buttons, page 2-30

Repair Job Parameters Area Fields

The Repair Job Parameters area of the Submit Repair Jobs window includes the
following fields:

Item: Defaults to the Repair Order Item, but you can change the item.
Description

Job Name Prefix

If the value of the profile option CSD: Use CSD as Job Name Prefix is set to Yes, the
value in this field appears as CSD, and cannot be updated.

If the value of the profile option CSD: Use CSD as Job Name Prefix is set to No, the
value in this field defaults to the value of the profile option CSD: Default Job Name
Prefix, and can be updated.

(Quantity) Repair Order: Displays the number of item units on the Repair Order.

(Quantity) Received: Displays the number of item units received on the Repair
Order.

The other fields in the Repair Job Parameters area include:

(Quantity) Submit: Enter the number of item units that you want to submit for the
Repair Job. This field is mandatory.
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(Quantity) Submit must be greater than 0.

The default for the (Quantity) Submit depends on the value of the profile option
CSD: Allow Creating WIP Job Without RMA, as follows:

e If the value is Yes, (Quantity) Submit defaults to the Repair Order quantity.

e If the value is No, (Quantity) Submit defaults to the received quantity.

If the Repair Job Item is the same as the Repair Order Item, (Quantity) Submit
cannot exceed the default value.

If the Repair Job Item is different from the Repair Order Item, (Quantity)
Submit can exceed the default value.

Job Status: The job status with which you submit a Repair Job to WIP. Possible
values are Released and Unreleased. This field is mandatory.

This defaults to the value of the profile option CSD: Default Repair Job Status.

Note: For a WIP Repair Job to begin or for materials to be issued
against the job, the Job Status must be Released.

Accounting Class: The valuation and variance accounts associated with the
accounting classes determine which accounts are charged and when. You can select
any active asset non-standard or non-standard expense class. This field is
mandatory.

Start Date: The system date defaults as Start Date.

Complete Date: Select the completion date and time for the WIP Repair Job.
Defaults to the start date. This field is mandatory.

For more information on WIP-related fields, such as Accounting Class, see the Oracle
WIP User’s Guide.

Repair Order Area Fields

The Repair Order area contains the following read-only fields, related to the Repair
Order:

Customer
Number: The Repair Order Number.
Type: The Repair Type of the Repair Order.

Status: The status of the Repair Order.
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e Promise Date

Service Codes, Bills and Routings Area Fields

The Service Codes, Bills and Routings area is the region where you select which method
you want to use to create the Repair Job, as indicated by the radio buttons at the top of
the area:

¢ Use Service Codes
® Select Bills and Routings
* Do not Specify Bills and Routings

Below the radio buttons, there are two multi-record areas. The availability and use of
these multi-record areas depends on which radio button option you select.

Note: You cannot select the Use Service Codes button unless there are
Service Codes associated in the Diagnostics tab.

If there are any Service Codes associated to the Repair Order, the Use Service Codes
radio button option will be selected by default in the Submit Repair Jobs window.

In the Submit Repair Jobs window, you must perform the following sequence of steps:

1. Select one of the radio buttons.
2. Enter information in one of the multi-record areas, if the area is enabled.

3. Click Submit Jobs.

Use Service Codes

If you select the Use Service Codes radio button, then the associated Service Codes and
Bills and Routings will be displayed in the multi-record areas, and cannot be updated.

If you deselect the Use Service Codes radio button, the Service Code and Bill and
Routing information is cleared.

For details of selecting Service Codes, see Use the Diagnostics Tab and the Knowledge
Base, page 4-39.

For details of setting up Service Codes, see the Oracle Depot Repair Implementation Guide.

Select Bills and Routings

If you select the Select Bills and Routings radio button, the first multi-record area is not
applicable, but the second multi-record area is available for you to fill in manually, and
you must enter at least one bill or routing.
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The fields in the second multi-record area are as follows:

e Bills (Reference)

* Bills (Description)

e Bills (Alternate)

¢ Routing (Reference)

* Routing (Description)
* Routing (Alternate)

These fields refer to Bills and Routings that are set up in Oracle Inventory and Oracle
Bills of Material. For more information, refer to the User's Guides for these applications.

Do not Specify Bills and Routings

If you select the Do not Specify Bills and Routings radio button, neither of the
multi-record areas is applicable. With this option selected, when you submit a Repair
Job, it is submitted without any Bill or Routing information for creation in WIP.

Buttons
The Submit Repair Jobs buttons include:

¢ Submit Jobs: Submits the Repair Job to WIP for creation.

* (lose: Closes the Submit Repair Jobs window.

Note: If there are any errors during the process of submitting a WIP
Repair Job, such as an inactive Service Code, they will appear in an
Errors window.

Repair Tasks Tab

Note: Oracle Depot Repair provides E-records and E-signature (ERES)
functionality in Task mode via the Debrief screen for each Task.

You can access the Repair Tasks tab from the Depot Repair Workbench. On the Repair
Tasks tab, you can create the tasks needed to assist an item repair. This tab is enabled
only if the Repair Type chosen has been defined during implementation to use the
repair mode of Task.

The tasks appear in the Repair Tasks table. The fields on the Repair Tasks tab
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dashboard area include:

® Number: Displays the system-assigned Task Number.

Name: Displays the task name.

® Description: Displays the task description.

e Status: Displays the current task status.

e Priority: Displays the task priority, for example: Critical, High, Medium, or Low.
e Actual Start: Displays the task start date.

¢ Actual End: Displays the task end or completion date.

® Owner: Displays the task owner's name.

* Applicable Qa Plans: Indicates whether any quality collection plans are associated
with the task.

The fields on the Repair Tasks tab include:

*  Number: Displays the system-assigned Task Number.

e Type: Displays the service depot task type, for example: Callback, Diagnostic,
General, Repair, or Upgrade.

e Name: Displays the task name.
e Status: Displays the current task status selected from the list of values.

¢ DPriority: Displays the task priority selected from the list of values, for example:
Critical, High, Medium, or Low.

® Description: A free text field to enter a detailed description of the displayed task.

e Publish (check box): If you wish to display the task for the customer to see on their
Oracle iSupport Web portal, then select the Publish check box.

® Private (check box): Select the Private check box if this is a personal task and you do
not want other employees to view it. Any resource associated with the task, for
example an assignee, will have access to the task whether it is marked as private or
not.

* Owner Type: Displays the owner type selected from the list of values, for example:
Employee, Group, or Team Resource.

* Owner: Displays the task owner's name selected from the list of values.
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* Assignee Type: Displays the assignee type selected from Assignment Manager.
* Assignee: Displays the assignee selected from Assignment Manager.

The fields in the Dates section of the Repair Tasks tab include:

® Planned Start: Displays planned start date.

e Planned End: Displays planned end date.

® Scheduled Start: Displays scheduled start date.
e Scheduled End: Displays scheduled end date.
¢ Actual Start: Displays actual start date.

® Actual End: Displays actual end date.

The fields that appear in the Effort section of the Repair Tasks tab include:

e Estimate Qty: Displays estimated number of units to complete the task.
¢ Estimate UOM: Displays unit of measure used to describe the estimated effort.
* Actual Qty: Displays actual number of units used to complete the task.

® Actual UOM: Displays unit of measure used to describe the actual effort.

Repair Tasks Tab Buttons

Buttons on the Repair Tasks tab include:

* Assignment Manager icon (next to the Assignee field): Displays the Assignment
Manager window.

* Add Tasks from Diagnostics: Adds tasks associated with Task Template Groups
associated with the Service Codes marked as applicable in the Diagnostics tab.

® Use Template: Displays the Create Tasks from Template Group window to permit
creation of new tasks from previously defined templates.

* Launch Workflow: Starts the task workflow to reserve the designated resources and
notify the task owner of task creation.

¢ Debrief: Displays the Debrief Report window to capture the Material, Labor, and
Expense billing transactions used to complete the task.

* More: Displays the windows to display and capture additional task details
including:
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® Resources: Defines and displays resource requirements, assignments, and
scheduling information.

* Dependencies: Specifies ordering and prioritization of multiple tasks.

¢ References: Permits linking of task to different documents or to other pertinent
background information.

e Dates: Identifies more dates in addition to the planned dates.

¢ Contacts: Enables creation and management of multiple contacts who are
assigned to a task. The system obtains contact information from customer
information.

® Recurrences: Enables the scheduling of tasks to occur automatically.

e Others: Identifies additional information about the task.

* Audit: Displays an audit history log with the changed dates and the user
responsibility that initiated the changes.

Repair Actuals Tab

The Repair Actuals tab provides the data fields required for billing your customer for
charges incurred during the processing of items in Oracle Depot Repair.

The Repair Actuals tab contains the following elements:

¢ The Summary of Actual Charges area
* A multi-record area consisting of the charge line fields

e Buttons to allow you to perform the following operations:

® Specify from where to add lines to the Repair Actuals tab
* View further details of the charge lines
® Select and deselect all charge lines

® Book selected charge lines

Depending on how you choose to add lines to the multi-record area, certain fields and
buttons may be enabled or disabled. See the Comments at the end of this section, page
2-38.
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Summary of Actual Charges Area

The Summary of Actual Charges area displays a summary of the information which
appears in greater detail in the multi-record area.

The Summary of Actual Charges area consists of the following read-only fields:

Material: Total charge of all the charge lines with the Material billing category.
Labor: Total charge of all the charge lines with the Labor billing category.
Expenses: Total charge of all the charge lines with the Expenses billing category.
Total: Total charge of all the charge lines.

Currency: Currency of all the charges.

Repair Actuals Tab Multi-Record Area

The multi-record area in the Repair Actuals tab is populated either with data copied
from other Depot Repair Workbench tabs, or manually.

The multi-record area of the Repair Actuals tab includes the following fields:

Select (check box): Selects the charge line for booking.

Source Type: Describes the source of the actual charge line.
The available values are:

e WIP, Estimate, and Task, for lines copied from other Oracle Depot Repair tabs.

* Manual, if you enter the actual charge line manually in this window. This value
appears when you start to enter a new charge line.

Note: The fields marked with an asterisk (*) below are available
for you to enter data if the Source Type field is Estimate or
Manual.

Order Number: Displays the Order Number returned from Oracle Order
Management, after you click Book Selected.

Billing Category*
Item*

Serial Num*: This field is enabled for items that are serialized at receipt.
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¢ PO Number*

¢ Contract Number*

® DPrice List*

® Pricing Attributes*

° Qty*

¢ UOM*

¢ Unit Price

¢ Charge*: You can enter a Charge if you first set the check box Override Charge and
if the value of the profile option CSD: Allow Charge Override for Actuals is set to
Yes. See the Comments at the end of this section, page 2-38.

e Override Charge* (check box)

® No Charge* (check box)

Repair Actuals Tab Button Area

Comments

The button area contains mainly buttons, and one data field, as follows:
Select All button: Selects all the eligible charge lines in the multi-record area.
Deselect All button: Deselects all the eligible charge lines in the multi-record area.

Book Selected button: Books the selected charge lines in the multi-record area. This
button is visible only if you have the User Function Name Repair Orders: Submit Charges
associated with your responsibility.

Line Details button: Shows details of the actual charge line.
Source field: Source of charge lines to copy into the Repair Actuals window.

e For WIP mode repairs, the options are WIP and Estimate.
* For Task mode repairs, the options are Task and Estimate.

Add button: Click this to copy the charge lines into the Repair Actuals tab from the
source you selected in the Source field.

1. The Book Selected button and the Select check box are enabled for all sources.

2. For lines whose Source Type is WIP, all the fields in the multi-record area except
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Override Charge (if CSD: Allow Charge Override for Actuals is set to Yes) and No
Charge are disabled. If you check Override Charge, you can enter a new Charge.

3. For lines whose Source Type is Task, the Select check box is checked, by default,
and cannot be deselected. All the other fields in the multi-record area are disabled.

4. For lines whose Source Type is Task, only Book Selected and Line Details are
available to you, as task lines have already been flagged for interfacing to Oracle
Order Management.

Drill into Order Management

The Sales Order Number can optionally be hyperlinked to allow you to click on it to
launch the Sales Order window in editable mode and in context of the clicked Order
Number. You can enter information such as credit card number, ship method and
payment details, save the order, close the Sales Order screen and return to the Depot
Workbench without ever leaving.

You can navigate to the Sales Order window from the Logistics tab and the Repair
Actuals tab.

¢ From the Logistics tab: Select a Return Line, and book the order. A number appears
in the Order Number field. Click the Actions list and select the Update Sales Orders
option. This launches the Sales Order window. You can also launch the Sales Order
window by clicking on the hyperlinked Sales Order number.

e From Repair Actuals tab: Select the individual charge lines or click Select All to
book all the charge lines and click the Book Selected button. A number appears in
the Order Number field. Click the Order Number to launch the Sales Order
window. You can also launch the Sales Order window by clicking on the
hyperlinked Sales Order number.

Note: Set the profile option, CSD: Enable Sales Orders Hyperlink, to
Yes. This profile enables the Sales order hyperlink on the Logistics tab
and Repair Actuals tab.

Depot Repair Workbench Tools Menu

The Tools Menu of the Depot Repair Workbench provides the following facilities:
e Quick Menu: Launches the Quick Menu.

e Print Estimate: Submits the repair estimate for printing.

* Freeze Estimate: Freezes the repair estimate and prevents updates.
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* Capture Serial Numbers: For details, see Capture Serial Numbers.
e  Find Customer: For details, see Find Customer Window

* Split Repair Order: Allows the user to split a Repair Order. For more information,
see Split a Repair Order, page 4-76.

Profile: To view an existingcustomer profile, select Profile from the Tools menu. For
proper setup of the Profile window with customizable options, see the Oracle
TeleService Implementation Guide.

* Send Message: Choose Send Message from the Tools menu to send a workflow
notification message, and have that message link to the Repair Order selected in the
Depot Repair Workbench at the time the message was sent. For more information,
see the Oracle TeleService User Guide.

* View Message History: Choose View Message History from the Tools menu to
display the Message History window. For more information, see the Oracle Support
User Guide.

* Coverage: For details, see Coverage Window, page 2-41.

Capture Serial Numbers

Capture Serial Numbers window enables you to quickly create repair orders for
multiple quantity of the same serialized item. You can create a single Draft repair order
for the serialized item with a quantity greater than one, rather than creating a repair
order for each item individually. When you create a repair order for a serialized item
with quantity greater than one, it is automatically saved with a repair order status of
Draft. Once that repair order is saved, the Capture Serial Numbers menu item is
enabled. Select the Capture Serial Numbers menu item to launch the Capture Serial
Numbers window. Use this window to capture the serial numbers for each item.
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Click the Process button to create a new repair order for each serial number entered.
The quantity of items on the Draft repair order decrements for each new repair order
created. If you capture the entire quantity of serial numbers, the Draft repair order
disappears. However, you can enter a partial quantity of serial numbers and only
process those which have been entered, leaving the remaining quantity of serialized
items to be processed later.

Serial number region

Button

The fields enable you to enter the desired serial numbers for creating the repair orders.
Count field displays the total number of serial numbers you enter. If the serial number
is not currently in the installed base, then the system adds the item to the installed base
for you.

Buttons in the Capture Serial Numbers window include:

* View Errors: Button is disabled. This button enables if any processing errors occur,
and allows you to determine the reasons of failure.

¢ Save: Saves the serial numbers you enter
® Process: Creates a new repair order for each serial number entered and the quantity

of items on the Draft repair order decrements for each new repair order created. It
also adds any new serial numbers to the installed base for the customer on the SR.
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® C(lose: Closes the Capture Serial Numbers window

Find Customer Window

The Find Customer Window enables you to find customers based on an item in Oracle
Install Base. This feature is available when you create the Service Request for the Repair
Order.

10O GEBSP AANER I LEPLPE IR T?
= —ox

Service Request Information
Custorer Type

Customer Find all custamers who have the following item(s) in their install base:
Account -
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Repair Order Informati ST
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1608 BES05063120 Cs0oo01 70148 = =
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The header of the Find Customer Window enables you to find customers. Enter the
relevant search criteria in the following fields:

® Item: Select the item from the list of values.
e Instance: Select the appropriate instance from the list of values.

e Revision: This field is updatable only for items that are revision controlled. If the
item is revision controlled, you can select one of the defined revisions in the list of
values.

e Serial Number: This field is enabled when the item is defined as serial controlled in
the Inventory Item Master.

The Results region displays the names of the customers based on the search criteria
provided in the header.
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Coverage Window

The Coverage window displays detailed information about the Installed Base item and
Contract entitlements. When you select the Coverage option from the Tools menu in the
Depot Repair Workbench, active entitlements or all entitlements (based on option
button selection) applicable to the selected Repair Order appear.
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Lot Murn Repair Owner Date Closed
Repair Mode WP Project [ Automatically Enter and Book Rhla
Project Task ¥ Estimate Approval Required i
Notes  Depot Repair 4 Go... “iew Configuration. . Update Counters... Update RO Status...

Option Buttons

Option buttons in the Coverage window include:

View Active Contracts: Displays the active entitlements that are applicable to the
selected Repair Order.

View All Contracts: Displays all the entitlements that are applicable to the selected
Repair Order, including expired ones. This is a useful tool for service agents to
inform customers about contract coverage expiration and service contract renewal
opportunities to reinstate item coverage.

Multi-Record Area Region

The fields that appear in the multi-record area region include:

Default (check box): Permits the service agent to select a contract coverage to
override the coverage selected at the Service Request level. Select the Default check
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box corresponding to the relevant contract coverage, and click Apply to cause this
change. The system defaults this coverage to all charge lines associated with the
selected Repair Order. However, you cannot apply this selected default contract to
the Task Debrief charge lines. The selected contract at the Service Request level
applies by default to these charge lines.

e Contract Num: The item warranty or Service Contract Number.

e Service: The contract name, Warranty, PM, Support Only, and Full Service.

® Description: High-level description of the contract offering.

* Coverage: The service provider's contract coverage window in days and hours.
e Start Date: The warranty or contract's effective start date.

e End Date: The warranty or contract's effective end date.

Buttons

Buttons in the Coverage window include:

* View Coverage: Displays the Service Contracts Coverage window that shows
details of the selected coverage. You can access this window also by double-clicking
the Coverage (field) value of an entitlement. For more information, refer to the
online help available from the Service Contracts Coverage window.

® C(Close: Closes the Coverage window.

* Apply: Select the contract entitlement that you want to use as default by using the
Default check box, and click Apply. This selection overrides the existing default
contract. This selected contract becomes the default contract for the Repair Order.
However, note that this contract cannot be applied to the Task Debrief charge lines.
Instead, the contract selected at the Service Request level applies by default to the
Debrief charge lines.

Depot Repair Workbench Data Menu
The Data Menu of the Depot Repair Workbench provides the following facilities:
e Service History Window, page 2-47

¢ Activity Window, page 2-48

¢ Reserve/Unreserve Serial Number, page 2-48
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Service History Window

The Service History window displays all the Service Requests and service depot Repair
Orders that have been logged against an Installed Base item.

Note: An item must be Installed Base trackable in order for this
functionality to work.

A service agent can view a document by clicking the Repair Order or Service Request
Number links to display the historical document. This functionality permits the service
provider to review the service history and repair records spread over the lifetime of the
Installed Base item.

The Service History window displays the following information in the multi-record
areas:

Service Requests Fields

Service Requests fields include:

* Number: Service Request Number.

¢ Date Opened: Displays the creation date of the Service Request document.
* Date Closed: Displays the closed date of the Service Request document.

e Type: Displays the Service Request type.

e Status: Displays the current Service Request status.

® Severity: Displays the severity of the Service Request or Repair Order that the
owner set.

* Urgency: Displays the customer's urgency being weighted on the Service Request.

Repair Orders Fields
Repair Orders fields include:

e Number: Repair Order Number.

* Date Opened: Displays the creation date of the Repair Order document.
¢ Date Closed: Displays the closed date of the Repair Order document.

e Type: Displays the Service Request type.

® Status: Displays the current Repair Order status.
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® Service Request: Displays the Service Request Number that is linked to the Repair
Order.

Buttons
Buttons in the Service History window include:
¢ (lose: Closes the Service History window.
Activity Window
The Activity window provides the service depot agent with information about the
major events and activities that occurred for a Repair Order. The agent can view the
latest status with each event date and time stamped at the completion of a process step.
The fields that appear in the upper section of the Activity window include:
*  Qty Received: RMA quantity that the service depot received.
¢ Qty Submitted to WIP: Repair Order quantity submitted to the Repair Job.
e Qty Completed in WIP: Repair Job quantity completed in WIP.
Note: The Qty Submitted to WIP and Qty Completed in WIP fields
appear only for repairs being processed in WIP repair mode.
* Qty Shipped: Repair Order quantity shipped against the Sales Order.
The fields that appear in the lower multi-record area include:
e Event: The Repair Order event that the service depot completed.
¢ Date: The completion date or time stamp of the activity.
¢ Details: Specific information about a particular activity.
Buttons

Buttons in the Activity window include:

* C(lose: Closes the Activity window.

Reserve/Unreserve Serial Number

Reserve Serial Number feature enables you to place a reservation for the serial number
of the repaired item and perform pick release using the serial number reserved. Also
group APl is used from shipping team to pick release the item.
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Navigate to the Reserve Serial Number option from the Data menu to perform serial
number reservation manually. To un-reserve serial number manually, navigate to the
Unreserve Serial Number option from the Data menu.

Note: The subinventory on the ship line is required for reserve serial
number and un-reserve serial number.

Find Repair Orders for Job Submission Window

The Find Repair Orders for Job Submission window permits you to search for Repair
Orders against which you want to submit Repair Jobs. Access the Find Repair Orders
for Job Submission window by double-clicking Submit Repair Jobs under Depot Repair
in the Navigator window. Double-clicking Submit Repair Jobs displays the
Organizations window, where you choose the organization that is repairing the item or
where the item is being repaired.

In the Find Repair Orders for Job Submission window, use the following fields to
specify your search criteria or view the search results:

* Service Request Area Fields, page 2-49
® Repair Order Area Fields, page 2-49

® Search Buttons, page 2-49

® Results Area Fields, page 2-49

* General Buttons, page 2-49
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Service Request Area Fields

You can enter one or more Service Request search parameters in the following fields:

¢ Request Num: Service Request Number.

¢ Customer: Name of the person or organization.
* Account: Customer account.

® Severity: Service Request severity.

e Urgency: Service Request urgency.

Repair Order Area Fields

You can enter one or more Repair Order search parameters in the following fields:
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® Repair Num: Repair Order Number.

e Jtem: The Repair Order Item.

¢ Description: The description of the Repair Order Item.

¢ Serial Num: The Serial Number of the Repair Order Item.
¢ RMA/Sales Order Num: The RMA/Sales Order Number.
® Repair Type: The Repair Type of the Repair Order.

® Supercession Item: The Item that has been upgraded or changed and used to
replace another Item.

For more information about supercessions, see the Oracle Field Service User Guide.
® Description: The description of the supersession item.

* Internal Order Num: The internal Order Number for a refurbishment generated
from Spares Management.

¢ Internal Requisition Num: The internal Requisition Number for a requisition
generated from Oracle Purchasing.

® Create Date: Creation date of the Repair Order. Optionally, start and end dates for a
range of creation dates.

* Promise Date: The Promise date of the Repair Order. Optionally start and end dates
for a range of promise dates.

¢ Create Date: Creation date of the Repair Order. You can enter a creation date range
if you want to perform a search based on this attribute.

Search Buttons

The Search buttons, below the Repair Order area, include:
* Find: Searches and returns results based on your entered search criteria.

® C(lear: Clears the fields in which you have entered values to specify your search
criteria. You can enter new values to perform a new search.

Results Area Fields

The fields in results area are almost completely the same as the search parameter fields
in the Service Request and Repair Order areas. The main result fields, that appear in the
non-scrolling area, are:
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® Request Num: The Service Request Number for the Repair Order.
® Repair Number: The Repair Order Number.

¢ Item: The Repair Order Item.

General Buttons
The General buttons, in and below the Results area, include:

® Select All: Selects all the Repair Orders in the Results area.

® Deselect All: Deselects all the Repair Orders in the Results area.

Note: To select multiple, non-contiguous rows from among the
Search Results, press and hold the Control key, and click each row.

Note: To select a range of rows from among the Search Results,
click the first row of the range, then press and hold the Shift key,
and click the final row of the range.

¢ OK: Displays the Submit Repair Jobs for Repair Orders window for the selected
Repair Orders.

* Cancel: Closes the Find Repair Orders for Job Submission window.

Submit Repair Jobs for Repair Orders Window

On the Submit Repair Jobs for Repair Orders window, you can submit a single WIP
Repair Job for single or multiple Repair Orders to WIP.

The Submit Repair Jobs for Repair Orders window includes:

® Repair Job Parameters Area Fields, page 2-52
® Repair Order Details Tab, page 2-52
e Bills and Routings Tab, page 2-52

* Buttons, page 2-52
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Repair Jobs Parameters Area Fields

The fields in the Repair Jobs Parameters area include:

¢ Item: The item Number of the Repair Job. This field is mandatory.
¢ Description: The item description.

¢ Job Name Prefix: The job name prefix for the Repair Job.

If the value of the profile option CSD: Use CSD as Job Name Prefix is set to Yes, the
value in this field appears as CSD, and cannot be updated.

If the value of CSD: Use CSD as Job Name Prefix is set to No, the value in this field
defaults to the value of the profile option CSD: Default Job Name Prefix, and can be
updated.

® Job Status: The job status with which you want to submit a Repair Job to WIP.
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Possible values are Released and Unreleased. This field is mandatory.

This defaults to the value of the profile option CSD: Default Repair Job Status.

Note: For a WIP Repair Job to begin or for materials to be issued
against the job, the Job Status must be Released.

® Accounting Class: The valuation and variance accounts associated with the
accounting classes determine which accounts are charged and when. You can select
any active asset non-standard or non-standard expense class. This field is
mandatory.

e Start Date: The system date defaults as Start Date.

e Complete Date: Select the completion date and time for the WIP Repair Job.
Defaults to the start date. This field is mandatory.

* Total Submit Qty (read-only): Shows the total of the (Quantity) Submit values in the
lines of the Repair Order Details tab. This is the number of items that you want to
submit to WIP.

This is the same as the Released quantity for a Repair Order line when you selected
only one Repair Order for submission to WIP. When you are creating a Repair Job
for multiple Repair Orders, this field value is the sum of the quantities for all the
Repair Orders that you are submitting.

For more information on WIP-related fields, such as Accounting Class, see the Oracle
WIP User’s Guide.

Repair Order Details Tab

The Repair Order line or lines that you selected from among the search results in the
Find Repair Orders for Job Submission window populate the Repair Order Details tab.
The fields on the Repair Order Details tab include:

* (Quantity) Repair Order (read-only): Shows the item quantity in a Repair Order.

* (Quantity) Received (read-only): Shows the quantity of items that you received
against a Repair Order.

*  (Quantity) Submit: Quantity of items in a Repair Order that you want to submit to
WIP for repair.

Bills and Routings Tab

You can optionally specify Bills and Routings to be used on the Repair Job.

The fields on the Bills and Routings tab include two radio buttons:
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® Select Bills and Routings
¢ Do not Specify Bills and Routings

The multi-record area, which is enabled only if you select the Select Bills and Routings
radio button, consists of the following fields:

e (Bill) Reference

e (Bill) Description

e (Bill) Alternate

* (Routing) Reference

¢ (Routing) Description

* (Routing) Alternate

Buttons

The buttons include:

¢ Submit Jobs: Submits the Repair Job or jobs to WIP for creation.

¢ (lose: Closes the Submit Repair Jobs for Repair Orders window.

Define Triggers for Service Bulletins

Depot Repair provides an interface to the repair manager enabling him to trigger
notifications, escalations, and/or workflows based on key business events in the repair
shop. The repair manager can drill down to the details of critical activities to speed up
the resolution of issues, thereby increasing customer satisfaction.

Key business events include:

* Past Due Repairs

® Overdue Customer Returns or Loaners

® Product Returned Multiple Times

¢ Products Under Recall

* Products Requiring WEEE, RoHS, or other Regulatory Compliance

® Repair Order item has an Expiring contract
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e Third party return due date

Setting up Service Bulletins
To set up service bulletins
1. Navigate to the Service Bulletins page.

This page displays the existing service bulletins in a summary table. The Simple
and Advanced Search options enable you to look for a particular service bulletin.

C)IQAC LE' Depot Repair

Diagnostics Home Logout Preferences

Service Bulletins
A Service Bulletin that is "active” is one that has been published AND today's date is between the Service Bulletin's start date and end date. —
simple Search
Note that the search is case insensitive Advanced Search
MName Q Mandatory [¥]
Type Q Published [¥]
Start Date & HERE [¥]
End Date @
[ 6o | | clear
Nlew Service Bulletin (0)
Name |pescription [Type |start Date|End Date|Active|update Duplicate
Service Bulletin for Third Farty Return Due Date Bulletn PR B
3 strikes rule Bulletin v | 2 B
Bulletin for Expiring Contract Bulletin v | 2 B
Service Bulletin for Loaner Repair Return Order Service Bulletin for Loaner Repair Return Order Bulletin v | 2 [
test Bulletin 2 B
Save Search

Diagnostics Home Logout Preferences
About this Page  Privacy Statement Copyight (c) 200, Oracie. Al rights reserved.

2. Click the Duplicate icon to duplicate a service bulletin. This reduces the overhead of
bulletin creation.

3. Click the New Service Bulletin button to navigate to the Create Service Bulletins
page.

4. Enter the information in the following fields. The fields marked with an asterisk (*)
are mandatory:

¢ Name: Name of the service bulletin.

® Description: Description of the service bulletin.

e Type: Select the type of the service bulletin.

*  Workflow Process: Associate a workflow process to the service bulletin.

* Frequency: Select how frequently the service bulletin is applied.

Apply Once per Item Instance implies that the service bulletin is applied only
once for a particular instance. For example, you can set this frequency when an
engineering change order is applied only once and for which the same bulletin
does not need to be applied repeatedly. A bulletin with this frequency never
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gets attached to Repair Orders with Non-Installed Base items.

Apply Once Per Repair implies that the service bulletin is applied every time
there is a new repair order.

* Mandatory: Select this checkbox to mark the service bulletin as mandatory on
the repair order.

e Escalation: You can define your own statuses.
e Start Date: The activation date of the service bulletin.

¢ End Date: The expiration date of the service bulletin.

Note: If the dates' field is left blank, it implies that the service
bulletin is always active.

C)lQAcl_En Depot Repair

Diagnostics Home Logout Pr

Senice Bullstins >
Create Service Bulletin
* Indicates required field publish (0) | | Cancel | | save | | Apply
*Name |Demo Service Bulletin [ Mandatory
Description |Dema Service Bulletin Escalation
= Type |Bulletin ] Start Date =]
Workflow Process Q End Date =]
* Frequency | Apply Once per Repair [~ O published

|- Service Codes
Code ~ [name I |active From|Active Tof
RBO11-A Q. Repalr bonnet Valve leak in bonnet - Repair 13-Sep-2004 o

Add Another Row
|-l Attachments
Search
Note that the search is case insensitive

Title Go
[ show More Search Options

Add Attachment
Title  [Type [Description |category [Last updated By [Last updated |usage | update  Dpelete Publish to Catalog
Demo  Short Text ADI Kiosk Default Logo EBUSINESS 16-Jul-2008 One-Time 2 7] =}
|-l Rules
Name & [Description |petails Duplicate Remove
Ttem = CSD00L B [iE] i}

Add Another Row

publish (0) | | cancel | | save | | Apply

In the Service Codes region, click Add Another Row to define the service codes for
the service bulletin.

You can add one or more attachments to a service bulletin using the Attachments
region. Click Add Attachment to navigate to the Add Attachment page.

Note: You can add a File, URL, or Text as an attachment.
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7. The Rules region enables you to define multiple rules to associate to the service
bulletin. Click Add Another Row to define rules.

8. Click the Details link in the Rules region to navigate to the Update Service Bulletin
Rule page.

9. Use the Conditions region to define conditions for the rule. Click Add Another Row
to enter the condition.
A rule can have multiple conditions and all the conditions are evaluated to hold
true for the rule to apply.

10. Click the Details link to navigate to the Update Rule Condition page.

11. Enter the required rule conditions and click Apply.

12. Navigate back to the Create Service Bulletin page and click Publish.

Note: Once you publish the service bulletins, it becomes read only.
You can only modify the start and end dates.

Receive Unplanned Returns

Bulk receiving module facilitates you to receive unplanned returns. The general
principle behind receiving unplanned returns is to enable you to record easily the
information required to process repair order items arriving in the depot without an
return materials authorization (RMA).

You use the bulk receiving function to create a batch of items per customer per
shipment. The items can have the attributes, serialized or non serialized, trackable or
non trackable, and the like. All combinations of these attributes are allowed.

See: Receiving Returns using the Bulk Receiving Module, page 8-1.

Execute Repair

The Repair Technician module automates and facilitates the creation of work orders,
issuing materials, and assigning resources, helping the repair technicians to take good
decisions. Based on a finite number of possible symptoms and a finite number of
responses to those symptoms, the system can recommend or dictate work to be done,
materials demanded, and resources needed for complex repairs based on symptoms
captured by a technician.

See: Executing Repairs using the Repair Technician Module, page 9-1.
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3

Oracle Depot Repair Business Scenarios

This chapter describes working with different service depot repair business scenarios.

This chapter covers the following topics:

Process a Repair and Return

Process a Loaner, Repair and Return
Process an Exchange

Process an Advance Exchange

Process a Replacement

Process an Internal Order Refurbishment
Process a Third Party Repair

Process a Return Only Repair

Process a Repair and Return

The following steps describe in the recommended order how to process a Repair and
Return scenario.

For more information, see Repair and Return, page 1-2.

Steps:

1.

If you have not already created a Service Request, then Create a Service Request in
the Depot Repair Workbench, page 4-12.

Create a Repair Order, selecting Repair and Return as the Repair Type.

If the create process is successful, the application automatically creates two charge
lines, one with Action Type Return, the other with Action Type Ship.

If you have not created and booked the Return line automatically as part of the
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process of creating the Repair Order, then book the Return line.
See Create and Book a Return Line Manually, page 4-26.

4. If you want to diagnose the problem by searching Oracle Knowledge Management
for solutions to related problems, or if you want to apply Service Codes to help in

creating estimates and WIP Repair Jobs for the current Repair Order, see Use the
Diagnostics Tab and Knowledge Base, page 4-39.

5. Receive the item, with or without inspection, page 4-65.

6. The ability to create an estimate is controlled by a profile option. If this is enabled,
and you want to create an estimate, then estimate the repair charges, page 4-54
and, if required, obtain the customer's approval.

e If the customer accepts the repair estimate, then proceed to step 7.

e If the customer rejects the repair estimate, then close the Repair Order, page 4-
121 and the Service Request, page 4-122, if appropriate, to end this scenario.

7. Manage the repair process using either WIP or Task repair mode.

The definition of the Repair Type that occurred during setup determines the repair
mode. Based on this definition, the Repair Jobs tab or Repair Tasks tab is available.

Note: The repair mode associated with the seeded Repair Type
Repair and Return is WIP.

For more information, see the following topics:

* Manage the Repair Process, page 4-79
¢ Create and Process WIP Jobs, page 4-79

* Create and Process Repair Tasks, page 4-90

8. If you have not created the Ship line automatically as part of the process of creating
the Repair Order, then create the Ship line manually.

See Create a Ship Line Manually, page 4-103.

9. Ship the repaired item, and process the Ship line accordingly.
See Ship a General Item, page 4-105.

10. If required, create actual charges for the Repair Order.

See Record Billing Data in Repair Actuals, page 4-112.

11. If required, book the actual charges for the Repair Order.
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12,

13.

14.

See Book Repair Actuals, page 4-119.

If required, invoice the customer.

See Invoice a Customer, page 4-120.
Close the Repair Order, page 4-121.

If appropriate, close the Service Request, page 4-122.

Process a Loaner, Repair and Return

The following steps describe in the recommended order how to process a loaner, repair

and return.

For more information, see Loaner, Repair and Return, page 1-2.

Steps:

1.

If you have not already created a Service Request, then Create a Service Request in

the Depot Repair Workbench, page 4-12.

Create a Repair Order, selecting Loaner, Repair and Return as the Repair Type.

If the create process is successful, the application automatically creates these charge

lines:

¢ Ship line for loaner
® Return line for defective item return
¢ Ship line for repair of defective item

e Return line to track the loaner item return

If you have not created the Ship line for the loaner automatically as part of the
process of creating the Repair Order, then create the Ship line manually.

See Create a Ship Line Manually, page 4-103.

Ship the loaner item, and process the Ship line accordingly.
See Ship a General Item, page 4-105.
If you have not created and booked the Return line for the defective item

automatically as part of the process of creating the Repair Order, then book the
Return line.

See Create and Book a Return Line Manually, page 4-26.
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7. If you want to diagnose the problem by searching Oracle Knowledge Management
for solutions to related problems, or if you want to apply Service Codes to help in
creating estimates and WIP Repair Jobs for the current Repair Order, see Use the
Diagnostics Tab and Knowledge Base, page 4-39.

8. Receive the defective item, with or without inspection, page 4-65.

9. The ability to create an estimate is controlled by a profile option. If this is enabled,
and you want to create an estimate, then estimate the repair charges, page 4-54
and, if required, obtain the customer's approval.

e If the customer accepts the repair estimate, then proceed to step 10.

e If the customer rejects the repair estimate, then close the Repair Order, page 4-
121 and the Service Request, page 4-122, if appropriate, to end this scenario.

10. Manage the repair process using either WIP or Task repair mode.

The definition of the Repair Type that occurred during setup determines the repair
mode. Based on this definition, the Repair Jobs tab or Repair Tasks tab is available.

Note: The repair mode associated with the seeded Repair Type
Loaner, Repair and Return is WIP.

For more information, see the following topics:

* Manage the Repair Process, page 4-79
® Create and Process WIP Jobs, page 4-79

* Create and Process Repair Tasks, page 4-90

11. If you have not created the Ship line for the repaired item automatically as part of
the process of creating the Repair Order, then create the Ship line manually.

See Create a Ship Line Manually, page 4-103.

12. Ship the repaired item, and process the Ship line accordingly.

See Ship a General Item, page 4-105.

13. If required, create actual charges for the Repair Order.

See Record Billing Data in Repair Actuals, page 4-112.

14. If required, book the actual charges for the Repair Order.
See Book Repair Actuals, page 4-119.

15. If required, invoice the customer.
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See Invoice a Customer, page 4-120.

16. When the loaner item is returned, book the Return line for the loaner item.

See Create and Book a Return Line Manually, page 4-26.
17. Receive the returned loaner item, with or without inspection, page 4-65.

18. If additional charges, such as rental charges, are required for the loaner item, create
actual charges for the Repair Order.

See Record Billing Data in Repair Actuals, page 4-112.

19. If required, book the actual charges for the Repair Order.
See Book Repair Actuals, page 4-119.

20. If required, invoice the customer.

See Invoice a Customer, page 4-120.
21. Close the Repair Order, page 4-121.

22. If appropriate, close the Service Request, page 4-122.

Process an Exchange

The following steps describe how to process an exchange in which an item is sent to the
customer after the service depot has received the defective item.

Note: Processing for the Exchange Repair Type typically does not
include a repair stage.

For more information, see Exchange, page 1-2.

Steps:

1. If you have not already created a Service Request, then Create a Service Request in
the Depot Repair Workbench, page 4-12.

2. Create a Repair Order, selecting Exchange as the Repair Type.
If the create process is successful, the application automatically creates two charge
lines, one with Action Type Return, the other with Action Type Ship.

3. If you have not created and booked the Return line automatically as part of the

process of creating the Repair Order, then book the Return line.

See Create and Book a Return Line Manually, page 4-26.
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4. Receive the item, with or without inspection, page 4-65.

5. If you have not created the Ship line automatically as part of the process of creating
the Repair Order, then create the Ship line manually.

See Create a Ship Line Manually, page 4-103.

6. Ship the exchange item, and process the Ship line accordingly.

See Ship a General Item, page 4-105.

7. If required, create actual charges for the Repair Order.

See Record Billing Data in Repair Actuals, page 4-112.

8. If required, book the actual charges for the Repair Order.
See Book Repair Actuals, page 4-119.

9. If required, invoice the customer.

See Invoice a Customer, page 4-120.
10. Close the Repair Order, page 4-121.

11. If appropriate, close the Service Request, page 4-122.

Process an Advance Exchange

The following steps describe how to process an advance exchange in which an exchange
item is sent to a customer before the defective item has been received back from the
customer for a credit.

Note: Processing for the Advance Exchange Repair Type typically does
not include a repair stage.

For more information, see Advance Exchange, page 1-2.

Steps:
1. If you have not already created a Service Request, then Create a Service Request in
the Depot Repair Workbench, page 4-12.

2. Create a Repair Order, selecting Advance Exchange as the Repair Type.

If the create process is successful, the application automatically creates two
transaction lines, one with Action Type Ship, the other with Action Type Return.

3. If you have not created the Ship line automatically as part of the process of creating
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10.

11.

the Repair Order, then create the Ship line manually.

See Create a Ship Line Manually, page 4-103.

Ship the exchange item, and process the Ship line accordingly.

See Ship a General Item, page 4-105.

If you have not created and booked the Return line automatically as part of the
process of creating the Repair Order, then book the Return line.

See Create and Book a Return Line Manually, page 4-26.
Receive the item, with or without inspection, page 4-65.

If required, create actual charges for the Repair Order.

See Record Billing Data in Repair Actuals, page 4-112.

If required, book the actual charges for the Repair Order.

See Book Repair Actuals, page 4-119.

If required, invoice the customer.

See Invoice a Customer, page 4-120.
Close the Repair Order, page 4-121.

If appropriate, close the Service Request, page 4-122.

Process a Replacement

The following steps describe how to process a replacement in which the service depot
sends a replacement item to the customer.

Note: Processing for the Replacement Repair Type typically does not
include a repair stage.

For more information, see Replacement, page 1-2.

Steps:

1.

If you have not already created a Service Request, then Create a Service Request in
the Depot Repair Workbench, page 4-12.

Create a Repair Order, selecting Replacement as the Repair Type.

If the create process is successful, the application automatically creates one
transaction line with action type Ship.
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3. If you have not created the Ship line automatically as part of the process of creating
the Repair Order, then create the Ship line manually.

See Create a Ship Line Manually, page 4-103.

4. Ship the exchange item, and process the Ship line accordingly.

See Ship a General Item, page 4-105.

5. If required, create actual charges for the Repair Order.

See Record Billing Data in Repair Actuals, page 4-112.

6. If required, book the actual charges for the Repair Order.
See Book Repair Actuals, page 4-119.

7. If required, invoice the customer.

See Invoice a Customer, page 4-120.
8. Close the Repair Order, page 4-121.

9. If appropriate, close the Service Request, page 4-122.

Process an Internal Order Refurbishment

Defective items in a Spares Management warehouse can be sent for repair to a Oracle
Depot Repair depot, and returned to Spares Management after repair.

Note: Spares Management is a module of Oracle Field Service.

From Spares Management, you identify how many units of each defective item you
wish to repair. Then you create a Service Request and one or more Repair Orders, also
within Spares Management, as follows:

* For serialized items, there is one Repair Order for each item instance.
* For non-serialized items, there is one Repair Order for each item.

The type of repair carried out in this situation is called a refurbishment.

From the depot's perspective, defective items are received via an Internal Requisition,
and usable or repaired items are shipped via an Internal Order.

The following steps describe how to process a refurbishment for an item or item
instance, for which a Repair Order has been created in the Spares Management module
of Oracle Field Service.
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Steps:

The steps below describe the processing for an individual refurbishment Repair Order.

1.

In the Find Repair Orders window, search for the Repair Order created in Spares
Management.

When the Repair Order appears in the Depot Repair Workbench, certain fields are
filled in, as follows:

¢ In the Service Request Information area, the Summary contains a standard

description, such as "Internal Refurbish repair".

® In the Repair Order Information area, the Repair Type indicates that the item is
to be refurbished; the value of the Repair Type is provided by the profile option
CSD: Repair Type Internal Repair Order.

The Repair Type must have been set up with a Repair Type Ref of
Refurbishment, and its Internal Order check box must have been set.

For more information on setting up Repair Types, see the Oracle Depot Repair
Implementation Guide.

Note: Because refurbishment Repair Orders are processed as
internal orders, the Repair Estimate tab, the Repair Actuals tab,
and the Tools > Coverage option are disabled.

Click the Logistics tab.

The Repair Order has two transaction lines, one with Action Type Move In, the
other with Action Type Move Out.

The Move In transaction processes the transfer of the defective item from the Spares
Management location into a depot for repair.

The Move In transaction is a two-stage process:

1. First, the item is shipped from Spares Management.

2. Then, the item is received into a depot subinventory.

The Move Out transaction is a single-stage process - the item is shipped from
the depot after it has been repaired.

Note: The Move In and Move Out transactions make use of
existing Internal Order and Internal Requisition functionality.
From the depot's perspective, defective items are shipped via
the Internal Requisition, and usable or repaired items are
shipped via the Internal Order.
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3. Process the two-stage transfer of the item into a depot, page 4-70.
4. Perform any required repairs on the item, page 4-79.

5. Process the shipping of the item back to the Spares Management location after
repair, page 4-109.

6. If appropriate, close the Repair Order, page 4-121.

7. If appropriate, close the Service Request, page 4-122.

Process a Third Party Repair

The repair centres require the ability to interface with third parties to fulfill a customer's
service requirements. Repair centres track the movement of products, work, and
financial obligation between all the parties involved in executing a repair.

For a third party repair execution, an Outside Processing (OSP) operation is created in
the Repair Technician Portal. OSP operations are not specific to Depot Repair, they are
standard in Work in Process (WIP). Essentially, completing the OSP operation triggers
the creation of a purchase order with a request to procure service from a third party.

For more information, see Third Party Flows, page 4-124.

Process a Return Only Repair

The return only repair functionality is used when a repair type is setup to have an RMA
line. In this case, there is no corresponding ship line. When an item is returned, you
have the following options:

e [Jtems are returned for credit
e [tems are returned to stock
® Items are returned for salvage

For example, when an item is returned, all the parts are first salvaged, the parts are
recycled, and the remaining parts are scrapped.
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4

Depot Workbench

This chapter describes task-based procedures for different processes that a user can
perform to fulfill responsibilities.

This chapter covers the following topics:

Overview of Managing Business Processes

View Customer Profile

View Coverage Information

View Service History

Determine Contract and Price List Defaults at Repair Order Creation
Create a Customer Contact

Create a Service Request

Find a Customer for an Installed Base Item

Create a Repair Order in the Depot Repair Workbench

Create a Repair Order Starting From Oracle TeleService

Create a Repair Order Starting From Oracle Order Management
Update the Repair Order Status

Update the Repair Type of a Repair Order

Create and Book a Return Line Manually

Move Items Internally

Find Service Requests and Repair Orders

Transfer Install Base Ownership

Create and Maintain Notes

Use the Diagnostics Tab and Oracle Knowledge Management

Manage Diagnostic Codes in the Diagnostics Tab
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e Search Oracle Knowledge Management

* Manage Solutions in the Diagnostics Tab

* Manage Service Codes in the Diagnostics Tab

® Select Service Codes Manually in the Service Codes Area
® Activate and Deactivate Service Codes in the Service Codes Area
® Delete Service Codes in the Service Codes Area

e Estimate Repair Charges

¢ Create a Repair Estimate

* Revise a Repair Estimate

® Obtain Customer Approval for a Repair Estimate

® Receive a General Item

¢ Ship Additional Items

¢ Auto-Receive an Item

® Receive an Item for an Internal Order Refurbishment

e Split a Repair Order

* Manage the Repair Process

* Create and Process WIP Repair Jobs

¢ Create a WIP Repair Job for a Single Repair Order

® Process a WIP Repair Job for a Single Repair Order

® Create a WIP Repair Job Across Multiple Repair Orders
® Process a WIP Repair Job Across Multiple Repair Orders
¢ Create and Process Repair Tasks

¢ Create a Repair Task Manually

® Create a Repair Task Using a Task Template

e Enter and Update Task Details

® Prepare the Repair Tasks Debrief

* View Activities Related to a Repair Order

* Update Repair Orders Concurrently

* Send and View Workflow-Based Messages

® Create a Ship Line Manually

® Ship a General Item

* Ship a Refurbished Item
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® Record Billing Data in Repair Actuals

e Add WIP Summary to Repair Actuals

* Add Task Debrief to Repair Actuals

* Add Estimate to Repair Actuals

® Create Manual Charges in Repair Actuals

* Book Repair Actuals

¢ Invoice a Customer

¢ (lose a Repair Order

* C(lose a Service Request

¢ Create and Process an Internal Party Refurbishment

® View Repair Orders in Oracle iSupport

e Third Party Flows

¢ Execute Outside Processing

® Select Repair Parts from Dynamic Repair BOM Window
* Print Traveler Document

* View Service Bulletins using Depot Repair Workbench

¢ View Read Only Workbench

Overview of Managing Business Processes
Oracle Depot Repair improves the efficiency of the service depot repair process.

Many different users can be involved in the overall service depot process. These users
and roles include the call center agent, service technician, shop floor technician, shop
floor accountant, shop floor production manager, warehouse administrator, shipping
administrator, receiving administrator, service administrator, accounts receivable
manager, purchasing manager, HR manager, and depot manager.

For example, the call center agent logs the Service Request, the service technician
diagnoses the broken part, the shop floor technician fixes the item, the shop floor
accountant keeps track of the repair costs, the shop floor production manager schedules
the repair jobs, and the depot manager has the overall repair process responsibility.
Depending on the service organization, a user can have multiple roles. For example, the
service technician can log the Service Request, and diagnose the broken part.

For key concepts and features of Oracle Depot Repair, see the Introduction to Depot
Repair.

To explore the Oracle Depot Repair user interface, see Overview of Using Oracle Depot
Repair.
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For an overview of the processes behind different depot repair business scenarios, see
Oracle Depot Repair Business Scenarios.

Note: To discover how to easily receive many items as they arrive in the
depot without an RMA, see Performing Bulk Receiving.

To use an enhanced set of operations to process your repairs, see
Performing High Volume Repair.

View Customer Profile

The customer profile summarizes customer information. A system administrator
usually sets up the profile entries that appear in the customer profile, which contain a
set of previously defined verifications. You can configure these verifications, as well as
the actual range values and value definitions. The verification results appear by using
the Customer Profile Engine, which is a concurrent program.

The customer profile information appears in the Profile window when you select Profile
from the Tools menu in the Depot Repair Workbench. Click Refresh in the Profile
region to view the latest profile information for the customer. This Oracle Depot Repair
functionality lets service agents verify a customer's profile information, including Open
Orders, Booked Orders, Cancelled Orders, Open Service Requests, Escalated Service
Requests, Active Contracts, Expired Contracts, Cancelled Contracts, Open Repair
Orders.

Module

Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

Repair Order records associated with the customer must exist in the database.

Navigation
Depot Repair > Repair Orders > (Find Repair Orders window) New

Steps:
1. In the Depot Repair Workbench, select the customer whose profile you want to
view.

2. Select Profile from the Tools menu.
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The Profile window opens.

3. Double-click a key indicator in the profile window.

Oracle Depot Repair shows a summary list of that profile verification. For example,
double-clicking Open Service Request (a key indicator) displays the list showing all
open Service Requests for the selected customer type.

This list displays information such as the Service Request Number, incident date,
problem code and resolution code.

4. Double-click any line in the summary list.

Oracle Depot Repair displays the appropriate window containing details of the
selected line.

View Coverage Information

Items that a warranty or service contract covers and that link to Oracle Installed Base,
populate the coverage fields with a list of all entitlements or all active entitlements
(based on option selection) that apply to the selected Repair Order.

Oracle Depot Repair permits the service agent to select a contract coverage that can be
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applied to the Sales Order charge lines that Charges created. The selected Contract
Number automatically defaults on each charge line that is generated from the WIP
Summary Report only. This option excludes those charge lines that relate to any new
item upgrades and enhancements. The agent can verify active warranties existing for
the item. Also, the contract selected as default in the Coverage window cannot be
applied to charge lines in the Debrief Report. Instead, the contract selected at the Service
Request level applies by default to the Debrief charge lines.

Oracle Depot Repair also permits the agent to find all contracts including those that
have already expired. This is a handy tool for service agents to advise customers on
contract coverage expiry, and service contract renewal offers to reinstate their coverage.

Module

Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

You can view coverage information only for an Installed Base item referenced on a
Repair Order.

Navigation
Depot Repair > Repair Orders
Steps

1. Retrieve the Repair Order referencing the item for which you want to view
coverage information.

For more information, see Find Service Requests and Repair Orders, page 4-32.

2. Select the relevant result from the Results area of the Find Repair Orders window,
and click OK.

The Depot Repair Workbench shows the selected Service Request and Repair Order
details.

3. From the top menu, select Tools > Coverage.
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Wiew Coverage Close Apply

The Coverage window displays the configuration and entitlements for the Installed
Base item referenced on the Repair Order.

Based on option selection, you can automatically query all contracts or all active
contracts applicable to the Repair Order. By selecting the Default check box beside a
contract, you apply this as the default contract to the Repair Order. For detailed
field descriptions, see Coverage Window, page 2-41.

If you select a contract that does not specify a Price List, the application defaults the
Price List that is set for the default Price List profile option. This happens if the Price
List currency is the same as the Repair Order currency. If the Price List currency is
not the same as that of the Repair Order, or if the profile option is not set, you can
select any Price List from the list.

View Service History

Service agents can view all the Service Requests and Repair Orders that were logged
against a service item. The item must be serialized and linked to an Installed Base
Instance value in order for this functionality to work. This valuable functionality
permits the service provider to review the service history and repair records that were
recorded over the lifetime of the Installed Base item, and is especially useful when
attempting to troubleshoot and diagnose repair patterns and service trends that affect
the item.

The following procedures describe how to view an item's service history.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User
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Prerequisites

You can view the service history of only an Installed Base item. Repair Order records
must exist for the item.

Navigation
Depot Repair > Repair Orders
Steps:
1. Retrieve the Repair Order corresponding to the item, the service history of which

you want to view.

For more information, see Find Service Requests and Repair Orders, page 4-32.

2. Select the relevant result from the Results area of the Find Repair Orders window,
and click OK.

The Depot Repair Workbench shows the selected Service Request and Repair Order
details.

3. From the top menu, select Data > Service History.

The Service History window lists all the Service Requests and Repair Orders
previously opened against the Installed Base item on a Repair Order.

For detailed field descriptions, see Service History Tab, page 2-47.

Service Request

~_ Mumber Date Opened Jate Cloged Severity Urgency
02-DEC-2003 16:49:50 SR_Charge Inoperable
|08-DEC-2003 16:01:43 Depot Repair Inoperable

16-DEC-2003 17:32:35 SR_Charge

Repair Order

_ Mumber Date Opened se
02-DEC-2003 16:51:23 Repair and Return
|03-DEC2003 15:09:19 Repair and Return
03-DEC-2003 15:23:49 Repair and Return

Determine Contract and Price List Defaults at Repair Order Creation

A service contract has entitlements, for example, discounts, and response time.
Entitlements are specified for each business process setup for the contract. There are
cases where a contract can have entitlements that are specified for the Business Process
of the Service Request, but not for the Depot Repair Business Process. If that is the case,
Oracle Depot Repair cannot use that contract.

The rest of this section describes how the default contract and Price List are evaluated
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when you create a new Repair Order.

Default Contract

Default Price List

If there is a contract in the Service Request, it becomes the default contract only if
the contract is valid for the Business Process associated with the Oracle Depot
Repair Repair Type in the Repair Order.

If the contract in the Service Request is not valid for the Business Process associated
with the Oracle Depot Repair Repair Type or if there is no contract in the Service
Request, the "best" contract calculated by response time becomes the default
contract.

1. With Contract

N

If there is a contract, get the Business Process Price List of the contract for the Repair
Type in the Repair Order and derive the currency.

If the contract does not have a Business Process Price List for the Repair Type, get
the contract (selling) Price List and derive the currency. If there is no Price List, then

get the default from the profile option CSD: Default Price List.

If the profile option CSD: Default Price List is not set, get the Repair Type Price List
and derive the currency.

If Repair Type Price List is not set, neither the currency nor the Price List is set.

. Without Contract

If no contract is set, get the default Price List from the profile option CSD: Default
Price List and derive the currency.

If the profile option CSD: Default Price List is not set, get the Price List from the
Repair Type setup and derive the currency.

If the Repair Type Price List is not set, neither the currency nor the Price List is set.

Create a Customer Contact

You can create a new contact for a customer in the Depot Repair Workbench, and use

this contact while creating your new Service Request.
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Module

Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

The customer whose new contact is being created must have an existing record in the
database.

Navigation
Depot Repair > Repair Orders
Steps:

1. In the Find Repair Orders window, click New to display the Repair Orders
window.

The Repair Orders window serves as the Depot Repair Workbench. From the Depot
Repair Workbench, you can perform all depot processes, end-to-end.
2 In the Depot Repair Workbench, in the Service Request Information area, click New

Contact.

The New Customer window opens.
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In the New Customer window, select the Customer Type: Person or Organization.

Customer Type refers to the type of the contact, and indicates whether or not the
contact is a person or an organization.

When you select the Person Customer Type, the following fields appear:

e Title: Indicates the contact's title, such as Miss, Mr., Mrs., and Dr.

e  First, Last, Middle, Suffix: Indicate the First, Last and Middle names of the
contact, and Suffixes in the name.

* Phone: Indicates the contact's phone number. You can look up area codes in the
list of values.

¢ Type: Refers to the phone type, such as Work, Home, Cell, or General. Select
from the list of values.

* Relation: Specifies the contact's relationship with the customer, such as
Associate of, Child of, and Benefactor of. Select from the list of values.

¢ DParty: Refers to the name of the customer. Select from the list of values.
* Email: Enter the contact's e-mail address.

e (Create Account: Check box, when selected, creates an account for the new
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contact in your database.

e Bill-to: Refers to the address to which you should send the contact's bill.

When you have entered the Country in the Address field, the Address window
appears where you can select the Context Value to choose the contact's Address
style, such as North European, Japanese, or South American. After you select
the Context Value, the Address window provides you with fields appropriate
to the address style you have chosen. Enter the address, and click OK.

¢ Ship-to: Refers to the address to which you should ship an item for the contact.

¢ Primary: Check boxes that indicate whether the Bill-to and Ship-to addresses
are the contact's primary addresses.

If you select the Customer Type Organization, the Title, First, Last, Middle, and
Suffix fields are replaced with the Organization name field. All the other fields
remain the same with the exception of an additional field for the organization's
URL or Web address.

4, In the New Customer window, click OK.

A note appears informing you that a Party Number and an Account Number (if you
selected the Create Account check box) have been created and saved for the new
contact.

5. In the note, click OK.

The application returns you to the Depot Repair Workbench.

Create a Service Request

Service Requests initiate the actions required to solve a customer problem. A Service
Request is mandatory for any repair process, and needs to be created before any Repair
Order can be created in the Oracle Depot Repair module.

Note: You do not have to create the Service Request explicitly before
creating the Repair Order. You can enter details for both the Service
Request and the Repair Order, and create both at the same time.

On the Depot Repair Workbench, you can log a customer request for assistance. The
application lets you create Service Requests without having to leave the Depot Repair
Workbench.

Generally, as you create a Service Request, you know which customer to associate with
the Service Request. There may be situations where you are only provided with
identifiers for Installed Base items, and the customer information is not provided. In
this case, you can use an Oracle Depot Repair feature to find and select the customer

4-12 Oracle Depot Repair User Guide



associated with the item.

Note: You cannot create a Service Request without a value in the Item
field if the profile CSD: Require Item For Service Request has been set
to Yes during implementation. Setting this profile option to No lets you
create a Service Request without entering a value in the Item field.
Also, when the profile option is set to No, you can specify an Installed
Base item without specifying an Instance value in the Service Request.

You can search for existing Service Requests and Repair Orders from the Find Repair
Orders window.

For more information, see Find Service Requests and Repair Orders, page 4-32.

Module

Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

The customer and contact records must exist in the database.Service Requests can be
logged only for items recorded in inventory.

Navigation
Depot Repair > Repair Orders
Steps:
1. In the Find Repair Orders window, click New.
The Depot Repair Workbench opens.

In the Service Request Information area in the Depot Repair Workbench, the
Contact Type, Customer Type, and Opened Date fields default to Relation,
Organization, and the Current Date respectively.

The Severity and Status fields default to the value of the profile options Service:
Default Service Request Severity and Service: Default Service Request Status
respectively.

If you need to discover the customer for the Installed Base item that will be the
subject of the Service Request, perform the operations in Find a Customer for an
Installed Base Item, page 4-15.

2. If you select a customer using these operations, the customer-related and the
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item-related fields in the Service Request Information area are automatically filled
in. The fields can be changed before you save the Service Request.

3. Choose the Contact Type and Customer Type from the lists of values, and use lists
of values to select the Contact, Customer, Request Type (such as Customer Call,
Depot Repair, Field Service), Severity, and Status fields.

You can also enter the date and time in the Opened field.

Note: Contact information is not mandatory for creating a Service
Request. Selecting a blank contact type in the Contact Type field
disables all Contact information fields.

The Bill-To and Ship-To address fields are populated automatically
when the Customer and Contact Names are entered. The addresses
always default to the primary Bill-To and Ship-To addresses of the
customer. Even if you select a primary address for the Installed
Base instance, the Bill-To and Ship-To address fields default only to
the primary address of the customer party. Also, the list of values
for both fields contains addresses for related parties, which can be
for either persons or for organizations.

For more information, see The Service Request Information Area,
page 2-5.

4. To validate the item against the Installed Base, select the Installed Items Only check
box.

5. Select the Item that the customer is reporting as defective from the Item list of
values.

If the item is serialized, the Serial Number appears. After validation, the Instance
field is automatically populated. For a given customer, the call center agent can
view all the items in the customer Installed Base.

For more information about entering the Item, Instance and Serial Number fields,
see Item Information Fields, page 2-5.

6. Select the name of the person responsible for overseeing the Service Request in the
Owner field from the list of values.

7. Enter a brief summary of the repair issue in the Summary text field.
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8. Click the Save icon on the toolbar to create the Service Request record.

The application populates the Request field in the Service Request Information area
with the Service Request Number. When you click any of the fields in the Repair
Order Information area, the application populates the Item, Item Description, UOM,
and Quantity fields from the Service Request Information area.

9. Authorized users can launch the Service Request HTML page by clicking the
hyperlinked Request Number from both the Depot Workbench and the Repair
Technician Portal. This renders the Service Request HTML page in editable mode
where you can update and save data. This enables you to update service request
values such as Customer Bill-to and Ship-to addresses, SR Status and SR Resolution

Type.

You can enable the hyperlink through profile option, CSD: Enable Service Request
Drill-down (Yes/No).

Find a Customer for an Installed Base ltem

Sometimes, when you are creating a Service Request, you may know the Item Name, or
its Serial Number, or its Installed Base Instance Number, but the customer name is
unknown or simply not provided.

In these circumstances, you can provide the item information, and search for the
customers that have the item in their Installed Base.

After you select one of the customers for the item, all the customer-related and
item-related fields appear in the Service Request Information area of the Depot Repair
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Workbench.

This procedure is only available when you are creating a new Service Request in the
Depot Repair Workbench.

Module

Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

You must be in the process of creating a Service Request.

The items provided as search parameters must be Installed Base trackable or serialized
items.

Navigation
Depot Repair > Repair Orders > New

Steps:
1. In the Depot Repair Workbench, from the top menu, select Tools > Find Customer.

The Find Customer window opens.

2. Select one or more of the following fields as search parameters:

o Jtem
e Instance
e Serial Num
® Revision
3. Click Find.
The Results area shows the customers that have the item in their Installed Base.

4. Highlight the customer whose data you want to have on the Service Request, and
click OK.

5. The Find Customer window closes, and the fields related to the customer and the

item appear in the Service Request Information area of the Depot Repair
Workbench.
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Create a Repair Order in the Depot Repair Workbench

Module

Responsibility

Prerequisites

The depot business process starts with a Repair Order. Creation of Repair Orders occurs
only against Service Requests for serviceable items.

You can create a Repair Order and its associated Service Request directly in the Depot
Repair Workbench, which automates part of the process. Alternatively, you can start the
process of creating a Repair Order in another Oracle application. For more information,
see Alternative Ways of Creating Repair Orders, page 4-17.

For repair items that are under revision control, a correct Revision Number is
mandatory. If your Repair Order Item is serialized, and the quantity to repair is greater
than 1, you will have specify each of the Serial Numbers of the item to be repaired, for
Installed Base trackable items.

Oracle Depot Repair also lets you add items to a customer's Installed Base from the
Depot Repair Workbench. This enables the depot to process (Installed Base trackable)
repair items that the customer purchased from outside the service organization. If you
try to create a Repair Order line without specifying an Instance value for an Installed
Base trackable item, the application will prompt you to add a new item instance to the
Installed Base. This lets you process the repair.

Each Repair Order must have a Repair Type. When you create a Repair Order in Oracle
Depot Repair, then, depending on the Repair Type, the application automatically
creates one or more RMA and Sales Order lines. The RMA and Sales Order lines appear
in the Logistics tab, with action types of Repair and Ship respectively. If you choose the
Standard Repair Type, no charge lines are created automatically; you must create them
manually.

You can also choose to create RMA charge lines manually. If you want to create the
RMA charge line manually, first you must clear the check box Automatically Enter and
Book RMA, during the creation of the Repair Order. Afterwards, you can create the
RMA charge line, as described in Create an RMA Manually, page 4-26.

The following procedures describe how to create a Repair Order in the Depot Repair
Workbench.

Oracle Applications Navigator

Depot Repair Super User

A Service Request record must exist for the broken item in order to create a Repair
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Navigation

Order for its repair.

Depot Repair > Repair Orders

Note: You can also proceed to creating a Repair Order immediately
after creating a Service Request record, without having to navigate to
the Find Repair Orders window. In this case, start at step 3.

Steps:

1.

From the Find Repair Orders window, retrieve the pertinent Service Request.

For more information, see Find Service Requests and Repair Orders, page 4-32.

Select the relevant Service Request, and click OK.

The Depot Repair Workbench shows the Service Request information.

In the Repair Order Information area in the Depot Repair Workbench, confirm the
information appearing in the table, or enter the appropriate information for the
defective item.

Select the Repair Type from the list of values.

For more information on Repair Types, see Repair Type Processing, page 1-2. For
field descriptions, see Details Tab, page 2-9.

Note: A Repair Order supports a single currency. Different
currencies are supported for different Repair Orders within a
Service Request. The default currency is based on the default
contract. If no default contract is selected, the default Price List
determines the currency. If neither defaults are set, the currency
selection is based on the manually selected Price List in the Details
tab.

After a charge line is created, you cannot change the currency of the
Repair Order in the Details tab or select another default contract
that has a Price List with a different currency. To change the
currency of a Repair Order, all the charge lines have to be deleted.

Optionally, enter the quantity of items to be repaired in the Qty field.

The default quantity is 1. If you specify a Qty that is greater than 1 for a serialized
item, then you will need to capture the Serial Numbers separately, after the Repair
Order is created. For details, see step 13.

In the Details tab, optionally enter the Promise Date (date and time) for repair
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10.

1.

completion after negotiation with the customer.

Optionally, select the name of the person responsible for overseeing the repair in
the Repair Owner field from the list of values.

If you require estimates to be approved before you can proceed with the repair of
an item, then select the check box Estimate Approval Required, else uncheck this
check box.

If you want the RMA line to be automatically entered and booked when you create
the Repair Order, then select the check box Automatically Enter and Book RMA,
else uncheck this check box.

Click Save to create the Repair Order.

If you have tried to create a Repair Order line without specifying an Instance value
for an Installed Base trackable item, or without specifying a Serial Number for a
serialized item with a Qty of 1, a message window appears.

In the message window, you can either click Add to IB to add an item instance to
the Installed Base, or you can click Save As Is to create the Repair Order without
adding to the Installed Base. You can only Add to IB if the User Function Name Repair
Orders: Add to IB is associated with your responsibility

Note: If you select Save As Is, the Repair Order is created, but no
charge lines are created automatically. You will have to create all
the required charge lines for your Repair Type manually in the
Logistics tab.

After the Repair Order is created, the application populates the
Repair Number fields both in the Details tab, and in the Repair
Order Information area, with the Repair Order Number.
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12. For the case where the Repair Order Item is serialized, and the quantity of the item
Repair Order Item is greater than 1, continue at step 13.

For all other cases, continue at step 18.
Capture Serial Numbers
13. If your Repair Order contains a serialized item, and the quantity is greater than 1,
when you click Save, a message window appears, which instructs you as follows:
® The Repair Order created will be a draft Repair Order, that is, its Repair Status
will be Draft.

*  You must enter the Serial Numbers using the Capture Serial Numbers option
from the Tools Menu.

14. To complete the processing for repairing many individual serialized items, click OK
in the message window, then, from the top menu, select the options Tools > Capture
Serial Numbers.

In the Serial Numbers window that appears, your main functions are to select a
Serial Number for each individual item instance, and to process the Serial Numbers.
Processing the Serial Numbers creates a separate Repair Order for each item
instance.

15. Select a Serial Number from the Serial Number list of values for the customer
account.

You can specify a Serial Number that does not exist yet. In this case, a message
appears asking if you wish to create the new Serial Number.
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16.

17.

18.

19.

You can optionally select the check box Add to Order within Service Request.

If you select this option, then, when the Serial Numbers are processed, each RMA
line will be added to the same Order Number.

After you have specified the Serial Numbers, click one of the following buttons:

® Save: This saves the Serial Numbers, but does not process the values into
separate Repair Orders for each Serial Number.

e Process: This creates a separate Repair Order for each Serial Number, each with
a status of Open.

¢ Close: This closes the window without saving or processing the Serial
Numbers.

Note: For serialized, non-Installed Base trackable items, if you
enter fewer Serial Numbers than the Qty on the Repair Order,
Oracle Depot Repair creates as many Repair Orders as the Qty
number of units. For example, if Qty is 10, and you enter 8
Serial Numbers, you get 8 Repair Orders with Serial Numbers
provided, and 2 without Serial Numbers. You will need to
provide the 2 missing Serial Numbers at time of receipt.

Note: For serialized, Installed Base trackable items, if you enter
fewer Serial Numbers than the Qty on the Repair Order, Oracle
Depot Repair creates only as many Repair Orders as the
number of Serial Numbers you entered. For example, if Qty is
10, and you enter 8 Serial Numbers, you get 8 Repair Orders
with Serial Numbers provided.

Checking the Logistics Tab

Click the Logistics tab.

While not technically part of the creation process, after you have created the Repair
Order, you should check the Logistics tab to determine the next process to perform.

Depending on your choice of Repair Type and whether you set the check box
Automatically Enter and Book RMA, the Logistics tab generally contains one or
more Return and Ship lines, each of which has a Status.

In certain cases, there are no charge lines in the Logistics tab, such as when one of
the following has occurred:

¢ The Repair Type is Standard.
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e For a serialized repair item, you selected Save As Is in the Create IB Instance
window (see step 11).

You must create and book the required charge lines manually.

See Create and Book a Return Line Manually, page 4-26 and Create a Ship Line
Manually, page 4-103.

20. If your Repair Type involves the return of a defective item, then, in order to receive
the defective item into inventory, the following conditions must apply:

* There must be a Return line in the Logistics tab.
* The Status of the Return line must be Booked.

To fulfill these conditions, except for the special case where you created the Repair
Order after creating an order in Oracle Order Management, proceed to create and
book the Return line, as required.

See Create and Book a Return Line Manually, page 4-26.

Comments:

1. If you are creating more than one repair order line, and the value of the profile
option CSD: Default Repair Order is set to Yes, then, as you arrow down from the
last repair order line, the values are defaulted from the last repair order line into the
new line.

2. After creating the Repair Order record, you can attach additional information to the
Service Request or Repair Order by clicking the Notes button in the Details tab

For more information, see Create and Maintain Notes, page 4-37.

After creating the Repair Order record, you can attach additional information to the
Service Request or Repair Order by clicking the Notes button in the Details tab.

3. After creating the Repair Order record, you can also search from the Diagnostics tab
for possible solutions to the problem affecting the repair item.

In the Diagnostics tab, by selecting Service Codes, either manually or as a result of a
search performed in Oracle Knowledge Management, you can get the information
ready to automatically create estimate lines and default Bills and Routings for WIP
Repair Jobs.

For more information, see Use the Diagnostics Tab and Oracle Knowledge
Management, page 4-39.

Alternative Ways of Creating Repair Orders

In addition to the method of creating a Repair Order and its associated Service Request
in the Depot Repair Workbench, which enables you to automatically create charge lines
associated with the Repair Type, there are two other ways by which you can create a
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Repair Order, as follows:

Create a Repair Order Starting From Oracle TeleService, page 4-23

Create a Repair Order Starting From Oracle Order Management, page 4-24

Create a Repair Order Starting From Oracle TeleService

The depot agent can view activities performed against a Service Request that was

initiated in the call center and transferred to the depot for resolution. You can link
RMAs and Sales Orders generated through the call center to Repair Orders created
within the Depot Repair Workbench.

This procedure shows an example of creating a Repair Order, where an existing Service
Request already has RMA and Sales Order lines.

1.

Create a Service Request in Oracle TeleService, with a Service Request Type of
Depot Repair.

In the Charges tab of the Service Request, create one or more charge lines with
typical Depot Repair activities for the items that require repair processing.

A RMA charge line, for example, could include the following values:

e Charge Line Type = Actual
* Business Process = Depot Repair
¢ Service Activity = Return for Repair

A Sales order line, for example, could include the following values:

e Charge Line Type = Actual
* Business Process = Depot Repair

® Service Activity = Ship Returned Item

Submit the lines for processing.

In the Navigator, using the Depot Repair Super User responsibility, navigate the
path Depot Repair > Repair Orders.

In the Find Repair Orders window, enter the Service Request Number you created
in step 1, and click Find.

When the record appears in the Results area, click OK.

A message window informs you that RMA/Sales Order lines not linked to a Repair
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Order were found, and asks if you want to create a Repair Order or associate the
RMA /sales lines.

7. When you click OK, the Create Repair Order window appears, containing the
not-yet-linked RMA lines.

8. Select the lines that you want to become Return (RMA) lines in the Repair Order,
and click OK.
If there are submitted Sales Order lines in the Service Request, the Link Sales Order
window appears, containing the not-yet-linked Sales Order lines.

9. Select the lines that you want to become Ship lines in the Repair Order, and click
OK.

The Repair Order appears in the Depot Repair Workbench, with a Standard Repair
Type. The Return and Ship lines appear in the Logistics tab, each with the Status of
Submitted.

Create a Repair Order Starting From Oracle Order Management

This procedure shows an example of creating a Repair Order, which starts with the
creation of an order in Oracle Order Management, and includes the operation of
receiving the repair item into inventory.

1. In Oracle Order Management (if you use the Depot Repair Super User
responsibility, navigate the path: Order Management > Orders, Returns > Sales
Orders), create a Sales Order, with the following values:

Order Information tab:

¢ Set Order Type = Mixed

Line Items tab, Main sub-tab:

® Specify the item to be repaired in Ordered Item, and set Qty = -1

Line Items tab, Returns sub-tab:

* Specify the Return Reason
Line Items tab, Shipping sub-tab:
® Specify the Warehouse
2. When the order status is Booked, note the Order Number.
3. In Oracle Purchasing (if you use the Depot Repair Super User responsibility,

navigate the path: Purchasing > Receiving > Receipts), in the Find Expected Receipts
window, click the Customer tab, and search for the receipt whose RMA Number
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you noted in step 2.

4. In the Receipts window, select Inventory for the Destination Type, select the
Subinventory.

5. If required, specify the Serial Number or Serial Number range of the item to be
received.

6. Submit a request to run the program Create SR/RO from OM RMA Lines; specify
the Organization and Subinventory parameters.

7. When this program finishes, the Repair Order has been created, with a Standard
Repair Type.

Because the item to be repaired has already been received, the Logistics tab contains
neither Return nor Ship lines.

8. From the top menu, select Data > Activity, to find summary information in the
Activity window about the receiving of the item.

Update the Repair Order Status

You can update the Status of a Repair Order either by selecting a Repair Order and then
clicking the Update RO Status button from the Depot Repair Workbench or by clicking
the Update Status button from the Repair Order page.

When you update the Status of a Repair Order, you can only change to a Status defined
as acceptable for the current Repair Type in your setup of Repair Order Status
Transitions. The list of values for New Status shows only the allowable statuses from
which you can select.

For more details, see Repair Order Status Transitions in the Oracle Depot Repair
Implementation Guide.

If the transition has been set up to require you to enter a reason at the time of status
change, enter the Reason, else it is optional for you to do this. You may also add or edit
Comments.
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Update Repair Order Status
Cancel | | Apply |

Item CMB6629 Quantity 1
Itern Description  Mother Board Unit of Measure  Each
Problern Description Serial Mumber 7220222
Repair Type  Repair and Return-wWIP Instance 743274

RO Status Open
W Hide Repair Order Details

External Reference Mumber RO Crarrier
Repair Number 10434 Repair Organization
SR Mumber 27160 Promise Date
Mewy Status | 'I
Reason I J
Comments ;l
Ciescription

Cancel | | Apply |

Update the Repair Type of a Repair Order

Start the process of updating the Repair Type of a Repair Order by selecting Tools >
Update Repair Type from the main menu.

You can update the Repair Type of a Repair Order only if the Status of the Repair Order
has previously been defined as a Status of both the current Repair Type and your
intended target Repair Type.

For more details, see Repair Type Transitions in the Oracle Depot Repair Implementation
Guide.

Enter the New Repair Type. The Description associated with the repair type transition
appears.

If the transition has been set up to require you to enter a reason at the time of repair
type change, enter the Reason, else it is optional for you to do this.

Important: Repair type transitions do not add, delete, nor default any
logistic lines. After a repair type transition is performed on a repair
order, you must perform manual adjustments to your logistic lines, if
your organization processes require this.

Create and Book a Return Line Manually

Important: In this section, the terms RMA, RMA line, and Return line are
used interchangeably.
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When creating a Repair Order, then, for Repair Types that require RMA creation, the
application automatically generates the Return line based on Repair Type setup. If you
choose or have to create an RMA manually, then, in the Details tab, clear the
Automatically Enter and Book RMA check box, before saving the Repair Order.

The main objective of creating and booking an RMA is to create an order in Oracle
Order Management. When the RMA is fully interfaced with Oracle Order Management,
an Order Number is associated with the RMA, and appears in the Return line.

The following procedures explain how you can create and book an RMA manually,
after you have created the Repair Order. If the RMA has already been created, you can
just book the RMA.

For background information about RMA creation, see Create a Repair Order in the
Depot Repair Workbench.

Module

Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

You must have created a Repair Order.

Navigation
Depot Repair > Repair Orders
Steps:
1. Retrieve the Repair Order for which you want to create or book the RMA.

For more information, see Find Service Requests and Repair Orders, page 4-32.

2. Select the relevant result from the Results area of the Find Repair Orders window,
and click OK.

The Depot Repair Workbench shows the selected Service Request and Repair Order
details.

3. Select the Logistics tab in the Depot Repair Workbench.

If a Return line already exists for the defective item to be returned, but the Status is
not Booked, then continue at step 10.

Creating a Return Line
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4. If you need to create a Return line, click the Action Type field in the next blank line,
and select Return.
5. Select the fields for the Return line.

The main fields that you must select are Action Code, Service Activity, Price List,
and Return Reason. For serialized items, you must select the Source Serial Number.

Item-related fields default to the Repair Order Item. You may edit these as required.

Note also the Add to Order field. Oracle Depot Repair lets you place all Return
(RMA) and Ship lines on the same order.

By default, all Return (RMA) and Ship lines appear on the next-highest Order
Number created when the lines are transferred to Order Management.

You can also select the specific order for the Return (RMA) or Ship line by selecting
the Order Number in the Add to Order field before interfacing the specified line to
Oracle Order Management.

For field descriptions, see Logistics Tab, page 2-12.

If you want to process the Return line directly to the Booked stage, continue at step
10.

6. Select the Process Trans check box for the Return line.
7. Select the Automate order processing steps through check box.
8. Select the Enter Order button option.

9. Click Process.
Acknowledge the message in any message window that appears.
The Status of the Return line changes to Entered or Submitted.

Booking a Return Line
10. Select the Process Trans check box for the Return line.
1. Select the Automate order processing steps through check box.
12. Select Book Order radio button option.

13. Click Process.
Acknowledge the message in any message window that appears.
The Status of the Return line changes to Booked.
The Sales Order Number can optionally be hyperlinked to allow you to click on it to

launch the Sales Order window in editable mode and in context of the clicked Order
Number. You can enter information such as credit card number, ship method and
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payment details, save the order, close the Sales Order screen and return to the Depot
Workbench without ever leaving.

Comments:

1. During the processing of the Return line, when the Return line is fully interfaced
with Oracle Order Management, the Order Num field is populated with the
system-generated RMA Order Number.

If you have not selected the No Charge check box, the application returns the item
price to the Price field based on Price List selected.

2. To delete a Return or Ship line, select the Return or Ship line on the Logistics tab,
and click the Delete icon on the toolbar.

Note: The Delete icon on the toolbar remains enabled as long as the
Return or Ship line has not been fully interfaced with Order
Management. After the order is fully interfaced to Order
Management, the application disables the Delete icon, and you
cannot delete the order line.

Move Items Internally

The Internal Move capability allows you to move items or parts from one location to
another from a single window. The Internal Move window wraps the capabilities
provided by the Internal Requisition and Internal Sales Order modules provided by
Purchasing and Order Management. This new capability enables a single repair order to
track both internal and external logistical operations. You can perform logistical
transactions without leaving the Depot Repair interface.

Additionally, it provides the ability to create Internal Requisitions and Internal Sales
Orders in one step, ship and receive Internal Sales Orders and link Internal Moves to a
repair order along with RMAs and Sales Orders. The business value of this functionality
is that it prevents losing track of items as they move from one location to another,
enables ad-hoc routing of material to the best processing location and reduces click
count to create Internal Requisitions and Sales Orders.

To move items internally:

1. Navigate to the Find Service Requests window and select a Repair Order to open
the Repair Orders window.

2. Select the Logistics tab.

3. Choose the Internal Move Orders option from the Actions drop down list and click
Go.
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The Move Items Internally page appears. The page displays the existing internal
move orders linked to this repair order. The Move Details region provides the
ability to enter one or more serial numbers or a serial number range.

Move Items Internall:

0OU = Operating Unit

Org = Inventory Organization

Hew Internal Move

Select Order Number Requisition Name

e}

o(0o|0|0(0|0|0|0

(e]

Hew Internal Move

Move Details

66004
66005
66008
66007
66008
66009
66010
66224
66277
66278
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From Serial Number To Serial Number
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14405
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14407
14408
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14410
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14421
14422

AS54388
AS54888
AS54888
AS54888
SFE25K
SFE25K
SFE25k
AS66628
AS66620

AS54888

Ttem
Description

AS54888

AS54888

AS54888

AS54888

Sun Fire E25k Server
Sun Fire E25k Server
Sun Fire E25k Server
Envoy Ruggedized Laptop
Envoy Ruggedized Laptop

AS54883

O Individual

1

Quantities Ship From
Expected Received Shipped UOM OU org
0 3 Each Vision Operations |Seattle Manufacturing
0 1 Each Vision Operations  Seattle Manufacturing
0 2 Each Vision Operations | Seattle Manufacturing
0 1 Each Vision Operations  Seattle Manufacturing
0 2 Each Vision Operations |Seattle Manufacturing
0 3 Each Vision Operations |Seattle Manufacturing
0 1 Each Vision Operations  Seattle Manufacturing
0 3 Each Vision Operations |Seattle Manufacturing
0 1 Each Vision Operations  Seattle Manufacturing

1 Each Vision Operations

Seattle Manufacturing

Ship Confirm

Pick Release

Receive

Previ

Receive Into

ou
Vision Operations
Vision Operations
Vision Operations
Vision Operatians
Vision Operations
Vision Operations
Vision Operations
Vision Operations
Vision Operations

Vision Operations

ship Confirm

org

Boston Manufacturing
Boston Manufacturing
Boston Manufacturing
Boston Manufacturing
Baston Manufacturing
Boston Manufacturing
Boston Manufacturing
Boston Manufacturing

Dallas Manufacturing

Dallas Manufacturing

Pick Release

Update

7
7
7
7
Va
7
7
7
7
7

B
®

Receive

4, To create a new internal move order, click the New Internal Move button. The
Create Move Orders page appears.

5. Enter the fields in the Internal Order Attributes region:

Item

Description

Quantity

Unit of Measure

Need By

6. Enter the Operating Unit and Inventory Organization in the Ship From region.
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7. Enter the Operating Unit, Inventory Organization, and Location in the Receive Into
region.

Mave iems Intemally >
Create Move Orders

=

Internal Order Attributes

* Indicates required fiskd

Order Nurmber Requisition Nurmber Quantity Shipped
Order Status Requisition Statis Quantity Received
“lItem AS66629 Q
Description Envoy Ruggedized Laptop
* Quantity |1
* Unit of Measure [Each Q

Meed By |18-Jun-2010 B

Ship From Receive Into
Operating Uriit vision Operations Q Operating Unit |Vision Dperations Q
Inventory Organization |[Seattle Manufacturing Q Inventory Organization  Dallas Manufacturing Q

Location [M3- Dallas Q

Cancel | | Apply

8. Click Apply to create a new internal move order. A confirmation page appears. You
cannot edit any fields once an Internal Sales order is created.

The header of the Create Move Orders page populates with the following:
® Order Number

e Order Status

® Requisition Number
* Requisition Status

* Quantity Shipped

* Quantity Received

9. To Pick Release the internal sales order line, select the move order on the Move
Items Internally page and click the Pick Release button. A confirmation message
appears validating the pick release.

[ Confirmation
Successfully pick released the selected internal order.

Move ltems Internall

Ship Confirm | [ Pick Release | [ Receive
U = Operating Unit
Org = Inventory Organization

New Internal Move Previous |1-10 [V Next10 ®

10. To Ship Confirm the internal sales order line, select the relevant move order and

click the Ship Confirm button. A confirmation message appears validating the ship
confirm.
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[z Confirmation
Successfully ship confirmed the selected internal order.

Move Items Internall

Ship Confirm Pick Release Receive

0U = Operating Unit
Org = Inventory Organization

New Internal Move Frevious |1-10 | ™| Next 10 @)

11. You can receive the internal requisition associated with Internal sales order in the
destination organization. If the shipping network between source and destination
organization are set up as direct then the receipt automatically happens as part of
ship confirm action in the source organization. Though the internal requisition is
automatically received as part of ship confirm action, you must click the Receive
button to refresh the receipt information in the depot schema. A confirmation
message appears validating the receipt.

The selected internal requisition has been successfully received.

Move Items Internall:

Ship Confirm Pick Release Receive

0OU = Operating Unit
Org = Inventory Qrganization

New Internal Move Frevious [1-10  |¥| Next10 @

Additionally, you can perform partial shipments and partial receipts. For example, for
an Internal Order with quantity of 5, the shipping clerk ships out only 3. In this case the
destination organization receives these 3 into their inventory. Later when the remaining
quantity of 2 is shipped out, the destination organization receives the remaining
quantity.

Find Service Requests and Repair Orders

On the Find Repair Orders window, you can retrieve Service Requests or Repair Orders
from the database.

A search in Oracle Depot Repair enables you to retrieve Service Requests and Repair
Orders based on parameters related to a Service Request or Repair Order (Number,
Customer, Item, or Date Opened). You can use a combination of these parameters to

restrict your search so as to retrieve only the Service Requests or Repair Orders that you
want.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User
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Prerequisites

Navigation

The Service Request or Repair Order record that you want to retrieve must exist in the
database.

Depot Repair > Repair Orders

Steps:
1.

In the Find Repair Orders window, specify the parameters based on whether you
want to search for the Service Request or Repair Order.

The search parameters in the Service Request area include:

The search parameters in the Repair Order area include:

Request Number
Status

Customer Name
Customer Account
Date Opened

Item

Serial Number

Owner

Repair Number

RMA / Sales Order Number
Internal Order Number
Internal Requisition Number
PO Num

Project

Date Opened

Item
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e Serial Number
e Status
e Job Name

® Project Task

Note: Performing a search based on these values searches for
Project or Task values saved on the Repair Order Details tab, and
not the values stored on linked Sales Orders or WIP jobs.

3. Click Find to find matching Service Requests or Repair Orders based on the
parameters you have specified.
4. The Results region in the Find Repair Orders window displays the search results.

You can select any of the retrieved Service Requests or Repair Orders, and click OK
to view its details in the Repair Orders window, generally known as the Depot
Repair Workbench.
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Service Request

Request Number
Status

Custarmer MNarme
Customer Account

Repair Order

Repair Mumber
RiA F Sales Order Murmber
Internal Order Mumber

Internal Requisition Number

PO Mum
Results
Custormer
Mame Account
1608

1]

Transfer Install Base Ownership

Transfer Install Base Ownership function is performed in two ways:

Changing ownership based on the service request

Changing ownership on a repair order

Date Opened
ltern
Serial Number

Owiner

Date Opened
[tem

Serial Number
Status

Job Marme

W= J

I Find | Clear J

3010302

Sewice Request
Murnher [tem

44576 ASHEG29

Description
Ervoy Rugged =

(0] Cancel J

Changing ownership based on the service request

You can change the ownership based on the service request.

Module

Oracle Applications Navigator

Responsibility

Depot Repair Super User
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Prerequisites

You must set up Transfer Ownership from System Administrator Responsibility.

Navigation
Depot Repair > Repair Orders
Steps
1. Navigate to the Service Request region.

2. Enter an SR with Install Base item instance owned by a party other than the SR
party.

3. Save the SR.

4. Click OK when the system prompts you to change the ownership of instance.
5. Select Change Ownership option from the Tools menu.

6. Click Yes to commit the change in the decision window.

7. Save the SR.

From Install Base query the instance number; you will find item's owner name is

changed to new one.

Changing ownership on a repair order

You can change the ownership based on a repair order.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

You must set up Transfer Ownership from System Administrator Responsibility.

Navigation
Depot Repair > Repair Orders
Steps

1. Navigate to the Service Request region.
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2. Enter an SR without item details.

3. Enter RO details with item instance belonging to another customer other than the
SR Party.

4. Save the RO.

5. Click OK when the system prompts you to change the ownership of instance.
6. Select Change Ownership option from the Tools menu.

7. Click Yes to commit the change in the decision window.

8. Save the RO.

From Install Base query the instance number; you will find item's owner name is
changed to new one.

Create and Maintain Notes

Notes are used to record and manage the comments that the depot agents and
technicians generated against various services. Notes in a Service Request help in
recording the descriptive information about customer repair issues, any progress that
the agent had done in resolving this issue, and so on. You can enter either Service
Request or Repair Order notes from the Details tab in the Depot Repair Workbench.

Module

Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

A Repair Order record must exist for an item before you can attach notes to the relevant
Service Request or Repair Order.

Navigation
Depot Repair > Repair Orders

Steps:
1. Retrieve the Service Request or Repair Order to which you want to attach a note.

For more information, see Find Service Requests and Repair Orders, page 4-32.
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2. In the Results area of the Find Repair Orders window, select the relevant result, and
click OK.

The Depot Repair Workbench shows the selected Service Request and Repair Order
details.

3. On the Details tab of the Repair Order window, select Service Request or Depot
Repair in the Notes area.

4. To open the Notes window, click Notes.
5. In the Type field, select a note type.

6. In the Status field, select a note status.

The choices are: Personal, Internal, and Publish. If you use the Personal status, this
note would not be viewable to any customer in a customer facing application.
Employees at the depot can view Internal notes. All employees and customers can
view Publish notes. You can create additional Status codes. For more information,
see the Oracle Common Application Components Implementation Guide.

7. In the Note field, enter a brief description of the note.

8. To enter more notes, click the More button.

The Detailed Note window opens and holds textual notes up to 32K characters.
9. After entering notes, click OK.

10. In the main Notes window, to specify more details for the note, specify the Related
To and Value fields.

11. Save the note.

The note appears in the table under the Notes tab on the left. The Summary tab
displays the notes as text in a chronological or reverse chronological manner. You
can change the chronological view by clicking the Latest First check box.

12. To search for existing notes, use the Find Notes functionality.

1. Open the Notes main window.
2. Click the flashlight icon on the toolbar to open the Find Notes window.
3. Enter the fields such as Source, Entered By, and so on.

4. Click Search to display the results.
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Use the Diagnostics Tab and Oracle Knowledge Management

The main purpose of the Diagnostics tab is to enable you to make use of solutions to
previous problems stored in Oracle Knowledge Management. Oracle Knowledge
Management is a repository of solution sets that have already been contributed.
Solutions to previous incidents can guide users to resolve current problems at hand.

However, even if you have not installed Oracle Knowledge Management, you can still
use the Diagnostics tab to select Service Codes, which enable you to automatically
create estimate lines and default Bills and Routings for WIP Repair Jobs.

This section consists of the following topics:

* Diagnostic Codes and Service Codes, page 4-39

e Using Diagnostic Codes and Service Codes with Oracle Knowledge Management,
page 4-39

* Using Service Codes in the Repair Order, page 4-39

* Diagnostics Tab Usage Overview, page 4-39

Diagnostic Codes and Service Codes

Depot repairs are generally repetitive in nature and the number of problems and
resolutions is finite. As such, Oracle Depot Repair provides the ability to associate the
potential problems with a Diagnostic Code, and to associate the potential resolutions
with a Service Code. By utilizing Diagnostic Codes and Service Codes, users can quickly
document repair efforts for customer charges and depot service history.

An example Diagnostic Code is DC100, whose descriptive Name is Engine Oil Light
On, and a corresponding example Service Code is SC100, with descriptive Name Engine
Oil Change.

For details of setting up Diagnostic Codes and Service Codes, see the Oracle Depot Repair
Implementation Guide.

Using Diagnostic Codes and Service Codes with Oracle Knowledge Management

The association of Diagnostic Codes to Service Codes is done in Oracle Knowledge
Management via Solutions. First, during implementation, Service Codes are linked to
Oracle Knowledge Management Solutions as external objects. Then, during the
authoring of Solutions in Oracle Knowledge Management, Diagnostic Codes (for
example, DC100) are included in the title or body of the Solution.

Once a Diagnostic Code is associated to a Service Code and that Service Code is linked
to an Oracle Knowledge Management Solution, then the repair work to be performed
has been defined.
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For details of associating Diagnostic Codes and Service Codes with Oracle Knowledge
Management, see the Oracle Depot Repair Implementation Guide.

Using Service Codes in the Repair Order

Oracle Depot Repair enables you to automate Repair Order processing as follows:

¢ In WIP repair mode, Oracle Depot Repair provides the ability to predefine work
using Bills and Routings and any associated material, labor and expense charges.
The user can retrieve the defined work using Service Codes. The Service Code
association with Bills and Routings can be used to create material, labor and
expense estimate lines as well as default routes to WIP Repair Jobs.

¢ In Task repair mode, Oracle Depot Repair provides the ability to predefine work
using Task Templates and Task Parts and any associated material, labor and
expense charges. The user can retrieve the defined work using Service Codes. The
Service Code association with Task Templates and Task Parts can be used to create
material, labor and expense estimate lines, and to create tasks.

For details of how Service Codes are used in the Repair Order, see the following:

¢ Create a Repair Estimate, page 4-57

® Create a WIP Repair Job for a Single Repair Order, page 4-80

Diagnostics Tab Usage Overview

The interface from Oracle Depot Repair to Oracle Knowledge Management is the
Diagnostics tab, which is divided into three areas:

¢ Diagnostic Codes
e Solutions
e Service Codes

The following figure shows an overview of the standard use of the different areas of the
Diagnostics tab.
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Overview of Standard Diagnostics Tab Usage

Oracle Depot Repair: Diagnostics Tab

Problem - - Resoiution
Diagnostic . Service
Codes Solutions Codes
Search for Solutions Displays Solutions Displays
with parameters: with Status: Sarvice
(a) Selected Diagnostic Codes Useful Possibly  Not * Codes
(b Problam Summary useful  useful i
1 i F
(o) Repair Order Itern E
/- ! ™
Oracle Knowledge If there ave
Management Yos IMaybe No Service Codes
associgfed with
the Useful

Optionally For each chosen Sﬂlu@ﬁ@

refingthe +— w  solution, isthe f----cooeooo-s
search : solution useful?

* - "Not useful” solutions appear in the Solutions area only if the value of the profile
option Knowledge: Action for Negative Feedback Solution is Link Solution as Not Solved:

_____________________________________________________________________________________

See Also
* Manage Diagnostic Codes in the Diagnostics Tab, page 4-42

® Search Oracle Knowledge Management, page 4-43
* Manage Solutions in the Diagnostics Tab, page 4-48

* Manage Service Codes in the Diagnostics Tab, page 4-50

Depot Workbench  4-41



Manage Diagnostic Codes in the Diagnostics Tab

Module

Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

You must have set up Diagnostic codes and Service Codes in Oracle Depot Repair.

You must have associated the Diagnostic Codes and Service Codes to Solutions in
Oracle Knowledge Management.

For details of setting up and associating Diagnostic Codes and Service Codes, see the
Oracle Depot Repair Implementation Guide.

Navigation
Depot Repair > Repair Orders
Steps

1. Retrieve the Repair Order that you want to process.

For more information, see Find Service Requests and Repair Orders, page 4-32.
2. If you are not already in the Diagnostics tab, click the Diagnostics tab.

3. If you do not want to provide any Diagnostic Codes as parameters to the search in
Oracle Knowledge Management, continue at step 7.

4. Enter a Diagnostic Code manually or select a Diagnostic Code from the list of
values.

The list shows all Diagnostic Codes that have been associated with either the Item
or the Item Category of the Repair Order Item.

For more information on setting up Diagnostic Codes, see the Oracle Depot Repair
Implementation Guide.

Note: If you enter an invalid Diagnostic Code, the list of values
appears, which contains all the valid Diagnostic Codes for your
Repair Order.
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5. Click the Select check box.

6. Repeat steps 4 to 5 for as many Diagnostic Codes as you want to display.

Note: You may click the Select All or Deselect All as appropriate
any time before you click Search Solutions.

Note: Only the Diagnostic Codes that are explicitly selected are
forwarded as search parameters to the Oracle Knowledge
Management search.

7. Click Search Solutions.
This launches two windows:

* A Refresh linked Solutions box, with the message: Please press OK after
searching for Solutions.

® An Oracle Knowledge Management window.

The window that is launched in Oracle Knowledge Management depends on
the value of the profile option Knowledge: Search to display for integrating
applications.

If the value of this profile option is Unified Search, then the window that is
launched is a Simple Search window; if the value of the profile option is
Advanced Search, then the window that is launched is the Advanced Solution
Search Results window.

Continue the search process at the section Search Oracle Knowledge
Management, page 4-43.

Search Oracle Knowledge Management

The search in Oracle Knowledge Management is the second stage of the completely
integrated process which starts in the Diagnostics tab. This section concentrates on the
Oracle Knowledge Management search itself, and how it provides feedback back into
the Diagnostics tab.

This procedure follows immediately after you have clicked the Search Solutions button
in the Diagnostics tab.

Use of the Search Parameters in Oracle Knowledge Management

The parameters passed to Oracle Knowledge Management to search for solutions are
the following;:
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e All selected Diagnostic Codes
* Problem Summary
* Repair Order Item

The search for solutions is performed as follows:

® The Diagnostic Codes and Problem Summary are used as search keywords in the
title and body of the Solutions.

e The Repair Order Item are used to match the specified item with the Related Items
as set up in the Solutions.

By utilizing the profile option Knowledge: Search results include weighting from
Product, Platform and Category filters, you can narrow or widen your search results.

When the profile option is set to No, the search results contain only Solutions matching
the specified Product/Platform/Category.

When the profile option is set to Yes, the results can also contain Solutions that do not
match the Product/Platform/Category specified -- the Solutions that do match the
Product/Platform/Category are given a boost in the scoring algorithm.

Note: Oracle Depot Repair does not make use of platform and category
filters in Oracle Knowledge Management.

For additional information on how to use Oracle Knowledge Management, please refer
to the Oracle Knowledge Management User Guide.

Search Result Examples
Consider the following search parameters:

* Selected Diagnostic Codes = DC01, DCO02.
* Problem Summary = Mouse Malfunction.
® Repair Order Item = ITM342.

With the profile option Knowledge: Search results include weighting from Product,
Platform and category filters set to No, you get the following results:

e All Solutions whose title or body contains DC01, DC02, Mouse, or Malfunction, and
whose Related Items include ITM342.

With the profile option Knowledge: Search results include weighting from Product,
Platform and category filters set to Yes, you get both of the following sets of results,
with the first set having a higher score:

e All Solutions whose title or body contains DC01, DC02, Mouse, or Malfunction, and
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whose Related Items include ITM342.

e All Solutions whose title or body contains DC01, DC02, Mouse, or Malfunction.

Prerequisites
You must have started the search process by clicking the Search Solutions button in the
Diagnostics tab.

For details, see Manage Diagnostic Codes in the Diagnostics Tab, page 4-42.
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Overview of Main Oracle Knowledge Management Search Procedure

Diagnostic Codes
Problem Summary
Repair Order [tem

'

Oracle Knowledge Management
[

\ \

[ Knowledge: Search to display tor [ Knowledge: Search to display for
integrating applications = integrating applications =
Adwvanced Search | Unified Search |
_______ L. I
| Optionally change | Simple Search
: search parameters, and : window
I perform a further search !
L e J ______
1 | Optionally change !
Advanced Solution : search parameters |
SearchResuts || — 777~ 1 ° !
| - Click Go /‘,
‘ Selact a Solution ‘ i
In S3imple Search Results
| area, click the Title
'( Click Full Solution J hyperlink of the solution

| |
Y

Solution Details
window

In the Feedback section, vou can choose to answer the question:
Iz the solution useful in resolving your question or problem?

Y ' !

Yes Maybe Neo

Steps

1. You can optionally add and edit search parameters in the Oracle Knowledge
Management search window, and then perform an explicit search.

The net objective of the Oracle Knowledge Management search is to specify
whether a solution is useful or potentially useful for the current repair problem. To
do this, you must first select a solution in a "search results" window, then access the
solution details for that solution.

2. If you are in the Simple Search window, click the Title hyperlink of the potentially
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useful solution in the Simple Search Result area. If you are in the Solution
Advanced Search Results window, click the radio button beside the potentially
useful solution, and click Full Solution.

In the Solution Details window, there is a section available for you to decide the
usefulness of the solution. This section is the Feedback section, whose main
constituent is the question "Is the solution useful in resolving your question or
problem?"

Note: The Feedback section only appears if the solution has not
already been linked to the current Repair Order. However, after a
user explicitly selects an answer to the usefulness question, then the
next time the Solution Details window appears for that solution,
the Feedback section does not appear.

3. In the Solution details window, scroll down to, and just beyond, the External
Objects area.

4. If the Feedback section appears, then, you can optionally respond to the question "Is
the solution useful in resolving your question or problem?", by clicking Yes, Maybe,
or No.

If you choose one of these options, a confirmation message appears, indicating that

your feedback was recorded.

5. You may optionally continue in Oracle Knowledge Management, and select more
Solutions for feedback to Oracle Depot Repair.

6. When you have finished in Oracle Knowledge Management, close the Oracle
Knowledge Management window.
7. Click OK in the Refresh linked Solutions box.

If you have linked any Solutions from Oracle Knowledge Management to a Repair
Order, they appear in the Solutions area of the Diagnostics tab. Additionally,
Service Codes appear in the Service Codes area of the Diagnostics tab (if any exist).

Providing Feedback into the Solutions Area of the Diagnostics Tab

In step 4, your response to the question "Is the solution useful in resolving your
question or problem?" causes the following to occur in the Solutions area of the
Diagnostics tab:

e If you answered Yes, then the solution appears with a Status of Useful.

e If you answered Maybe, the solution appears with a Status of Possibly useful.

Depot Workbench  4-47



e If you answered No, and if the value of the profile option Knowledge: Action for
Negative Feedback Solution is Link Solution as Not Solved, the solution appears
with a Status of Not useful.

Providing Feedback into the Service Codes Area of the Diagnostics Tab

If the Useful Solutions returned to the Solutions area have any Service Codes associated
with them, then those Service Codes will appear in the Service Codes area, together
with their associated Solution Number and with their Applicable check box set.

Details T Logistics T Diaghostics lHepairEstimateI Repair Jobs T Repair Tasks Tﬁepa\rActuals_

~Diagnostic Codes ~Soluti ~Service Codes
Select Applicable Solution
| Code Mame Murmber Title Status | Code MName Mumber
| v [pco IDC for Mechanical | = || J[10025  [Mechanical S[Useful (= || | [sco11 |[Mechanical Service 10025 o
[ ] \ [[0210  [Hard disk faili[Possibly us| ||| ™ | | |
[ ] \ [[10327 [Mechanical a[Not useful [ | |
[ \ [l | | [= | |
[ \ = || | | = | | <
| Select All Deselect All ) Details.. ‘ Update Status
Search Salutions... )

Manage Solutions in the Diagnostics Tab

The main use of the Solutions area is to change the status of Solutions returned from
Oracle Knowledge Management searches, in order to influence the Service Code
information in the Service Codes area.

When you change the Status of a Solution in the Solutions area to Useful, any Service
Codes associated with that Solution in Oracle Knowledge Management appear in the
Service Codes area, and are initially marked as Applicable.

Under the following conditions:

¢ The profile option CSD: Use Tasks from Knowledge Base Solutions is set to Yes
¢ The Solution in the Solutions area is marked as Useful

¢ The corresponding Solution in Oracle Knowledge Management has one or more
Task Templates among its Related Objects

you can retrieve the associated Task Template charge lines into the Repair Estimate tab
by clicking Add Lines from Diagnostics.

For more details, see Create a Repair Estimate, page 4-57.

Note: From the Solutions area, you may also return to Oracle
Knowledge Management to view the solution details, by clicking the
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Module

Details button.

Oracle Applications Navigator

Responsibility

Depot Repair Super User

Prerequisites

You must have previously performed an Oracle Knowledge Management search for the

Repair Order, and returned one or more Solutions into the Solutions area (see Search
Oracle Knowledge Management, page 4-43)

Navigation

Depot Repair > Repair Orders

Steps

1.

If you have not already accessed the Repair Order, retrieve the Repair Order that
you want to process.

For more information, see Find Service Requests and Repair Orders, page 4-32.
If you are not already in the Diagnostics tab, click the Diagnostics tab.

Click the right-hand side of the Status field of a solution whose status you want to
change.
Select a different status from the list of values.

This enables the Update Status button.

Click Update Status.

If, in steps 3 and 4, you changed the Status to Useful, existing Service Codes
associated with the solution will appear in the Service Code area with the
Applicable check box set on.

Continue at step 6.

If, in steps 3 and 4, you "downgraded" the Status from Useful to Possibly useful or
Not useful, then an Update Solution Status message box appears, presenting the
following information:
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e Service Codes associated with the solution in the Service Codes area will be
marked as not applicable.

* You may delete the Service Code in the Service Codes area manually.

Click OK in the Update Solution Status message box.

This unsets the Applicable check box for the associated Service Code in the Service
Codes area.

For details of deleting Service Codes in the Service Codes area, see Delete Service

Codes Manually in the Service Codes Area, page 4-53.

Optionally, repeat steps 3 through 6 for each solution whose status you want to
change.

Note: You cannot delete any Solutions from the Solutions area, you
can only change the status values of the Solutions.

Manage Service Codes in the Diagnostics Tab

The topics in this section include the following:

Select Service Codes Manually in the Service Codes Area, page 4-50

Activate and Deactivate Service Codes Manually in the Service Codes Area, page 4-
52

Delete Service Codes Manually in the Service Codes Area, page 4-53

Select Service Codes Manually in the Service Codes Area

As part of Oracle Depot Repair implementation, when Service Codes are set up, they
are associated with Items, Categories, a combination of Bills and Routings, and Task
Template Groups.

The main usage of the Service Codes area in the Diagnostics tab is to enable the
associated elements of the Service Codes to be added to the estimate lines and WIP
Repair Jobs of the current Repair Order.

The Service Codes area is populated with Service Codes in one or more of the following

ways:

Automatically by Useful Solutions (see Search Oracle Knowledge Management,
page 4-43).

Manually, by selecting Service Codes from the lists of values in the Service Codes
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Module

Responsibility

Prerequisites

Navigation

Steps

area - in this case, there is no associated Solution Number.

This section deals with the manual selection of Service Codes in the Service Codes area.

Oracle Applications Navigator

Depot Repair Super User

You must have set up Service Codes in Oracle Depot Repair.

To make use of prior repair knowledge, you must have associated Service Codes to
Solutions in Oracle Knowledge Management.

For details of setting up and associating Diagnostic Codes and Service Codes, see the
Oracle Depot Repair Implementation Guide.

Depot Repair > Repair Orders

1. If you have not already accessed the Repair Order, retrieve the Repair Order that
you want to process.

For more information, see Find Service Requests and Repair Orders, page 4-32.
2. If you are not already in the Diagnostics tab, click the Diagnostics tab.

3. Select a Service Code from the Service Code list of values in the Service Codes area.

This list of values that appears shows all the Service Codes that have been
associated with either the repair Item or the Inventory Category of the repair item.

For more information on setting up Service Codes, see the Oracle Depot Repair

Implementation Guide.

4, In the Code field, either enter a Service Code, or select a Service Code from the list
of values.

Note: If you enter an invalid Service Code, the list of values
appears, which contains all the valid Service Codes for your Repair
Order.
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By default, as each valid Service Code is entered or selected, its Applicable check
box is set.

Manually entered Service Codes do not have a Solution Number.
5. Repeat steps 3 to 4 for as many Service Codes as you want to display.

6. Save your changes.

Activate and Deactivate Service Codes in the Service Codes Area
You activate Service Codes in the Service Codes area by marking them as applicable.

Activating Service Codes in the Service Codes area enables the following subsequent
processing options:

® In the Repair Estimate tab, after you have created a repair estimate header, you can
add lines from the Diagnostics tab associated with the activated Service Codes in
the Service Codes area.

Charge lines can be added in for WIP mode repairs (if Bills and Routings are
associated with the Service Codes) and for Task mode repairs (if Task Template
Groups are associated with the Service Codes).

* In the Repair Jobs tab, you can create a WIP Repair Job with the Bills and Routings
associated with the activated Service Codes in the Service Codes area.

For more information on setting up Service Codes, see the Oracle Depot Repair
Implementation Guide.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must have previously performed one or more of the following operations for the

Repair Order:

* Searched Oracle Knowledge Management, and returned one or more Service Codes
into the Service Codes area (see Search Oracle Knowledge Management, page 4-43
and Manage Solutions in the Diagnostics Tab, page 4-48).

® Selected one or more Service Codes manually (see Select Service Codes Manually in
the Service Codes Area, page 4-50).
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Navigation
Depot Repair > Repair Orders

Steps

1. If you have not already accessed the Repair Order, retrieve the Repair Order that
you want to process.

For more information, see Find Service Requests and Repair Orders, page 4-32.
2. If you are not already in the Diagnostics tab, click the Diagnostics tab.

3. In the Service Codes area, check the Applicable check box for each Service Code
that you want to activate.

4. In the Service Codes area, uncheck the Applicable check box for each Service Code
that you want to deactivate.

5. Save your changes.

Delete Service Codes in the Service Codes Area

You may delete Service Codes from the Service Codes area, whether they are marked as
applicable or not.

Note: After the first time that you use Service Codes in a Repair Order
in either the creation of a repair estimate or the creation of a WIP Repair
Job, then the selected Service Codes are protected against deletion in
that Repair Order.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

You must have previously performed one or more of the following operations for the
Repair Order:

® Searched Oracle Knowledge Management, and returned one or more Service Codes
into the Service Codes area (see Search Oracle Knowledge Management, page 4-43
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Navigation

Steps

Comments

and Manage Solutions in the Diagnostics Tab, page 4-48).

Selected one or more Service Codes manually (see Select Service Codes Manually in
the Service Codes Area, page 4-50).

Depot Repair > Repair Orders

If you have not already accessed the Repair Order, retrieve the Repair Order that
you want to process.

For more information, see Find Service Requests and Repair Orders, page 4-32.
If you are not already in the Diagnostics tab, click the Diagnostics tab.

In the Service Codes area, click the marker field to the left of the Service Code that
you want to delete.

From the top menu, select Edit > Delete.
Optionally, repeat steps 2 through 3 for each Service Code that you want to delete.

Save your changes.

If you wish to reinstate Service Codes that you have deleted, then perform one of the
following operations:

Change the status of any associated solution in the Solutions area to Useful, as
described in Managing Solutions in the Diagnostics Tab, page 4-48.

Select and activate Service Codes manually, as described in Selecting Service Codes
Manually in the Service Codes Area.)

Estimate Repair Charges

Depots can require a repair diagnosis of the customer's returned item in order to
accurately determine the cost involved in the actual repair, upgrade, or overhaul. The
depot technician typically performs this by inspecting or performing a teardown of the
item to determine the required parts and labor for the repair. After completing this
process, the depot provides a formal quotation to the customer for approval before any

work is scheduled. During the teardown, the technician can identify individual parts,
and diagnose for further service requirements using typical repair manuals and
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technical notes for aid.

Note: If you have set up the application to not use the Estimate
functionality, by setting the profile option CSD: Enable Estimates to No,
the Repair Estimate tab in the Depot Repair Workbench is not available
and you cannot create a repair estimate. For more information, see the
note in the topic Repair Estimate Tab, page 2-24.

Items for Estimates

Items for estimates must be defined in the organization specified by the profile option
Service: Inventory Validation Organization.

Pricing and Currency

To charge for repair services, a service provider can use standard pricing method using
Price Lists to determine the fixed repair price. Variable pricing method can also be used,
which permits the depot to charge the customer for the actual material, labor, and other
expenses incurred during the repair. When exchanging or replacing items, a service
provider typically calculates the price of the exchange as 60% of the new item price, and
possession of the customer's broken item.

In Oracle Depot Repair, a Repair Order supports a single currency. The default currency
is based on the default contract. If no default contract is selected, the default Price List
determines the currency. If neither defaults are set, the currency selection is based on
the Price List manually selected in the Details tab. After a charge line is created, you
cannot change the currency of the Repair Order in the Details tab, or select another
default contract that has a Price List of a different currency. To change the currency of a
Repair Order, all the charge lines, including the Logistics lines, have to be deleted.

The Repair Order currency drives the list of Price Lists that you can use for estimate
charge lines. You cannot select a Price List with a currency that is different from the
Repair Order currency.

Estimate Lines from Diagnostics

If you have Service Codes marked as applicable in the Diagnostics tab, and these
Service Codes are associated with Bills, Routings, and Task Template Groups, then you
can copy the following into the Repair Estimate tab:

¢ Charge lines associated with the Bills and Routings for WIP mode repairs.
® Charge lines associated with Task Template Groups for Task mode repairs.

When you add in lines for WIP mode repairs through Service Codes, then, typically:

e Bill of Material items are added as Material lines.
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® Resources associated to the Operations for BOM Routing are added as Labor lines.

When you add in lines for Task mode repairs through Service Codes, then, typically:

¢ Items specified in Task Parts in Spares Management are added as Material lines.

¢ Planned Effort elements for a Task Template are added as Labor lines.

Estimate Cost Analysis

While preparing an estimate, you can also perform estimate cost analysis. Estimate cost
analysis lets you compare your estimated margins and profitability based on estimated
costs and estimated charges. The only supported costing method is standard costing.
The estimate cost analysis is always an aggregate of all estimated costs and charges for
the Repair Order.

Materials, labor, and expenses comprise the totals for charges or costs. Taxes and other
fees are not included in cost analysis.

Costing of items differs in WIP and Task mode.
¢ In WIP mode, Item Cost is used for material, labor, and expense charges; however,

if a Resource Cost exists, it is used for the Labor charge.

® In Task mode, Item Cost is used for material, labor, and expense charges; Resource
Cost is not used.

To enable estimate cost analysis, the following conditions must apply:

¢ The profile option CSD: Enable Costing must be set to Yes.

* Each material, labor, and expense item must have an item cost defined in Oracle
Inventory.

Estimate Approval

On the Details tab for a Repair Order, you can check or uncheck the Estimate Approval
Required field. If the check box is set, you must get customer approval for the estimate,
and record this as a status change in the repair estimate.

The topics in this section include the following:

¢ Create a Repair Estimate, page 4-57
* Revise a Repair Estimate, page 4-62

e Obtain Customer Approval for a Repair Estimate, page 4-63
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Create a Repair Estimate

Module

Responsibility

Prerequisites

Navigation

Steps

The following procedures describe how to prepare a repair charges estimate for the
customer.

Oracle Applications Navigator

Depot Repair Super User

You must complete all steps in the relevant business scenario prior to creating the
estimate. For more information, see Oracle Depot Repair Business Scenarios..

Depot Repair > Repair Orders

Retrieve the Repair Order for which you want to estimate charges.

For more information, see Find Service Requests and Repair Orders, page 4-32.

Select the relevant record from the Results area of the Find Repair Orders window,
and click OK.

The Depot Repair Workbench shows the selected Service Request and Repair Order
details.

Select the Repair Estimate tab in the Depot Repair Workbench.

Optionally enter the Status, Date, Lead Time, and UOM field values.

For field descriptions, see the topic Repair Estimate Tab, page 2-24.
Click Save Estimate to save the estimate header record.

You can enter estimate details in one or more of the following ways:

* Manually, by entering individual charge line details in the multi-record table
area.

For field descriptions, see the topic Repair Estimate Tab, page 2-24.
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e If you have previously selected and activated Service Codes in the Diagnostics
tab, then you can click Add Lines from Diagnostics.

This adds the charge lines associated with the active Service Codes in the
Diagnostics tab, that is, the Service Codes marked as applicable.

You can also add Task Template charge lines associated with Solutions if the
following conditions are true:

1. The profile option CSD: Use Tasks from Knowledge Base Solutions is set to
Yes.

2. At least one Solution in the Solutions area of the Diagnostics tab is marked as
Useful, and the corresponding Solution in Oracle Knowledge Management has
one or more Task Templates among its Related Objects.

When these conditions are true and you click Add Lines from Diagnostics, you
retrieve the associated Task Template charge lines into the Repair Estimate tab.

After you have clicked Add Lines from Diagnostics, the added lines appear in
the Repair Estimate tab, and an information window appears which records
any errors and information about the lines added.

If the lines that you expect to be added do not appear, you should check a
variety of factors associated with your Repair Order and the data that you are
trying to add in. See Checks for Adding Estimate Lines from Diagnostics, page
4-60.

For more information, see the topic Activate and Deactivate Service Codes in
the Service Codes Area, page 4-52.

Note: After you have added the lines associated with the active
Service Codes, the Service Code rows from which you derived
the estimate lines are disabled in the Service Codes area of the
Diagnostics tab.

7. After entering a charge line, click Save Estimate to record the charge line.

The application populates the Unit Price and Est Charge fields in the table. The
Summary of Estimated Charges region is also populated. This region is updated as
you add (or delete) charge lines.

8. Optionally, click Costs to see an estimate cost analysis.
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10.

11.

% Estimated C s Estimated Charges

Charge Frofit
Material 180.00 130.00

Labar 30.00 -0.00

Taotal

The Estimated Costs versus Estimated Charges window opens and shows the
estimated Cost, the estimated Charge, the estimated Profit (Charge less Cost), and
the estimated Profit Margin% by separate Material, Labor, Expense, and Total lines.

Click Close to exit the Estimated Costs versus Estimated Charges window.

Click Line Details to display the Estimate Charge Details window.

Enter the detailed charge line values in the table fields.

For field descriptions, see the topic About Estimate Charge Line Details Window,
page 2-24.

To allow provisioning for overriding the entered charges later, select the Override
Charges check box.

This is enabled if the profile option CSD: Allow Charge Override for Estimates is set
to Yes.

The Override Charges check box lets you override repair charges, in the Estimated
Charge field, after you have saved it. Discounts associated with the contract are not
applied if you manually change the Estimated Charge.
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Details

T Logistics I Diagnostics TﬁepalrEstlmaleI Repair Jobs I Repair Tasks Iﬁepaerctua\s_

Estimate Header Summary of Estimated Charges
Status [T ’— Reason Summary | TEST =] Material 90.00 Currency |US dollar
Date [02-FEB-2004 Lead Tirme [4 UOM [Hour - Labor 75.00
Expense .00
Estimate Motes. . Total 163.00 Costs...
Source Billing Contract Pricing Attributes Estirnated Owerride Mo
Type Category ltern Murmber Price List Gty UOM | Unit Price Charge  Charge Charge
[[service Code [Material [csokoot  [15649 [Corporate [ 1[Fach [ || 100.00 | 9000 0 e
[ |Semice Code |Lahor |Lahor |15549 |Curpurale ’_1|Huur | ‘ ?5.[I[I| 7500 r
| | | | | N | r B
Line Details... (%) | Add|Lines fram Diagnostics Freeze Estimate Save Estimate ()

12. Click Save to record the changes.

13. Click Close to close the Estimate Charge Details window, and return to the Repair

Estimate tab.

The Totals fields in the lower part of the Repair Estimate tab show charge line

totals.

14. To delete a charge line, select the relevant charge line on the Repair Estimate tab,
and click the Delete icon on the toolbar.

Comments

1. You cannot add or delete charge lines in the Estimate Charge Details worksheet.
You can add or delete charge lines only in the Repair Estimate tab.

2. If you have added estimate lines derived from a Service Code, using Add Lines
from Diagnostics, then you cannot add the lines again from the same Service Code.

Checks for Adding Estimate Lines from Diagnostics

You should ensure that the following conditions are true before you add lines from the
Diagnostics tab. Failure to satisfy all the conditions results in rows not being imported

as estimate lines.

(A) General Checks

The following checks apply to all lines:

¢ You must have at least one active Service Code, that is, a Service Code marked as
applicable, associated to the Repair Order.

e The default Price List must be defined and active.

e The Billing Type for the item must be defined.
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Note: You cannot add an estimate line from the same Service Code
entry on the Diagnostics tab twice.

(B) WIP-Specific Checks
The following checks apply to WIP lines:

¢ The Service Code must be associated with at least one work entity (bill or routing),
and each associated work entity must be defined for the organization specified by
the profile option Service: Inventory Validation Organization.

¢ Each work entity must have a Bill of Material.
¢ Each operation sequence must have a Resource.

¢ Each Resource must have a billing Item.

(C) Task-Specific Checks

The following checks apply to task lines derived through Service Codes and, under
profile control, directly from Task Templates related to Oracle Knowledge Management
Solutions.

¢ Each work entity must have a Task Template Group.
* Each Task Template Group must have a Task Template.

* You must have a product part defined for the Task Templates and the Repair Order
Item.

* For a task parts definition, you should have a manual or a rollup quantity or both.

¢ If there is a substitute defined for a task part, the task part is not added as an
estimate line.

e For labor lines only, for Planned Effort, you must have provided a value for the
profile option CSD: Default Labor Item for Estimate Line from Tasks.

¢ For labor lines, the Planned Effort Interval and UOM for the Task Template must
not be null.

(D) Tasks-from-Solutions Checks

In addition to the Task-Specific checks, the following additional checks apply to task
lines derived directly from Oracle Knowledge Management Solutions:

e The profile option CSD: Use Tasks from Knowledge Base Solutions must be set to

Depot Workbench  4-61



Yes.

e The Solution in the Solutions area of the Diagnostics tab must have a Status of
Useful.

¢ The corresponding Solution in Oracle Knowledge Management must have an active
Task Template among its Related Objects.

Revise a Repair Estimate

Certain repairs can require service providers to revise repair estimates many times. The
service agent should verify existing warranties or contracts while quoting and revising
estimates.

Note: If you manually override the Estimated Charge, which you are
allowed to do if the profile option CSD: Allow Charge Override for
Estimates is set to Yes, then discounts associated with the contract are
not applied.

Note: Net Discount will always be the Extended Price minus the
Estimated Charge, not the contract discount.

The following procedures describe how to revise the estimated charges for an item
under repair.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

A repair charges estimate must exist for the broken item.

Navigation
Depot Repair > Repair Orders

Steps

1. Retrieve the Repair Order for which you want to revise the estimate.

For more information, see Find Service Requests and Repair Orders, page 4-32.
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2. Select the relevant record from the Results area of the Find Repair Orders window,
and click OK.

The Depot Repair Workbench shows the selected Service Request and Repair Order
details.

3. Select the Repair Estimate tab in the Depot Repair Workbench.

The existing charge lines appear in the multi-record area.

4, Click Line Details.

The Estimate Charge Line Details window opens.

5. Make the necessary changes to the charge line field values.

For more information, see Estimate Repair Charges, page 4-54.
6. Click Save to record the revised charges.

7. Click Close to close the Estimate Charge Line Details window and return to the
Repair Estimate tab.
The charge lines and totals on the Repair Estimate tab reflect the revision made to

the estimate.

8. To change the repair estimate status, choose an appropriate value from the list of
values in the Status field.

9. Click Save Estimate to record the changes.

Obtain Customer Approval for a Repair Estimate

Module

If estimate approval is required for a repair estimate, then, after creating the repair
charges estimate, the service agent seeks the customer's approval of the estimate.

Upon customer's approval, the depot receives the defective parts in repair
subinventory. If the customer rejects the estimate, the Repair Order can be closed, or put
on hold as appropriate.

Repair Order estimates can be New, Drafted, Bid, Accepted, Rejected, or Cancelled.
These statuses indicate whether to start a repair process. Typically, a repair estimate
must be approved prior to the start of the WIP Repair Job.

The following procedures describe how to record customer approval for a repair
estimate.

Oracle Applications Navigator
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Responsibility

Prerequisites

Navigation

Steps

Depot Repair Super User

A Repair Order record with an approved estimate must exist. Also, you must have
revised the original estimate as appropriate.

Depot Repair > Repair Orders

Retrieve the Repair Order that you want to revise.

For more information, see Find Service Requests and Repair Orders, page 4-32.
Select the relevant record from the Results area of the Find Repair Orders window,
and click OK.

The Depot Repair Workbench shows the selected Service Request and Repair Order
details.

The Details tab of the Depot Repair Workbench displays the total charges for the
repair in the Charges area.
Make changes to the original estimate charge lines as required.

For detailed instructions, see Revise a Repair Estimate, page 4-62.
Discuss the revised charges with the customer.

In the Repair Estimate tab, update the estimate Status to Estimate Accepted or
Estimate Rejected.

Click the Save icon on the toolbar to save the updated status.

The Repair Order is revised with the new charges and customer approval
information.

On the Details tab, create or consult notes as required.

For detailed instructions, see Create and Maintain Notes, page 4-37.

Click Update RO Status.

In the Update Repair Order Status window, you can update the Repair Order
status.

For details, see Update the Repair Order Status, page 4-25.
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9. Optionally, from the top menu, click Tools > Freeze Estimate to freeze the estimate.

After the estimate is frozen, you cannot change the estimate.

Receive a General Item
The term "general item” indicates an item that is not being refurbished.

Depot technicians can receive hand carried (walk-in) items for repair, or receive
serviceable items against RMAs. Oracle Depot Repair provides flexible options when
receiving and shipping items from and to customers and vendors.

Before receiving an item the system allows you to receive a serial number different from
the one originally entered in the repair order. In case of a mismatch or discrepancy the
system allows the receipt of the discrepant serial number and logs an activity to track
the discrepancy.

Inspection

You can also inspect items during the receiving process, which allows for more accurate
repair estimates as a result of inspection. Inspection of items is possible only if the
routing on the RMA order is either Standard Receipt or Inspection Required.

The procedure for receiving an item with inspection is more extensive than the
procedure for receiving an item without inspection

The following is an overview of the procedure for receiving an item without inspection:

® Receive the item on the RMA order into a subinventory.

The following is an overview of the procedure for receiving an item with inspection:

® Receive the item on the RMA order into a receiving location.
e Inspect the item, then accept or reject it.
* Move the item into a subinventory.

The following procedures describe how to receive a general item (except for internal
order refurbishment items - for details of those procedures, see Receive an Item for
Refurbishment, page 4-70).

Module

Oracle Applications Navigator

Responsibility
Depot Repair Super User
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Prerequisites

You must complete all steps in the relevant business scenario prior to receiving the
general item. For more information, see Oracle Depot Repair Business Scenarios..

Navigation

Depot Repair > Repair Orders

Steps:

1.

Retrieve the Repair Order for which you want to receive the general item.

For more information, see Find Service Requests and Repair Orders, page 4-32.

Select the relevant result from the Results area of the Find Repair Orders window,
and click OK.

The Depot Repair Workbench shows the selected Service Request and Repair Order
details.
Select the Logistics tab in the Depot Repair Workbench.

If the RMA (Return) line was not created and booked automatically for the Repair
Order, then create an RMA order manually.

For detailed instructions, see Create and Book a Return Line Manually, page 4-26.
Click Receive to open the Find Expected Receipts window.

In the Customer tab in the Find Expected Receipts window, enter the RMA
Number, and click Find.

If the RMA is found, the application displays the Receipt Header and Receipts

windows.

Confirm the Received By field of the Receipt Header window, that is, the person
receiving the RMA.

Confirm the Receipt Date, and click the Save icon on the toolbar to obtain the
system-generated Receipt Number.

Close the Receipt Header window.

If you want to receive an item without inspection, continue at step 9.

If you want to receive an item with inspection, continue at step 16.

Receiving an Item Without Inspection
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10.

11.

12,

13.

14.

15.

16.

17.

Note: For Direct Delivery Routings, you must receive an item
without inspection. Inspection is optional if your routing is
Standard Delivery or Inspection Required.

However, for Inspection Required Routings, Oracle recommends
that you perform the steps starting at step 16.

In the Receipts window, in the Lines tab, select the check box located beside the Qty
field to confirm quantity.

For the Destination Type, select Inventory.

Scroll the horizontal bar to reveal the Subinventory field, and select a Subinventory
location in this field from the list of values.

If the general item is a serialized item, the Lot-Serial button on the Receipts window
is enabled.

1. Click Lot-Serial to display the Serial Number window.

2. Enter the received Serial Number, and click OK.

You can manually enter a Serial Number even if the number does not appear in
the list of values

Click the Save icon on the toolbar.
Close the Receipts window to return to the Depot Repair Workbench.

In the Logistics tab, click Refresh Logistics.

The status of the RMA (Return) line changes to Received.

Optionally, you can see item reception details in the Activity window. From the top
menu, select Data > Activity to open up the Activity window.

This completes the procedures for receiving an item without inspection.

Receiving an Item With Inspection

Note: Note: For Inspection Required Routings, Oracle recommends
that you perform the inspection steps that follow.

In the Receipts window, in the Lines tab, select the check box located beside the Qty
field to confirm quantity.

For the Destination Type, select Receiving.
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18.

19.

20.

21,

22,

23.

24,

25.

26.

27.

28.

29.

30.

31

32,

Select a Location.

Click the Save icon on the toolbar.

Close the Receipts window.

Back in the Logistics tab of the Depot Repair Workbench, click Inspect/Move.

In the Customer tab in the Find Receiving Transactions window, enter the RMA
Number, and click Find.

The Receiving Transactions window appears.
If there is more than one line, select the lien you want to inspect.
Click Inspect.

In the Inspection Details window, select the Status (values are either Accept or
Reject).

Click OK.
This closes the Inspection Details window.

The Destination Type of the item shows as Inspect.

Click the Save icon on the toolbar.

Close the Receipt Transactions window.

Back in the Logistics tab of the Depot Repair Workbench, click Inspect/Move.

In the Customer tab in the Find Receiving Transactions window, enter the RMA
Number, and click Find.
The Receiving Transactions window appears, with the Destination Type of the item

showing as Inventory.

Scroll the horizontal bar to reveal the Subinventory field, and select a Subinventory
location in this field from the list of values.

If the general item is a serialized item, the Lot-Serial button on the Receiving
Transactions window is enabled.

1. Click Lot-Serial to display the Serial Number window.

2. Enter the received Serial Number, and click OK.

You can manually enter a Serial Number even if the number does not appear in
the list of values.
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33. Click the Save icon on the toolbar.

34. Close the Receiving Transactions window to return to the Depot Repair
Workbench.

35. In the Logistics tab, click Refresh Logistics.

The status of the RMA (Return) line changes to Received.

36. Optionally, you can see item reception details in the Activity window. From the top
menu, select Data > Activity to open up the Activity window.

This completes the procedures for receiving an item with inspection.

Note: You can enable the functionality of updating the Repair
Status automatically once an item is received successfully. This is
done by setting the profile option, CSD: Enable Auto Update of
Repair Order Status upon Receiving, to Yes, and the profile option,
CSD: Default Repair Order Status After Receiving, will hold the
value for the new status.

Use caution in setting the profile option, CSD: Default Repair Order
Status After Receiving, to Yes as only one status can be chosen
irrespective of the item or repair type used.

Ship Additional ltems

On the Logistics tab, Oracle Depot Repair verifies that the item quantity on the Repair
Order matches the RMA quantity on Logistics tab. This implies that it is not possible to
ship additional items or quantities of items against the same Repair Order. To ship
additional items or quantities of items, you must create a new Repair Order with the
additional item or quantity.

Auto-Receive an ltem

When you receive an item into a subinventory, you generally have to perform a number
of operations in several different windows (for example, find a receipt, edit one or more
receipt fields).

Under certain conditions, you can receive an item directly from the Logistics tab,
without having to navigate through extra windows. The operation of receiving an item
directly from the Logistics tab is called auto-receive.

The conditions under which you can auto-receive an item are as follows:

e The item must be serialized.
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¢ The item must be locator controlled.

® The quantity on the RMA (Return) line is 1.

¢ The Receipt Routing must not be Inspection Required.

* You must enter the Source Serial Num and Subinv fields on the RMA (Return) line.
When all these conditions apply, and you click the Receive button on the Logistics tab,

an alert message appears that informs you that the item is eligible for auto-receive.

If you accept the option to auto-receive the item, the auto-receive operation is
performed.

Note: After the successful completion of the auto-receive operation, the
Status of the RMA (Return) line is Booked. After you click Refresh
Logistics, the Status changes to Received.

Receive an Item for an Internal Order Refurbishment

When a Repair Order has been created in the Planner's Desktop of Spares Management,
or an equivalent external agency, and the item or items are to be sent to an Oracle Depot
Repair depot for processing, this type of repair is called an internal order refurbishment.

Note: This is not the same as an internal party refurbishment, where the
items to be refurbished belong to an internal party. For more
information, see Create and Process an Internal Party Refurbishment,
page 4-123.

If you do not select a subinventory for the item, the subinventory is derived from the
picking rule defined in the profile option CSD: Default Pick Release Rule for Sales
Orders.

In Oracle Depot Repair, the Repair Order for each item or item instance to be
refurbished contains two transactions, with action types Move In and Move Out. This
section describes the Move In transaction.

The Move In transaction has two components:
1. First, the shipment stage, where the item is shipped from a source organization,
such as Spares Management.

2. Then, the receiving stage, where the item is received into a depot subinventory.

In the shipment stage, if you do not select a subinventory for the item, the subinventory
is derived from the picking rule defined in the profile option CSD: Default Pick Release
Rule for Sales Orders.
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Inspection

Module

Responsibility

Prerequisites

The shipment stage includes a Pick Release process, and then either a manual Ship
process or an automatic Ship Confirm process. When both Pick Release and Ship
Confirm processes can be performed automatically, that is, without any manual Serial
Number entry required, you can select whether to perform both processes separately
one after the other, or in sequence automatically.

During the receiving stage, you can also inspect the items to be refurbished, which
allows for more accurate repair estimates as a result of inspection. Inspection of items is
possible only if the routing on the requisition order is either Standard Receipt or
Inspection Required.

The procedure for receiving an item with inspection is more extensive than the
procedure for receiving an item without inspection.

The following is an overview of the procedure for receiving an item without inspection:

* Receive the item on the requisition order into a subinventory.

The following is an overview of the procedure for receiving an item with inspection:

¢ Receive the item on the requisition order into a receiving location.
e Inspect the item, then accept or reject it.

* Move the item into a subinventory.

Oracle Applications Navigator

Depot Repair Super User

The Service Request and the associated refurbishment Repair Order or orders must
have been created in the Planner's Desktop of the Spares Management module of Oracle
Field Service.

Note: It is possible to create demand for refurbishment using a module
other than Oracle Field Service and to pass this demand to Oracle
Depot Repair.
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Navigation

Note: The module must be able to create Internal Requisitions and
associate them to Internal Sales Orders. However, Oracle recommends
using the out-of-the-box integration to Oracle Field Service.

Depot Repair > Repair Orders

Steps:

1.

Retrieve the Repair Order for which you want to receive the item for refurbishment.

For more information, see Find Service Requests and Repair Orders, page 4-32.

Select the relevant result from the Results area of the Find Repair Orders window,
and click OK.

Click the Logistics tab.

Click any field of the Move In line to make that line current.
The Status of the Move In line should be Booked.

Shipping the Item to be Refurbished from Spares Management

Note: The following description assumes that you select the
automatic Pick Release option when processing the Move In line.

Note: Even if you select Ship Confirm as your first choice for
processing the Move In line, the application automatically
processes the Pick Release stage first, then the Ship Confirm stage.

Pick Release
Click the Process Trans check box for the Move In line.
Click the Automate order processing steps through check box.

Select the Pick Release radio button.

Click Process.
The Status of the Move In line generally changes to Released.

However, for a serialized item that has Serial Control which is either Predefined or
At Receipt, the resulting Status depends on whether you are performing the Pick
Release processing for the first time or the second time.
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10.

11.

12,

13.

14.

1. The first time, you must enter a Serial Number, navigating through the Find
Move Order Lines window that appears automatically, to the Transact Move
Orders window.

For details of the Find Move Order Lines window and the Transact Move
Orders window, see the Oracle Inventory User’s Guide.

When you return from the Transact Move Orders window, the Status of the
Move In line remains as Booked.
2. The second time you perform the Pick Release process (steps 5 through 8), you

do not have to enter any further data, and the Status changes to Released.

To see the Serial Number that you entered during the first-time Pick Release
processing in the (Source) Serial Num field on the Logistics tab, click Refresh
Logistics, after you complete the second-time Pick Release processing.

Optionally, from the top menu, select Data > Activity to see the details of the item
shipment in the Activity window.

If there has been a mismatch between the Serial Number in the Move In line and the
Serial Number you entered in the Transact Move Orders window, an alert message
line appears in the Activity window, recording the two Serial Numbers. You must
explicitly select Data > Activity to display the alert message.

This completes the Pick Release processing.

Manual Ship or Ship Confirm

For the case of a serialized refurbished item, whose Serial Control is At Sales Order
Issue, the Ship Confirm button is disabled. In this situation, click Ship and enter the

item's Serial Number in Oracle Shipping Execution windows. For details of these
windows, see the Oracle Shipping Execution User’s Guide.

When you return to the Logistics tab, click Refresh Logistics. The Status changes to
Shipped.

This completes the manual ship processing for these special Move In lines.

Continue at step 16.

For all other cases, click the Process Trans check box for the Move In line.
Click the Automate order processing steps through check box.

Select the Ship Confirm radio button.

Click Process.

When processing the Ship Confirm stage, you should wait until the concurrent
program Interface Trip Stop has completed successfully before you click Refresh
Logistics, to see the changed value of the Status.
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15.

16.

17.

18.

19.

20.

21,

22,

23.

24

You can monitor the progress of the program by selecting Requests from the View
menu on the toolbar, and selecting appropriate search criteria.
Click Refresh Logistics.

The purpose of this is to update the Status on the Move In line, so that it reflects in
Oracle Depot Repair the results of the procedures executed in other Oracle
applications when you clicked Process.

After the background concurrent process Interface Trip Stop has completed
successfully, the Status changes to Shipped.

Starting the Process of Receiving the Item to be Refurbished

Click any field of the Move In line to make that line current.

Click Receive to open the Find Expected Receipts window.

In the Supplier and Internal tab in the Find Expected Receipts window, enter the
Requisition from the Requisition Num of the Move In line, and click Find.

If the requisition is found, the application displays the Receipt Header and Receipts

windows.

Confirm the Received By field of the Receipt Header window, that is, the person
receiving the requisition.

Confirm the Receipt Date, and click the Save icon on the toolbar to obtain the
system-generated Receipt Number.

Close the Receipt Header window.

If you want to receive an item without inspection, continue at step 22.

If you want to receive an item with inspection, continue at step 29.
Receiving the Item to be Refurbished Without Inspection

In the Receipts window, in the Lines tab, select the check box located beside the Qty
field to confirm quantity.

In the Destination Type field, select Inventory.

Scroll the horizontal bar to reveal the Subinventory field, and select a Subinventory
location in this field from the list of values.

If the item is a serialized item, the Lot-Serial button on the Receipts window is
enabled.

1. Click Lot-Serial to display the Serial Number window.

2. Enter the received Serial Number, and click OK.
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25.

26.

27.

28.

29

30.

31

32,

33.

34.

35.

36.

37.

38.

39.

40.

You can manually enter a serial number even if the number does not appear in
the list of values.

Click the Save icon on the toolbar to save the receipt record.
Close the Receipts window to return to the Depot Repair Workbench.

Click Refresh Logistics.

The Status of the Move In line changes to Received.

Optionally, from the top menu, select Data > Activity to see the details of the
reception of the item in the Activity window.

This completes the process of receiving an item without inspection.

Receiving the Item to be Refurbished With Inspection

In the Receipts window, in the Lines tab, select the check box located beside the Qty
field to confirm quantity.

For the Destination Type, select Receiving.

Select a Location.

Click the Save icon on the toolbar.

Close the Receipts window.

Back in the Logistics tab of the Depot Repair Workbench, click Inspect/Move.

In the Supplier and Internal tab in the Find Expected Receipts window, enter the
Requisition from the Requisition Num of the Move In line, and click Find.

The Receiving Transactions window appears.
Click Inspect.

In the Inspection Details window, select the Status (values are either Accept or
Reject).

Click OK.
This closes the Inspection Details window.

The Destination Type of the item shows as Inspect.
Click the Save icon on the toolbar.

Close the Receipt Transactions window.
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4,

42,

43

44,

45,

46.

47.

48.

Back in the Logistics tab of the Depot Repair Workbench, click Inspect/Move.

In the Supplier and Internal tab in the Find Expected Receipts window, enter the
Requisition from the Requisition Num of the Move In line, and click Find.

The Receiving Transactions window appears, with the Destination Type of the item

showing as Inventory.

Scroll the horizontal bar to reveal the Subinventory field, and select a Subinventory
location in this field from the list of values.

If the item is a serialized item, the Lot-Serial button on the Receiving Transactions
window is enabled.

1. Click Lot-Serial to display the Serial Number window.

2. Enter the received Serial Number, and click OK.

You can manually enter a Serial Number even if the number does not appear in
the list of values.

Click the Save icon on the toolbar.

Close the Receiving Transactions window to return to the Depot Repair
Workbench.

In the Logistics tab, click Refresh Logistics.

The status of the Move In line changes to Received.

Optionally, from the top menu, select Data > Activity to see the details of the
reception of the item in the Activity window.

This completes the procedures for receiving an item with inspection.

Split a Repair Order

Often as a result of an inspection carried out during the receiving of an item, you may
decide to repair some but not all of the defective units.

Under certain conditions (see the Prerequisites that follow in this section, page 4-77),
Oracle Depot Repair allows you to split a Repair Order, but not necessarily just because

of an inspection.

Repair Type Change Options

One of the prerequisite conditions is that the original Repair Type must have a Repair
Type Ref value of either Standard or Repair and Return. You can change the Repair
Type on the new Repair Order, so long as the final Repair Type also has a Repair Type
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Ref value of either Standard or Repair and Return.

Note: The explicit condition specifies the Repair Type Ref attribute of
the allowable Repair Types. The seeded Repair Types Standard and
Return and Repair have the same Repair Type Ref values as their
Repair Type names.

For details of setting up Repair Types, see the Oracle Depot Repair Implementation Guide.

Splitting Options
When you choose to split a Repair Order, you have the following options:
*  You can split into two separate Repair Orders, as for example when splitting 10
units into two lines of 8 and 2 units.

® You can split into multiple Repair Orders, each with a quantity of 1.

When you choose to split the Repair Order into two separate Repair Orders, you can
also decide whether to copy attachments from the original Repair Order to the new
Repair Order.

When you split into multiple lines, each with a quantity of 1, all attachments on the
original Repair Order, if any exist, are automatically copied to each new Repair Order.

Module

Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

The Repair Order Item must be serialized.

The item must not be Installed Base trackable.

All quantities must be received.

For WIP mode, all jobs must be completed, that is, no partial completions are allowed.
The Repair Order status must be Open.

The Repair Type Ref of the Repair Type must be Standard or Repair and Return.

No Ship lines have been interfaced to Oracle Order Management.
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Navigation
Depot Repair > Repair Orders

Steps:
1. Retrieve the Repair Order that you want to split.

For more information, see Find Service Requests and Repair Orders, page 4-32.

2. Select the relevant result from the Results area of the Find Repair Orders window,
and click OK.

3. From the top menu, select Tools > Split Repair Order.
The Split Repair Order window appears.
Your splitting options are indicated by the two radio buttons:

e Split into 2 lines
e Split into lines with quantity of 1

Split into 2 Lines
Under the Split into 2 lines option, there is a table showing the following fields:

¢ Original Repair Order Quantity (enabled)
® Original Repair Order Repair Type

* New Repair Order Quantity

¢ New Repair Order Repair Type (enabled)

There is also a check box under the Split into 2 lines option, enabling you to copy
attachments from the original Repair Order to the new Repair Order.

If there are no attachments to the original Repair Order, the check box is disabled.
Split into Lines with a Quantity of 1

Under the Split into lines with a quantity of 1 option, a message indicates that any
attachments to the original order will be automatically copied to the new order.

4, Select one of the radio buttons.

5. If you selected Split into lines with a quantity of 1, you have no further choices.
Continue at step 7.

6. If you selected Split into 2 lines:
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1. Enter the Original Repair Order Quantity, that is, the new quantity that you
wish to have on the original Repair Order after splitting.

The New Repair Order Quantity is automatically calculated after you enter the
Original Repair Order Quantity.

2. Select the New Repair Order Repair Type.
You can only select a Repair Type whose Repair Type Ref was set up as

Standard or Repair and Return.

3. Optionally, select the check box Copy attachments from original Repair Order
to new Repair Order.

7. Click OK.

Manage the Repair Process

Oracle Depot Repair lets service organizations manage repair by using either Oracle
WIP or Task Manager, a module in Oracle Common Application Components.

WIP mode is recommended for use when the repair jobs require series of sequential
steps, and materials management. Task mode is recommended for use when the repairs
require minimal steps that are not necessarily completed in sequence.

The WIP or Task modes are associated to the Repair Types during implementation.
Though a service organization can have different Repair Types associated with different
repair modes, it is recommended that a service organization select only one repair mode
for all Repair Types to enhance usability.

The topics in this section include the following;:

¢ Create and Process WIP Jobs, page 4-79

® Create and Process Repair Tasks, page 4-90

Create and Process WIP Repair Jobs

Note: Oracle Depot Repair provides E-records and E-signature (ERES)
functionality in WIP mode via Oracle WIP.

The topics in this section include the following;:

* Create a WIP Repair Job for a Single Repair Order, page 4-80

® Process a WIP Repair Job for a Single Repair Order, page 4-83
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® Create a WIP Repair Job Across Multiple Repair Orders, page 4-85

® Process a WIP Repair Job Across Multiple Repair Orders, page 4-88

Create a WIP Repair Job for a Single Repair Order

Module

Responsibility

Prerequisites

The Shop Floor Technician can create a non-standard WIP Repair Job from the Depot
Repair Workbench. You select the organization for the WIP Repair Job, and the items
for the WIP Repair Job must be defined in that organization.

Multiple jobs can be created for each Repair Order. You can release WIP Repair Jobs on
to the shop floor. You must provide the WIP Accounting Class through which costs are
posted to Oracle General Ledger.

Depot agents can view WIP Discrete Jobs window in a read-only mode to verify the
status and additional details of the WIP Repair Job.

The following procedures describe how to create a WIP Repair Job for a single Repair
Order.

Oracle Applications Navigator

Depot Repair Super User

You must complete all steps in the relevant business scenario prior to creating the WIP
Repair Job for the Repair Orders. For more information, see Oracle Depot Repair
Business Scenarios.

Note: You may need to create a Repair Job without an RMA in case of
remanufacture or refurbishment on items that your organization
already owns, or if your organization took ownership or possession of
an item through a field service agent rather than against an RMA.

Note: Oracle Depot Repair provides you with a profile option, CSD:
Allow Creating WIP Job Without RMA, which enables you to create a
WIP Repair Job without an RMA. Refer to Oracle Depot Repair
Implementation Guide for details.
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Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order for which you want to create a WIP Repair Job.

For more information, see Find Service Requests and Repair Orders, page 4-32.

2. Select the relevant record from the Results area of the Find Repair Orders window,
and click OK.

The Depot Repair Workbench shows the selected Service Request and Repair Order
details.

3. In the Depot Repair Workbench, select the Repair Jobs tab, and click Create Job.

The Submit Repair Jobs window opens. The job you create will be in the
organization set up when you perform the Change Organization operation. If you
have not performed the Change Organization operation, the organization is taken
from the profile option CSD: Default Repair Inventory Org.

nufacturing)

Repair Order
Quantity

ct Bills and Routings

Mechanical Service 1 18-NOV-2003

Routing

_ Reference Description Alternate eference Description Alterate
Bill 01 for Depot Repair
Bill 01 for Depot Repair

Submit Jobs

4. If the WIP Repair Job item is different from the Repair Order Item, select the
relevant WIP item from the list of values in the Item field.

5. Select the Released Job Status from the list of values.
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Note: The default value for this field is taken from the profile
option CSD: Default Repair Job Status.

Note: You may submit a WIP Repair Job with a Job Status of
Unreleased. You will be able to change the status later using Oracle
Work In Process transactions.

6. Select an Accounting Class from the list of values, for example, Rework.
7. Enter the number of items that you want to submit in the (Quantity) Submit field.

8. The system date defaults as Start Date. Select the Complete Date for the WIP Repair
Job.
9. In the Service Codes, Bills and Routings area, select one of the three radio buttons:

® Use Service Codes
® Select Bills and Routings
¢ Do not Specify Bills and Routings

If you select Use Service Codes, the following occurs:

¢ Bills and Routings associated with the active Service Codes, that is, the Service
Codes marked as applicable, in the Diagnostics tab are attached to the WIP
Repair Job.

¢ Read-only summary information about the Service Codes, Bills, and Routings is
displayed in the Service Codes, Bills and Routings area.

¢ After you have added the Bills and Routings associated with the active Service
Codes, the Service Code rows from which you derived the Bills and Routings
are disabled in the Service Codes area of the Diagnostics tab.

Note: After you have added the Bills and Routings associated
with the active Service Codes, the Service Code rows from
which you derived the Bills and Routings are disabled in the
Service Codes area of the Diagnostics tab.

If you select Select Bills and Routings, enter appropriate Bill and Routing data in the
Bill and Routing sections.

If you select Do not Specify Bills and Routings, you are choosing not to provide any
Bill and Routing information for the WIP Repair Job.
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10. Click Submit Job to submit the job in a released status to WIP.

11. To make sure that the program completes successfully, monitor the requests by
choosing View > Requests.

12. Close Repair Jobs window to return to the Depot Repair Workbench.

13. Click Refresh Job.

The new job appears on the Repair Jobs tab.

14. To view the job, select the job record on the Repair Jobs tab, and click View Job.

To process the WIP Repair Job, see Process a WIP Repair Job for a Single Repair
Order, page 4-83.

See Also
Create a WIP Repair Job Across Multiple Repair Orders, page 4-85.

Multiple WIP Repair Jobs and Partial Quantities for a Single Repair Order

Oracle Depot Repair lets you create multiple WIP Repair Jobs for a single Repair Order
and supports the creation of multiple WIP Repair Jobs with partial quantities per RMA.

WIP Repair Job Item Same As Repair Order Item

If the item selected for the WIP Repair Job is the same as the one in the Repair Order,
then for each WIP Repair Job submission, the submit quantity cannot be greater than the
quantity received. A submit quantity less than the quantity received implies that you
can create multiple WIP Repair Jobs against a single Repair Order, with each WIP
Repair Job handling part of the RMA quantity.

For example, consider that the item on the Repair Order is A, and the quantity of item A
is 5. When you submit WIP Repair Jobs for item A, the maximum number of units of A
that can be submitted in a WIP Repair Job is 5, and the minimum is 1.

WIP Repair Job Item Different From Repair Order Item
If the item selected for a WIP Repair Job is different from the one on the Repair Order,
the submit quantity restriction does not apply, and you can submit the WIP Repair Job
for any quantity. The application validates this quantity with the quantity received in
the Repair Order line. In this case, the quantity to be submitted to WIP must be at least
1.

Process a WIP Repair Job for a Single Repair Order

The following procedures describe how to process a repair WIP Repair Job that contains
a single Repair Order.
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Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

You must complete all steps in the relevant business scenario prior to processing the
WIP Repair Job for the Repair Order. For more information, see Oracle Depot Repair
Business Scenarios.

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order for which you want to process the WIP Repair Job.

For more information, see Find Service Requests and Repair Orders, page 4-32.

2. Select the relevant record from the Results area of the Find Repair Orders window,
and click OK.
The Depot Repair Workbench shows the selected Service Request and Repair Order
details.

3. In the Depot Repair Workbench, select the Repair Jobs tab.

4. Click Material Txn to display the Material Transaction window.

5. Issue the item and the material required to process the WIP Repair Job.
For details, see Issuing and Returning Specific Components in the Oracle Work In
Process User’s Guide.

6. Complete the item repair using a recommended repair procedure.

7. When the repair is complete, click Complete Job in the Repair Jobs tab.
The Completion Transaction Find window opens.

Enter the completion details, such as quantity completed and completion
subinventory, for the WIP Repair Job.

For details, see Completing and Returning Assemblies in the Oracle Work In Process
User’s Guide.
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Post-Processing

8. In the Repair Jobs tab of the Depot Repair Workbench, click Refresh Job to update
the Repair Order activity information.

1. To see information about the WIP Repair Job activity, from the top menu, select
Data > Activity.

For more information, see View Activities Related to a Repair Order, page 4-100.

2. After you have processed a WIP Repair Job, if invoicing is required, you must move
the data to Repair Actuals.

For more information, see Record Billing Data in Repair Actuals, page 4-112.

Create a WIP Repair Job Across Multiple Repair Orders

Module

Responsibility

Oracle Depot Repair lets service organizations automatically create a single WIP Repair
Job against multiple Repair Orders for identical items.

You search for WIP Repair Jobs issued for items that have already been received into
the repair organization. You can perform the search against the Item Code, or attributes
that pertain to the linked Service Request.

You perform this operation in two stages:
1. First, you search for the Repair Orders, in the Find Repair Orders for Job

Submission window.

2. Then, you determine how many units to submit for repair for each Repair Order,
and submit the WIP Repair Job, in the Submit Repair Jobs for Repair Orders
window.

The Find Repair Orders for Job Submission window incorporates a multi-select feature
to let you select any or all Repair Order lines that appear in the search results.

In the Submit Repair Jobs for Repair Orders window, you can specify the quantity of
the item to submit for each Repair Order, and optionally, select Bills and Routings.

The following procedures describe how to create a WIP Repair Job for multiple Repair
Orders relating to the same item.

Oracle Applications Navigator

Depot Repair Super User
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Prerequisites

You must complete all steps in the relevant business scenario prior to creating the WIP
Repair Job for the Repair Orders. For more information, see Oracle Depot Repair
Business Scenarios.

Navigation

Depot Repair > Submit Repair Jobs...Organizations window

Steps

1. Select the relevant Repair Organization from the list of values.
Find Repair Orders for Job Submission Window
The Find Repair Orders for Job Submission window opens.

For field descriptions, see Find Repair Orders for Job Submission Window, page 2-
49.

2. Enter one or more search criteria by using one or more of the following fields:

* (Service Request) Request Num

* (Service Request) Customer

* (Service Request) Account

® (Service Request) Severity or Urgency

* (Repair Order) Item

¢ (Repair Order) Promise Date or Date Range

¢ (Repair Order) Create Date or Date Range
This is a sample list of the search parameters.

For descriptions of all the fields, see Find Repair Orders for Job Submission
Window, page 2-49.

3. Click Find to start the query.

The search results appear in the Results area of the Find Repair Orders for Job
Submission window.

4. Select the relevant Repair Order or combination of Repair Orders.

e To select all the rows, click Select All.
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10.

11.

12,

13.

* To select multiple, non-contiguous rows from among the search results, press
and hold the Control key, and click each row.

¢ To select a complete range of rows from among the search results, click the first
row of the range, then press and hold the Shift key, and click the final row of
the range.

e To deselect all rows, click Deselect All.

After you select the relevant rows, click OK.
Submit Repair Jobs for Repair Orders Window
The Submit Repair Jobs for Repair Orders window opens.

The selected rows populate the Repair Order Information area in the window, and
the Total Quantity Submitted for repair automatically appears.

For field descriptions, see Submit Repair Jobs Window, page 2-52.

In the Job Status field, select Released from the list of values.

You may submit a WIP Repair Job with a Job Status of Unreleased. You will be able
to change the status later using Oracle Work In Process transactions.

Select an Accounting Class from the list of values, for example, Rework.

Your organization determined these values during implementation of Oracle Depot
Repair.

The system date defaults as Start Date. Select the WIP Complete Date.

In any line of the Repair Order Details tab, you can optionally change the number of
units to submit in the (Quantity) Submit field.

You can optionally click the Bills and Routings tab, and select one of the radio
buttons:

® Select Bills and Routings
* Do not Specify Bills and Routings

If you choose Select Bills and Routings, then you must select at least one Bill or
Routing.

Click Submit Jobs to submit the job in a released status to WIP.

To verify that the program completes successfully, monitor the requests by
choosing View > Requests from the toolbar.

Close the Submit Repair Jobs for Repair Orders window and return to the
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Navigator.

Refresh Job for Each Repair Order
14. Retrieve these Repair Orders by using the Find Repair Orders window.

15. In the Depot Repair Workbench, select each Repair Order, and click Refresh Job.
The new job appears on the Repair Jobs tab.

For more information, see Update Repair Orders Concurrently, page 4-102.

Comments
After you have created and submitted a WIP Repair Job for identical items across
multiple Repair Orders, you can process the WIP Repair Job.
For more information, see Process a WIP Repair Job Across Multiple Repair Orders,
page 4-88.

See Also

Create a WIP Repair Job for a Single Repair Order, page 4-80

Process a WIP Repair Job Across Multiple Repair Orders

The following procedures describe how to process a WIP Repair Job containing
multiple Repair Orders. Processing a WIP Repair Job across multiple Repair Orders
involves the following areas:

e Find Discrete Jobs Window, page 4-89
® Material Transactions Window, page 4-89
* Completion Transactions Window, page 4-90

e  WIP Jobs and Schedules Window, page 4-90

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

You must complete all steps in the relevant business scenario prior to processing the
WIP Repair Job for the Repair Orders. For more information, see Oracle Depot Repair
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Business Scenarios.

Navigation

WIP > Discrete > Discrete Jobs...Find Discrete Jobs window

Steps

Find Discrete Jobs Window

1.

Enter the WIP Repair Job Number, and click the Find button.

The Discrete Jobs window opens.
Confirm that the Repair Job is in Released status.

Click the Routing Tab and select the Completion Subinventory from the list of
values.

If the item is under Locator control, enter the Locator value.
Save your work.

Close the Discrete Jobs window to return to the navigator.

Material Transactions Window

1.

Navigate to WIP > Material Transactions > WIP Material Transactions.

The Material Transactions window opens.

Select the Specific Component option if the material to be issued is not defined as a
material requirement for the job.

Enter the WIP Job Number, and click the Continue button.

The WIP Component Issue window opens.

In the Components Issue window, enter the Items to be repaired.

If you did not select the Specific Component option, and the material you want to
issue is not defined as a material requirement for the job, you might not be able to
issue the item.

Select the present Subinventory location of the items.

If the items are Locator controlled, enter Locator information.

Enter the Quantity to be repaired.
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10.

11.

If the items are under Serial or Lot control, enter Serial or Lot information.
Enter the material needed to assist the repair.

Click Done.

This issues the material and closes the window.

Close the Material Transactions window to return to the Navigator.

Completion Transactions Window

1.

After completing the repair, navigate to WIP > Material Transactions > Completion
Transactions.

The Completion Transactions window opens.
Enter the WIP Repair Job Number, and click the Continue button.

Enter the completed quantity and the completion subinventory if you did not enter
this information previously.

If the items are Locator, Serial, or Lot controlled, and you entered such information
previously, enter these values.

Click Done to perform the completion transaction and return to the Depot Repair
Navigator window.

WIP Jobs and Schedules Window

1.

Navigate to WIP > Discrete > WIP Value Summary.
The WIP Jobs and Schedules window opens.

Enter the WIP Repair Job Number, and click Find.

The WIP Jobs and Schedules window opens.
Enter the From Period and To Period information.

Click Value Summary.

The WIP Value Summary window opens.

Create and Process Repair Tasks

Note: In Task mode, Oracle Depot Repair provides E-records and
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E-signature (ERES) functionality via the Debrief screen for each Task.

Tasks consist of work assignments that detail the actions required of company
personnel.

The Repair Tasks tab in the Depot Repair Workbench provides a solution for repair
establishments that use simple, standard business processes without requirements for
WIP-based processes. The Tasks module is accessed (Repair Tasks tab is enabled or
disabled) depending on the Repair Type selected in the Depot Repair Workbench
Details tab.

In the Repair Tasks tab, you can create, update, assign, and view previous tasks
assigned to a Repair Order. Tasks assigned previously appear in the table in the upper
part of the tab, while details of the selected task appear in the fields below it. You can
create a task directly from the Repair Tasks tab by entering all the relevant information,
or by using a template.

Using Quality Collection Plans with Tasks

You can assign Oracle Quality collection plans to tasks, through setups to be performed
in Oracle Quality.

For general information about collection plans, see the Oracle Quality User's Guide.

Tip: When creating the collection plan, copy the elements from the
Template Depot Repair Task Plan as a starting point.

To link a collection plan with a task, you must select Depot Repair Task Transaction as a
Quality Collection Transaction. You may choose to make this transaction mandatory:
this will require Oracle Depot Repair users to enter quality results before they close the
task.

You can also set up one or more collection triggers to specify conditions under which
the collection plan is to be assigned to tasks.

In Oracle Depot Repair, you must enter the quality results for mandatory plans. For
details, see Enter and Update Task Details, page 4-96.

Repair Task Debrief

On the Repair Tasks tab, you can click the Debrief button to display Material, Labor,
and Expense forms. You can debrief a job with actual Material, Labor, and Expense
repair charges.

For repair jobs that you have managed using Tasks, the Debrief provides the actual
charges incurred during the repair that would be invoiced to a customer. If both
estimate and debrief exists for a repair that you have managed using Tasks, the
customer is invoiced based on charges that appear in the debrief.
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The topics in this section include the following;:

® Create a Repair Task Manually, page 4-92
* Create a Repair Task Using the Task Template, page 4-94
* Enter and Update Task Details, page 4-96

® Prepare the Repair Tasks Debrief, page 4-98

Create a Repair Task Manually

The following procedures describe how to create a repair task manually.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

You must complete all steps in the relevant business scenario prior to creating the repair
tasks for the Repair Order. For more information, see Oracle Depot Repair Business
Scenarios.

Navigation
Depot Repair > Repair Orders

Steps

1. Retrieve the Repair Order for which you want to create repair tasks.
For more information, see Find Service Requests and Repair Orders, page 4-32.

2. Select the relevant record from the Results area of the Find Repair Orders window,
and click OK.
The Depot Repair Workbench shows the selected Service Request and Repair Order
details.

3. In the Depot Repair Workbench, click the Repair Tasks tab.

If tasks have already been defined for the Repair Order, the table lists the tasks. If
more than one task appears, selecting a different task displays the corresponding
detail in the lower fields on the tab.
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Enter the task information in the required fields by selecting from the list of values.
For field descriptions, see The Repair Tasks Tab, page 2-35.

Enter the values in the Assignee and Owner fields (or change them) by selecting
from the list of values.

You can also change the Assignee field values from the Assignment Manager. To
access the Assignment Manager, click the Assignment Manager button next to the
fields. For additional information about the Assignment Manager, see Oracle
Common Application Components User’s Guide.

Choose the Planned Start and End Dates.

Click the Save icon to save the task record.
A system-generated Task Number populates the Num field.
Optionally, you can click Add Tasks from Diagnostics. This adds tasks from task

template groups associated with the service codes marked as applicable in the
Diagnostics tab.

To manually launch workflow, select the task from the table, and click Launch
Workflow.

Based on the task, the workflow runs. The designated resources are reserved, and
the workflow notifies the task owner of task creation through email.
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Note: The Launch Workflow button is available only if resources
have been assigned to the selected task.

10. To add or update task details, click More.
The Task Details window opens.

For more information, see Enter and Update Task Details, page 4-96.

Create a Repair Task Using a Task Template

The following procedures describe how to create a repair task using a Task Template.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

You must complete all steps in the relevant business scenario prior to creating the repair
tasks for the Repair Order. For more information, see Oracle Depot Repair Business
Scenarios..

Before you create a task from a Task Template, a template design must exist.

Navigation
Depot Repair > Repair Orders

Steps

1. Retrieve the Repair Order for which you want to create repair tasks.

For more information, see Find Service Requests and Repair Orders, page 4-32.

2. Select the relevant record from the Results area of the Find Repair Orders window,
and click OK.

The Depot Repair Workbench shows the selected Service Request and Repair Order
details.

3. In the Depot Repair Workbench, select the Repair Tasks tab.

If tasks have already been defined for the Repair Order, the table lists the tasks. If
more than one task appears, selecting a different task displays the corresponding
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detail in the lower fields on the tab.

On the Repair Tasks tab, click Use Template.

The Create Tasks from Template Group window opens.

In the Template Group field, select the Template Group based on the task which is
to be created.

Values in the Source Document, Source Name, Owner Type and Owner fields are
default values. You can change these values.
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Click Create Tasks.

The Repair Tasks tab opens and displays a new task line that shows a
system-generated Task Number in the Num field.

To manually launch workflow, click Launch Workflow.

Based on the task, the workflow runs. The designated resources are reserved, and
the workflow notifies the task owner of task creation through email.

Note: The Launch Workflow button is available only if a resource
has been assigned to a selected task.

Click More to open the Task Details window to enter details such as resource
assignments, dependencies, references, and contacts.
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For more information, see Enter and Update Task Details, page 4-96.

Enter and Update Task Details

Module

Responsibility

Prerequisites

Navigation

Steps

After a task record is created, you can update task information and task details. The
following procedures describe how to update task information and to add task details.

Oracle Applications Navigator

Depot Repair Super User

Task records that you want to update or add details to must exist in the database.

Depot Repair > Repair Orders

Retrieve the Repair Order for which you want to update task details.
For more information, see Find Service Requests and Repair Orders, page 4-32.

Select the relevant record from the Results area of the Find Repair Orders window,
and click OK.

The Depot Repair Workbench shows the selected Service Request and Repair Order
details.
In the Depot Repair Workbench, select the Repair Tasks tab.

If tasks have already been defined for the Repair Order, the table lists the tasks. If
more than one task appears, selecting a different task displays the corresponding
detail in the lower section of the window.

To update task information, make the necessary changes to the field values, and
click the Save icon.

For field descriptions, see the Repair Tasks Tab, page 2-35 topic.
Entering Quality Results

If your task has any mandatory collection plans associated with it, you will not be
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able to set the task Status to Closed unless you first enter quality results for the task.

To do this, either click the Enter Quality Results icon in the toolbar, or select Tools >
Enter Quality Results; then enter the information required.

Specifying Task Details

To specify task details, select the task for which you want to update details, and
click More.

The Task Details window opens. The Task Details window comprises the following
tabs:

Resources: Assign personnel information to a task. This tab defines resource
requirements, assignments, and scheduling information.

Dependencies: Determine the order of tasks. Oracle Depot Repair, however,
does not enforce task dependencies.

References: Link the task to different documents or tasks with pertinent
background information.

Dates: Identify more dates in addition to the planned dates, the scheduled
dates, and the actual dates. You can track task progress by entering dates after
task milestones such as task creation, resource reservation, or task completion.

Contacts: Create and manage multiple contacts assigned to a task. Contact
information is obtained from customer information. To enter this information,
you must identify a customer in the main task window.

Recurrences: Schedule tasks so as to occur automatically. Examples of intervals
include daily, weekly, monthly, or yearly occurrences. To schedule recurring
tasks, you must either specify a start date and the number of tasks to create, or
the end date. The task dates are populated as the planned start and end dates.

Others: Identify additional information about the task, and select different
configurations for each task. Setting flags customizes each task according to
business needs.

Audit: Track each update to a task. The tab documents and dates the history of

task change, and provides a trail from the original task through to the current
task status.
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8. Enter the field values on the different tabs as required.

For detailed instructions, refer to the Task Manager topic in Oracle Common
Application Components User’s Guide.

9. Click OK to save your work and return to the Repair Tasks tab in the Depot Repair
Workbench.

Prepare the Repair Tasks Debrief

On the Repair Tasks tab, you can click the Debrief button to display the Debrief Report,
with Material, Labor, and Expense tabs. You can debrief a job with actual Material,
Labor, and Expense repair charges.

For repair jobs that you have managed using Tasks, the Debrief provides the actual
charges incurred during the repair that would be invoiced to a customer. If both
estimate and debrief exists for a repair that you have managed using Tasks, the
customer is invoiced based on charges that appear in the debrief.

Note: The Debrief Report form does not let you apply contracts per
charge line. If you are using the Debrief Report form to generate
charges, the system automatically applies the contract at the Service
Request level to the charge line.

The following procedures describe how to create the Debrief. This procedure is
applicable only to repair processes that you have managed by using Tasks.
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Module

Responsibility

Prerequisites

Navigation

Steps

Oracle Applications Navigator

Depot Repair Super User

You must complete all steps in the relevant business scenario prior to creating the repair
tasks for the Repair Order. For more information, see Oracle Depot Repair Business
Scenarios..

Depot Repair > Repair Orders

1. Retrieve the Repair Order for which you want to update task details.
For more information, see Find Service Requests and Repair Orders, page 4-32.

2. Select the relevant record from the Results area of the Find Repair Orders window,
and click OK.
The Depot Repair Workbench shows the selected Service Request and Repair Order
details.

3. In the Depot Repair Workbench, select the Repair Tasks tab.

If tasks have already been defined for the Repair Order, the table lists the tasks. If
more than one task appears, selecting a different task displays the corresponding
detail in the lower section of the window.

4. Select the task for which you want to create the report, and click Debrief.

The Debrief Report window shows the selected task details populated in the fields
at the upper part of the window. The lower half of the window comprises the
Material, Expense, and Labor tabs.
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5. Select the Material tab to enter required details of material transactions of the repair
task.

6. Select the Expense tab to enter required details of other expenses of the repair task.
7. Select the Labor tab to enter required labor transaction details of the repair task.

8. Click Update to save the details.

For detailed instructions and discussion on buttons and check boxes accessible from
the Debrief Report window, refer to Oracle Field Service User Guide.

View Activities Related to a Repair Order

The Activity window displays a real-time view of events and activities that surround a
Repair Order. This permits the depot agents and planners to know the exact status of
each Repair Order line.

The following procedures describe how to view the activities that have elapsed at the
depot in association with a Repair Order.

Module

Oracle Applications Navigator

Responsibility
Depot Repair Super User
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Prerequisites

None

Navigation
Depot Repair > Repair Orders

Steps:

1. Retrieve the Repair Order for which you want to view the elapsed depot activities.

For more information, see Find Service Requests and Repair Orders, page 4-32.

2. Select the relevant result from the Results area of the Find Repair Orders window,
and click OK.

The Depot Repair Workbench shows the selected Service Request and Repair Order
details.

3. From the top menu, select Data > Activity.

The Activity window displays the quantity received, quantity submitted to WIP,
quantity completed in WIP, and quantity shipped. It also displays individual
events, event dates, quantity, and other details. For detailed field descriptions, see
Activity Tab, page 2-48.

Note: The fields, Quantity Submitted to WIP and Quantity
Completed in WIP, appear only for repairs processed in WIP mode.
However, when quantities are submitted in WIP mode across
Repair Orders, these Quantity fields do not contain valid values.

Details

Job Name: CSD10912, Oty Created: 1

][I]S-MAR-ZI]M 09:19:55 Job Name: CSD10912, Job Qty Submitted: 1, Group ID: 48410, Concurrent Request Num
|05.MAR2004 09:19:47  |Job Name: CSD10911, Oty Created: 1

][[IS-MAR-Z[I[M 09:19:16 Joh Name: CSD10911, Job Qty Submitted: 1, Group ID: 48409, Concurrent Request Num
][[Iﬁ—MARZ[I[M 09:18:40 Joh Name: CSD10908, Qty Created: 1
][IJS—MARQIJIM 09:18:40 Job Name: CSD10909, Oty Created: 1
05-MAR-2004 09:18:40 Job Name: CSD10910, Oty Created: 1

4. If the Activity window does not display the updated information that you expect,
you may need to run the appropriate information update program:

* Click the Logistics tab, then click Refresh Logistics.
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®  (lick the Repair Jobs tab, then click Refresh Job.

Note: The programs triggered by the Refresh Logistics and Refresh
Job buttons update the activity information only for the Repair
Order currently selected in the Depot Repair Workbench.

For more information, see Update Repair Orders Concurrently, page 4-102.

Update Repair Orders Concurrently

The following concurrent programs update all the open Repair Orders at the same time:

*  Depot Repair Job (WIP) Update
® Depot Repair Receipt Update
* Depot Repair Shipment Update

To access these programs, from the Depot Repair Navigator, navigate to:
Depot Repair > Other > Run Requests.

The Submit a New Request window opens. In the Submit a New Request window, you
can choose to submit a single request. When you submit a single request, the Submit
Request window opens. In the Name field, select the program that you want to run.
Choices include Depot Repair Receipt Update, Depot Repair Job (WIP) Update, or
Depot Repair Shipment Update. You also specify to update quantity received, quantity
submitted to or completed in WIP, and quantity shipped respectively, for all open
Repair Orders.

In the remaining fields, you can schedule the program to run at times or intervals of
your choice, choose whom to notify on completion, and choose whether to print or save
the reports. For more information, refer to the online help available from these
windows.

The Depot Repair Receipt Update concurrent program picks only the receiving lines
that are delivered to a subinventory. This is to support business scenarios that involve
quantity correction of goods received at the dock.

For example, during the inspection of goods received at a dock, you can correct or
return some quantity of the goods delivered. This could be because not as many items
were sent as the customer said they would, or the customer returned more than
expected, such as, goods that were too damaged to qualify for a refund, or goods that
your organization did not sell. Items are not considered as received until they pass the
inspection, and are delivered to a subinventory. Only at this point does the Depot
Repair Receipt Update concurrent program stamp the received quantity and show the
change in the received quantity.
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Send and View Workflow-Based Messages

At a high level, the Workflow-based Messaging functionality provides the ability to
send a workflow notification message, and have that message link to the Repair Order
selected in the Depot Repair Workbench at the time the message was sent. Messages can
be of various types, from information-only to those that request actions or approvals
from others. When the message recipient responds to the message linked to the
specified Repair Order, that response is captured in the Repair Order's message history.
A message can be sent to one or many recipients, and can be sent to group lists.
Messages sent to multiple recipients can only be informational messages.

In Oracle Depot Repair, messages are tied to a Repair Order, and are sent from the
Repair Orders form.

It LT 42670

15 ¥

CSDK-001

: —
ST 415 509.76( GEN MEHil |

Details

roval Required
Enter and Book EhA

Repair Num 12515

ltem |CSDK-001
Revision

Instance 85247
Serial Num | EH101

e G |

]

( “iew B Config... I [ Update Counters.. ] [ Update RO Status... )

Lot Mum

Installed Site | 102 WILLOW

(W)

Default PO Nurn |

For more information on message types, sending, receiving, and viewing messages, and
user procedures, see the Oracle TeleService User Guide and Oracle TeleService
Implementation Guide.

Create a Ship Line Manually

The following procedures describe how to create a Ship line manually.

Module

Oracle Applications Navigator
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Responsibility

Depot Repair Super User

Prerequisites

You must complete all steps in the relevant business scenario prior to creating a ship
line manually. For more information, see Oracle Depot Repair Business Scenarios..

Navigation

Depot Repair > Repair Orders

Steps:

1.

Retrieve the Repair Order for which you want to create the Ship line manually.

For more information, see Find Service Requests and Repair Orders, page 4-32.

Select the relevant result from the Results area of the Find Repair Orders window,
and click OK.

The Depot Repair Workbench shows the selected Service Request and Repair Order
details.
Select the Logistics tab in the Depot Repair Workbench.

In the Action Type field, select Ship.

Select the fields for the Ship line.

The main fields that you must select are Action Code, Service Activity, and Price
List.

Note also the Add to Order field. Oracle Depot Repair lets you place all Return
(RMA) and Ship lines on the same order.

By default, all Return (RMA) and Ship lines appear on the next-highest Order
Number created when the lines are transferred to Order Management.

You can also select the specific order for the Return (RMA) or Ship line by selecting
the Order Number in the Add to Order field before interfacing the specified line to
Order Management.

For field descriptions, see Logistics Tab, page 2-12.

Click the Save icon on the toolbar to save the record.

The Ship line is created with the Status of Entered.
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Ship a General ltem

The term "general item” indicates an item that is not being refurbished.

Depending on the business scenario, an item being shipped might be repaired.
Shipments can include repaired, replacement, loaner, or exchange items.

If you do not select a subinventory for the item, the subinventory is derived from the
picking rule defined in the profile option CSD: Default Pick Release Rule for Sales
Orders.

The Ship line that corresponds to the shipment goes through several stages of
processing, and at each stage the Status is updated. The Status values that it passes
through are Entered, Submitted, Booked, Released, and Shipped.

You may go through each processing stage one stage at a time, or process several stages
in sequence automatically.

Enter Order (Submit to Oracle Order Management)

Book Order

Pick Release

After a Ship line is created, its first Status is Entered.

When you submit the line to Oracle Order Management, and it is successfully
interfaced, it gets an Order Number returned from Oracle Order Management, and its
Status changes to Submitted.

After the Ship line has been interfaced with Oracle Order Management, it cannot be
deleted.

In this stage, the line must be booked in Oracle Order Management. The main effect of
this in Oracle Depot Repair is that the Status of the line changes to Booked.

During the Pick Release processing, the application reserves the exact items to ship.
The Status of the Ship line at the end of the Pick Release stage changes to Released.

[For serialized items whose Serial Control is either Predefined or At Receipt, you are
required to perform the Pick Release processing twice:

* The first time, you must enter the Serial Number in a separate Oracle Inventory
window, but the Status of the Ship line remains as Booked.

® The second time, you automatically upgrade the Ship line Status to Released.]
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Ship Confirm

At the end of the Ship Confirm stage, the item has been shipped and the Status of the
line changes to Shipped.

Automatic Processing of a Ship Line
The standard way to process a Ship line for a general item is as follows:

1. Decide the stage you want to reach.
2. Click the Automate Order Processing steps through check box.

3. Select the radio button which corresponds to the stage you want to reach:

e Enter Order
e  Book Order
e Pick Release

e Ship Confirm

4. Click Process.

Note: You can optionally process the last stage, that is, with the
Ship line in the Released status, by clicking the Ship button, and
then entering data in Oracle Shipping Execution windows. For
details of these windows, see the Oracle Shipping Execution User’s
Guide.

Module

Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

You must complete all steps in the relevant business scenario prior to shipping the
general item. For more information, see Oracle Depot Repair Business Scenarios.
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Navigation

Depot Repair > Repair Orders

Steps:

1.

Retrieve the Repair Order for the item that you want to ship.

For more information, see Find Service Requests and Repair Orders, page 4-32.

Select the relevant order from the Results area of the Find Repair Orders window,
and click OK.

The Depot Repair Workbench shows the selected Service Request and Repair Order
details.

Select the Logistics tab of the Depot Repair Workbench.

Click any field of the Ship line to make that line current.

Click the Process Trans check box.

Select the Automate Order Processing Steps Through check box.

Select one of the following radio buttons:

e Enter Order
e  Book Order
e DPick Release

e Ship Confirm

For the special case where you have chosen Ship Confirm, for a serialized item
whose Serial Control is At Sales Order Issue, enter the Source Serial Number.
Click Process.

Depending on how many stages you have chosen to perform, a variety of
procedures are performed.

In all cases, acknowledge the message in any message window that appears.
Enter Order

If, at step 7, you chose Enter Order, the Status changes to Submitted.

Book Order

If, at step 7, you chose Book Order, the Status changes to Booked.
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Pick Release
If, at step 7, you chose Pick Release, the Status generally changes to Released.
Pick Release for Items with Serial Control Predefined or At Receipt

For a serialized item that has Serial Control which is either Predefined or At
Receipt, the resulting Status depends on whether you are performing the Pick
Release processing for the first time or the second time.

1. The first time, you must enter a Serial Number, navigating through the Find
Move Order Lines window that appears automatically, to the Transact Move
Orders window.

For details of the Find Move Order Lines window and the Transact Move
Orders window, see the Oracle Inventory User’s Guide.

When you return from the Transact Move Orders window, the Status of the
Ship line remains as Booked.

Repeat the Pick Release processing (steps 5 through 9).

2. The second time you perform the Pick Release process, you do not have to enter
any further data, and the Status changes to Released.

10. To see the Serial Number that you entered during the first-time Pick Release
processing in the (Source) Serial Num field on the Logistics tab, click Refresh
Logistics, after you complete the second-time Pick Release process.

11. To check if there has been a mismatch between the Serial Number in the Ship line
and the Serial Number you entered in the Transact Move Orders window, select
Data > Activity to display the Activity window. If a mismatch occurred, an alert
message in the Activity window records the two Serial Numbers.

When the Status of the Ship line is Released, the Pick Release stage is complete.
Ship Confirm

When processing the Ship Confirm stage, you should wait until the concurrent
program Interface Trip Stop has completed successfully before you click Refresh
Logistics, to see the changed value of the Status.

12. You can monitor the progress of the program by selecting Requests from the View
menu on the toolbar, and selecting appropriate search criteria.
13. Click Refresh Logistics.

The purpose of this is to update the Status on the Ship line, so that it reflects in
Oracle Depot Repair the results of the procedures executed in other Oracle
applications when you clicked Process.

If, at step 7, you chose Ship Confirm, and the background concurrent process
Interface Trip Stop completes successfully, the Status changes to Shipped.
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14.  When the transaction is completed, you can optionally view the shipping
information in the Activity window, by selecting Data > Activity from the top
menu.

Ship a Refurbished Item

In Oracle Depot Repair, after a refurbished item has been received from the Spares
Management warehouse and repaired, it is ready to be shipped back to Spares
Management.

Note: Spares Management is a module of Oracle Field Service.

If you do not select a subinventory for the item, the subinventory is derived from the
picking rule defined in the profile option CSD: Default Pick Release Rule for Sales
Orders.

You must process the item through the Pick Release and a Ship stages. These stages are
similar to the Pick Release and Ship Confirm stages for shipping a general item.

Where both options are allowed (that is, where the equivalent radio buttons are both
enabled), you can either perform the two stages one at a time, or process both stages in
sequence automatically.

For serialized items whose Serial Control is either Predefined or At Receipt, you are
required to perform the Pick Release processing twice, as for general items. For more
information, see Ship a General Item, page 4-105.

Manual Ship Processing for Items with Serial Control At Sales Order Issue

Module

The only difference in the processing of a refurbishment item and a general item occurs
in the final, Ship stage, and then only for the case of a serialized refurbished item,
whose Serial Control is At Sales Order Issue.

To ship this type of item, you must use the manual method of clicking Ship and
entering the Serial Number using Oracle Shipping Execution windows; you cannot use
the automatic method of choosing Ship Confirm and clicking Process.

Note: You must also use the manual method for partial shipments.

The following procedures describe the Move Out transaction, that processes the
shipment of the refurbished item back to Spares Management.

Oracle Applications Navigator
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Responsibility
Depot Repair Super User

Prerequisites

The Service Request and the associated refurbishment Repair Order or orders must
have been created in the Spares Management module of Oracle Field Service.

The item must have been received and repaired.

Navigation
Depot Repair > Repair Orders

Steps:
1. Retrieve the Repair Order for which you want to ship the refurbished item.

For more information, see Find Service Requests and Repair Orders, page 4-32.

2. Select the relevant result from the Results area of the Find Repair Orders window,
and click OK.

3. Click the Logistics tab.

4. Click any field of the Move Out line to make that line current.
The Status of the Move Out line should be Booked.

Note: The following description assumes that you select the
automatic Pick Release option when processing the Move Out line.

Even if you select Ship Confirm as your first choice for processing
the Move Out line, the application automatically processes the Pick
Release stage first, then the Ship Confirm stage.
Pick Release
5. Click the Process Trans check box for the Move Out line.
6. Click the Automate order processing steps through check box.

7. Select the Pick Release radio button.

8. Click Process.

The Status of the Move Out line generally changes to Released.
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10.

11.

12,

13.

14,

15.

Pick Release for Items with Serial Control Predefined or At Receipt

For a serialized item that has Serial Control which is either Predefined or At
Receipt, the resulting Status depends on whether you are performing the Pick
Release processing for the first time or the second time.

1. The first time, you must enter a Serial Number, navigating through the Find
Move Order Lines window that appears automatically, to the Transact Move
Orders window.

For details of the Find Move Order Lines window and the Transact Move
Orders window, see the Oracle Inventory User’s Guide.

When you return from the Transact Move Orders window, the Status of the

Move Out line remains as Booked.

2. The second time you perform the Pick Release process (steps 5 through 8), you
do not have to enter any further data, and the Status changes to Released.

To see the Serial Number that you entered during the first-time Pick Release
processing in the (Source) Serial Num field on the Logistics tab, click Refresh
Logistics, after you complete the second-time Pick Release process.

To check if there has been a mismatch between the Serial Number in the Move Out
line and the Serial Number you entered in the Transact Move Orders window,
select Data > Activity to display the Activity window. If a mismatch occurred, an
alert message in the Activity window records the two Serial Numbers.

When the Status of the Move Out line is Released, the Pick Release stage is
complete.

Manual Ship or Ship Confirm

For the case of a serialized refurbished item, whose Serial Control is At Sales Order
Issue, or for partial shipments, the Ship Confirm button is disabled. In these
situations, click Ship and enter the item's Serial Number in Oracle Shipping
Execution windows. For details of these windows, see the Oracle Shipping Execution
User’s Guide.

When you return to the Logistics tab, click Refresh Logistics. The Status changes to
Shipped.

This completes the manual ship processing for these special Move Out lines.
For all other cases, click the Process Trans check box for the Move Out line.
Click the Automate order processing steps through check box.

Select the Ship Confirm radio button.

Click Process.
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When processing the Ship Confirm stage, you should wait until the concurrent
program Interface Trip Stop has completed successfully before you click Refresh
Logistics, to see the changed value of the Status.

You can monitor the progress of the program by selecting Requests from the View
menu on the toolbar, and selecting appropriate search criteria.

16. Click Refresh Logistics.

The purpose of this is to update the Status on the Move Out line, so that it reflects in
Oracle Depot Repair the results of the procedures executed in other Oracle
applications when you clicked Process.

After the background concurrent process Interface Trip Stop has completed
successfully, the Status changes to Shipped.

17. Optionally, from the top menu, select Data > Activity to see the details of the Move
Out transaction in the Activity window.

Record Billing Data in Repair Actuals

When you have completed the repair and have determined the final billing for
materials, labor, and expenses that you want to bill your customer, you need to put the
billing amounts in Repair Actuals. Sources of billing amounts in Repair Actuals can
include the estimate, WIP Summary, Task Debrief, or manual entries.

Note: For WIP mode jobs, although it is not prohibited to create actuals
from both WIP and Estimate sources, generally you will copy in from
either WIP or Estimate sources.

Similarly, for Task mode jobs, although you can copy in lines from both
Task and Estimate sources, generally you will copy in from either Task
or Estimate sources.

When you record the billing entries in Repair Actuals, the system creates charge lines in
the Repair Actuals area. In turn, the system can transfer the billing data to other
modules for invoicing.

Note: The Debrief Report form does not let you apply contracts per
charge line. If you are using Debrief Report form to generate charges,
the system automatically applies the contract at the Service Request
level to the charge line.

Topics that guide you through adding data into your Repair Actuals tab include:
¢ Add WIP Summary to Repair Actuals, page 4-113
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Add Task Debrief to Repair Actuals, page 4-116

Add Estimate to Repair Actuals, page 4-117

Create Manual Charges in Repair Actuals, page 4-118

See Also

Book Repair Actuals, page 4-119

Detailz T Logistice I Diagnostics IRepa\rEstlmateI Repair Jobs T Repair Tagks T Repair Actuals —
Summary of Actual Charges
Material 495.00 Labor 225.00 Expense ‘ .00 Total | 720.00 Currency |(US dollar
Select Override Mo
‘ Source  Order Eilling Serial FO Contract  Price Unit Charge Charge
Type Mumber  Category  Rem Murm Mumber  Mumber  List City IO Price  Charge | |
| =T 57263 [material [csDK002| [ [15649  |corporate 1|Each | zo000| 3000 — ¢ =
T [Estimate [57283  [Labor  [Labor | [ [15649  [comorate 3Hour | 7400 22800 T ¢
[ |Manual [57283  [Material |Material | [ [15649  |corporate 2|Dollars | 75.00| 13500 [
r | | | \ | | \ | | | -t
Select All Unselect Al Enaok Selected Line Details ] Source |Estimate Add )

Add WIP Summary to Repair Actuals

If your Repair Order is in WIP mode, you can add the WIP Summary as a source for
your Repair Actuals.

When you add from the WIP Summary to your Repair Actuals, the system adds all
material, labor, and expense lines from the WIP Summary into the Repair Actuals.

Generally, when adding in lines from WIP Repair Jobs:

e Material Transactions are added as Material lines.

e Resources Transactions are added as Labor lines.

Note: Before you can add WIP Summary data into the Repair
Actuals, you must define a billing inventory item for all the BOM
Resources that are associated with a WIP Repair Job. This
requirement lets Depot Repair add the WIP Summary lines into
Repair Actuals as material, labor, and expense items. For more
information, see the Oracle Depot Repair Implementation Guide.

After you add WIP Summary lines into the Repair Actuals, you can:

e View the WIP Job Name in the Source column of the Repair Actuals tab to see the
source of the added lines.
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* Update the WIP Summary-sourced lines in Repair Actuals but not delete them. The
updates you can perform are limited: under profile option control, you can either
set No Charge for a charge line or you can override the charge.

Note: If you manually override the charge, then discounts
associated with the contract are not applied.

* View each line's details to let you view more information about the line, indicate
whether or not to override charges, or indicate to make no changes.

Important: After you have imported at least one line from a WIP
Repair Job into the Repair Actuals, you cannot import any
additional lines from that job.

Additionally, lines will not be imported from WIP Repair Jobs
shared across Repair Orders.

® Manually create additional charge lines. You can manually create charge lines
before and after you add lines from the WIP Summary.

Upon importing the WIP Summary lines to the Repair Actuals, the system creates
charge lines for each line.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

You must be processing a Repair Order.

Navigation
Repair Actuals tab

Steps
1. In the Source field, click the right-hand end of the field, then click the ellipsis (...)
button.

A window opens and displays the possible sources from which you can add data to
Repair Actuals.
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View Line Details

See Also

For a WIP mode repair, the options are WIP and Estimate.

For a Task mode repair, the options are Task and Estimate.
2. Select a Source and click OK.

3. Click Add.

The system automatically populates rows and fields on the Repair Actuals tab from
the source that you selected. An information window appears which records any
errors and information about the lines added

The Source field shows the Source Name. You should review each line on the
Repair Actuals tab to:

® Determine if any lines require overrides.
® Determine if any lines should be at no charge.

4. (Not available for lines imported from Task Debrief.)

If the profile option CSD: Allow Charge Override for Actuals is set to Yes, you
override an amount on a line, as follows:

1. Select Override Charge.
2. Inthe Charge column, enter a new amount.
5. (Not available for lines imported from Task Debrief.)
To change a line to No Charge, select the No Charge check box.

6. Click Save to record the changes.

On the Repair Actuals tab, you can view additional information about a charge line's
details. Additional details include costing and charge information. You can access a
charge line's details by selecting a charge line and clicking the Line Details button. An
expanded window shows the detailed information.

¢ Record Billing Data in Repair Actuals, page 4-112
¢ Add Task Debrief to Repair Actuals, page 4-116
* Add Estimate to Repair Actuals, page 4-117

® Create Manual Entries in Repair Actuals, page 4-118
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® Book Repair Actuals, page 4-119

Add Task Debrief to Repair Actuals

If your Repair Order is in Task mode, you can import the Task Debrief as a source for
your Repair Actuals.

When you import from the Task Debrief to your Repair Actuals, the system imports all
material, labor, and expense lines from the Task Debrief into the Repair Actuals.

Note: The Debrief Report form does not let you apply contracts per
charge line. If you are using the Debrief Report form to generate
charges, the system automatically applies the contract at the Service
Request level to the charge line.

After you import Task Debrief lines into the Repair Actuals, you can:

* View the Task Number in the Source column of the Repair Actuals tab to see the
source of the imported line.

e Add additional Task Debrief lines to the Repair Actuals.

* Manually create additional charge lines. You can manually create charge lines
before and after you add lines from the Task Debrief.

Upon importing the Task Debrief lines to the Repair Actuals, the system creates charge
lines for each line.

Note: You cannot update lines whose Source is Task.

For procedural information on how to add Task Debrief data to the Repair Actuals, see
the Steps in the topic Add WIP Summary to Repair Actuals, page 4-114.

See Also
® Record Billing Data in Repair Actuals, page 4-112

e Add WIP Summary to Repair Actuals, page 4-113
¢ Add Estimate to Repair Actuals, page 4-117
¢ (Create Manual Entries in Repair Actuals, page 4-118

® Book Repair Actuals, page 4-119
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Add Estimate to Repair Actuals

If your repair includes an estimate, you can use the Repair Estimate as a source for your
Repair Actuals.

When you import from the Repair Estimate to your Repair Actuals, the system imports
all lines from the Repair Estimate into the Repair Actuals.

After you import Repair Estimate lines into the Repair Actuals, you can:

¢ Update, add, or delete the Repair Estimate-sourced lines in Repair Actuals.

* View each line's details to let you view more information about the line, indicate
whether or not to override charges, or indicate to make no changes.

* Manually create additional charge lines. You can manually create charge lines
before and after you add lines from the Estimate.

Note: If you manually override the charge, then discounts
associated with the contract are not applied.

Upon importing the Repair Estimate lines to the Repair Actuals, the system creates a
charge line for each estimate line.

Note: After you have imported any estimate lines into Repair Actuals,
any changes made to those source estimate lines are not automatically
forwarded to the corresponding Repair Actuals lines. To take
advantage of the new estimate changes, you must delete the
corresponding Repair Actuals lines, and then re-import the changed
source estimate lines.

For procedural information on how to add Estimate data to the Repair Actuals, see the
Steps in the topic Add WIP Summary to Repair Actuals, page 4-114.

See Also
¢ Record Billing Data in Repair Actuals, page 4-112

¢ Add WIP Summary to Repair Actuals, page 4-113
¢ Add Task Debrief to Repair Actuals, page 4-116
* Create Manual Entries in Repair Actuals, page 4-118

* Book Repair Actuals, page 4-119
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Create Manual Charges in Repair Actuals

In addition to adding billing data from other sources--such as the WIP Summary, Task
Debrief, or Estimate--you can:

¢ Manually create entries in Repair Actuals.

* Update or delete the manual charge lines in Repair Actuals.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

You must be processing a Repair Order.

Navigation
Repair Actuals tab

Steps

1. To manually create a new charge line on the Repair Actuals line, select the new row
on which you are adding a charge line.

The Source Type field automatically indicates Manual.

2. Enter or select the Billing Category, Item, Price List, Qty, UOM, Pricing Attributes
fields, and optionally, the PO Num field.

3. Optionally, complete the Contract Number field.

4. If the profile option CSD: Allow Charge Override for Actuals is set to Yes, you
override an amount on one line, as follows:

1. Select Override Charge.

2. In the Charge column, enter a new amount.

Note: If you manually override the charge, then discounts
associated with the contract are not applied.
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5. To change a line to No Charge, select the No Charge check box.

6. Click Save to record the changes.

See Also
* Record Billing Data in Repair Actuals, page 4-112

¢ Add WIP Summary to Repair Actuals, page 4-113
¢ Add Task Debrief to Repair Actuals, page 4-116
¢ Add Estimate to Repair Actuals, page 4-117

® Book Repair Actuals, page 4-119

Book Repair Actuals

After you have recorded your billing data in Repair Actuals, from one or more sources,
and possibly entered charge lines manually in Repair Actuals, you can book selected
charge lines.

The following procedures describe how to book selected Repair Actuals charge lines.

Module

Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

You must be processing a Repair Order.

You must have charge lines in Repair Actuals, either manually entered or added in
from a Source of Estimate, WIP, or Task.

Navigation
Repair Actuals tab

Steps:

1. Select either individual charge lines or click Select All if you want to book all the
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charge lines in the Repair Actuals tab.

2. Click Book Selected.

Comments:

For lines whose Source is Task, the items used in the Debrief Report decrement
inventory only after the Field Service concurrent program CSF: Update Debrief Lines is
submitted. This concurrent program updates the Quantity On Hand (QOH) in the
inventory.

Invoice a Customer

Note: Tax, Shipping, and Freight charges are not calculated within
Oracle Depot Repair, but are calculated in Order Management when
orders transfer to Order Management. For this reason, the charge totals
in the estimate lines and lines from Task Debrief may be different from
the value charged on the invoice.

The following procedures describe how to invoice a customer.

Module

Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites

You must complete all steps in the relevant business scenario prior to invoicing the
customer. For more information, see Oracle Depot Repair Business Scenarios..

Navigation

Accounts Receivable

Steps:

1. Invoice the customer by using normal business procedures.

For more information, see the Oracle Receivables User Guide.
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Close a Repair Order

The following tasks describe how to close a Repair Order.

Module

Oracle Applications Navigator

Responsibility

Depot Repair Super User

Prerequisites

You must complete all steps in the relevant business scenario prior to closing the Repair

Order. For more information, see Oracle Depot Repair Business Scenarios..

Navigation

Depot Repair > Repair Orders

Steps:

1.

Retrieve the Repair Order for the item that you want to ship.

For more information, see Find Service Requests and Repair Orders, page 4-32.

Select the relevant result from the Results area of the Find Repair Orders window,
and click OK.

The Depot Repair Workbench shows the selected Service Request and Repair Order
details.

Confirm that the quantity on the Repair Order is complete.

Consult or create notes if necessary.

For detailed instructions, see Create and Maintain Notes, page 4-37.

In the Details tab of the Depot Repair Workbench, click Update Status.

The Update Status window opens. In the Update Status window, you can update
the Repair Order status. The Repair Order can remain Open, be on Hold, or Closed.

Select Close by selecting the option button, and click OK to close the Repair Order
line.

You can select a Reason Code from the list of values, and enter additional details
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7.

supporting the status update.

Click the Save icon on the toolbar to save the record.

Close a Service Request

The following procedures describe how to close a Service Request.

Module

Oracle Applications Navigator

Responsibility

Depot Repair Super User

Prerequisites

You must complete all steps in the relevant business scenario prior to closing the

Service Request. For more information, see Oracle Depot Repair Business Scenarios..

Navigation

Depot Repair > Repair Orders

Steps:

1.

Retrieve the Service Request that you want to close.

For more information, see Find Service Requests and Repair Orders, page 4-32.

Select the relevant result from the Results area of the Find Repair Orders window,
and click OK.

The Depot Repair Workbench shows the selected Service Request and Repair Order
details.

In the Service Request Information area of the Depot Repair Workbench, change the
status of the Service Request to Closed by selecting from the list of values.

Enter the date closed.

If required, create notes stating the reason for the Service Request closure.

For detailed instructions, see Create and Maintain Notes, page 4-37.

Click the Save icon to close the Service Request.
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7. Alternatively, if the Request Num hyperlink is enabled, you can click the Request
Num link to launch the Update Service Request page. You can use this page to
change the service request status and update the SR Resolution Code.

Create and Process an Internal Party Refurbishment

In Oracle Depot Repair, you can create and process items that need to be refurbished
that belong to an internal party. In these cases, the items to be refurbished do not move
from an external location, such as a Spares Management warehouse, they remain in the
internal party location.

Note: Spares Management is a module of Oracle Field Service.

Create the Service Request

You must first create a Service Request, and explicitly choose an internal party for your
customer.

An internal party is defined as a customer set up in at least one of the following ways:
® The customer is the Party Name set up in the Installed Base Install Parameters.

® The customer is set up in Oracle Order Management with a classification type of
Internal.

For more information on setting up internal parties, see the Oracle Depot Repair
Implementation Guide.

Create the Repair Order

When you create the Repair Order, you must select a Repair Type that has been set up
with a Repair Type Ref of Refurbishment, and whose Internal Order check box has not
been set.

For more information on setting up Repair Types, see the Oracle Depot Repair
Implementation Guide.

Process the Repair Order

After the Repair Order has been created, the Logistics, Estimates, and Repair Actuals
tabs are disabled, as is the tools option menu Tools > Coverage.

The main operations that you perform on internal party refurbishment items are repairs
to be carried out through WIP Repair Jobs or Tasks.

The only special considerations that apply to the internal party items to be refurbished
are as follows:
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e For serialized items, that are Installed Base trackable, the lists of values for Serial
Num and Instance show all item instances owned by the internal party, and whose
Oracle Installed Base usage is In-Inventory.

e For serialized items, that are not Installed Base trackable, the lists of values for
Serial Num and Instance show all item instances whose Oracle Installed Base usage
is In-Inventory.

View Repair Orders in Oracle iSupport

Oracle Depot Repair customers can now search for their Repair Orders through a
self-service user interface in Oracle iSupport.

Oracle iSupport authenticates the user and displays only the Repair Orders for accounts
which the user is authorized to view. For each Repair Order, summary and detail
information, including Repair Order status, can be displayed.

The procedure to view Repair Orders in Oracle iSupport is as follows:

1. Login to Oracle iSupport.
2. Click the Accounts tab.

3. Select the Repair Orders menu item.

The Repair Order Summary page appears.

4. Click the Repair Order Number hyperlink for a Repair Order.

The Repair Order Details page appears.
You can also use the Saved Searches function in Oracle iSupport to assist subsequent
searches.

For more information, see the Oracle iSupport User Guide.

Third Party Flows

The repair centers interface with the third parties to execute many of customer's service
requirements. They track the movement of products, work and financial obligation
between all the parties involved in executing a repair.

The functions for managing repair operations across multiple parties consists of the
following:

e Third Party Logistics for Repairs
¢ Invoice Third Party

* Supplier Warranty Claims
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Invoice Third Party

Third Party Logistics for Repairs

Broken products, repaired products, and exchanges are moved and tracked between
service organization, customer, and third parties. The Depot Repair application
supports the following models of third party repair logistics:

Ad hoc Repairs

A repair organization manually creates orders to ship items to a third party or RMA
items back from a third party. Outside processing orders for repair service are
automatically generated from repair jobs.

Cross Dock Repairs

A repair organization sends broken customer product out for third party repair
immediately upon receipt. Depot Repair defaults the appropriate repair vendor and
ship to location based on customer defined disposition rules. Overdue returns
trigger escalation notifications. Third party refurbishment status is tracked via
workflow and/or iSupplierPortal.

Portal Repairs

A repair organization provides a third party repair shop with technician portal
access. The third party views repair orders assigned to them, update status, capture
time and materials, and capture symptoms and root causes. The repair organization
keeps the repair intelligence without exposing customer or pricing information to
an outside party.

Control Tower Repairs

A repair organization coordinates the repair process without executing any repair
or fulfillment operations in house. Customer broken products are routed to third
party repair shops while exchanges are sourced from OEMs or third party
distribution centers. Depot Repair defaults the appropriate repair vendor, and ship
from inventory based on customer defined disposition rules. Overdue returns and
refurbishments trigger escalation notifications. Third party refurbishment status is
tracked via workflow and/or iSupplierPortal.

Setting Up Repair and Return with Third Party

1.

Navigate to the Repair Types page. The Repair Type Summary region displays the
existing repair types in the system.

To create a new repair type, click the New icon on the menu option.

Enter the required information in the following fields:

® Repair Type: Enter the name of the repair type.
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® Description: Enter description of the repair type.
¢ Business Process: Select Depot Repair from the list of values.

* Repair Mode: The default value is Work In Process. The other available options
are Task Mode and None.

Note: You must select WIP Mode to use the Repair Technician
Portal.

® Repair Type Ref: It defaults if you select a seeded Repair Type.

e Third Party Ship and RMA: Select the Ship and RMA Service Activity Billing
Types from the list of values.

The list of values displays the Service Activity Billing Types, which are setup in
the Charges setup windows. These values must be associated with a third party
RMA line and third party Ship line to indicate what OM line types to use, what
operating unit to associate them with, what contract entitlements apply, and so
on.

You must set up the Service Activity Billing Types under the Pre-Repair and
Post-Repair columns in order to have a RMA line under pre-repair, and a Ship
line under post-repair.

e Third Party checkbox: Selecting the check box creates a third party ship and
RMA line at time of repair order creation if a Service Activity Billing Type is
selected in the Third Party RMA and ship columns. If a Service Activity Billing
Type is selected for the Ship column but not the RMA column, only a ship line
will be created at time of repair order creation. Likewise, if a Service Activity
Billing Type is selected for the RMA column but not the Ship column, only an
RMA line will be created at time of repair order creation.

If the third party flag is not checked, no Third party lines will be auto-created,
even if service activities are entered in the Third Party Ship and RMA fields.

Note: A repair type having third party lines can also have
regular lines, provided the Service Activity Billing Types are
set up for them in their respective columns.

4. Click Save.

5. In the Repair Type Details region, enter Service Activities in the Material, Labor,
and Expense tabs. This is optional and is required only when a customer creates
Estimate or Actual lines. They are not needed if no billing is done in Estimates or
Actuals.
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10.

Select Automatically enter and book RMA, and Automatically ship through options
for third party shipments. This is optional and depends on the business process of
the repair center. You can use any of the following options: auto-create, auto-enter,
or auto-book. Automatically process through option enables the ship lines to create
a charge line, or enter an unbooked line in OM, or book a line in OM.

This is optional and depends on the business process of the repair center.

HYO ISP RXDDER LB o7

Repair Type Summary

Active

Repair Type Description

Advance Exchange Advance Exchange
l Repair and Retum
Credit Only

Exchange

Repair and Return

Receive Broken Product for cred
Exchange

Internal Repairs Repair Internal tems
Loaner Loaner
Loaner, Repair and Return | Loaner, Repair and Return
Loaner, Repair and Return-Ol | Loaner, Repair and Return-Ohso
Rebur Reburbishment

Refurhishment Refurbishment

Repair Type Details
v Automatically enter and book RhA

W Autarnatically ship thraugh:
 Enter Qrder
 Book Order

Repair Order Status Transitians ~ J

Repair Type Transitions J

Click Save. Close the Repair Type form.

Navigate to the Repair Orders page.
Create a new Service Request.

Create a new Repair Order.
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v
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BP0 B HGPI LB D A LEPDP 5% R ?
(=] | Time
Service Request Information
Customer Type | Organization Contact Type | Relation - ¥lInstalled ltems Only Reguest Num 52580
Customer |Business VWorld Cantact ltem CE0O01 SR ]
- Summary
Account 1605 Relationship Revision -+
Phone |BS0555 555 Teler: Contact ID Instance 70156 Request Type |Depot Repair
Bill-To 2391 L Street,,, = Phone Serial Mum Severity |High
Ship-To 2391 L Street,,, = Email Opened  21-JUL-2008 00:5 Status |Open
Mew Contact.. Closed Ownar Anderson, Steve
Repair Order Information Repair Beifigia
Repair Num Repair Type Itam ltern Description IO Qty  Status Approved
l 11229 Repair and Return-Y¥WIF Cs0a0t Standard ltem with Mo Control Each 1|Open =
Details Logistics Diagnostics Repair Estimate Repair Jobs Repair Tasks Repair Actuals
Repair Mum 11228 Installed Site | 23971 L Street, San Jose, Problem Description -]
ltem (CE0001 Default Contract 21579 -
Revision Currency |US dallar Priority |1 - High
Instance 70156 Default Price List |Corporate Date Created 21-JUL-2008 01:13:41
Serial Nurn Default PO Murm Resalve By Date | 22-JUL-2008 01:10:03
Unit Mum Repair Org |Repair Center-West Promize Date
Lot Mum Repair Owner Date Closed
Repair Mode  WVIP Project Automatically Enter and Book RA
Escalation Project Task ¥ Estimate Appraval Required il
Motes | Depot Repair i Go... ) “iew Configuration... Update Counters... Update RO Status.. )

11. Click Save.

12. Navigate to the Logistics tab.

You can view four lines in the Action Type column. Return and Ship lines for
regular repair and return and Ship Third Party and Return Third Party lines for
third party (RMA and Ship).

13. Receive the item in inventory. For more information, see: Auto-Receive an Item.,
page 4-69

14. Select the row to ship an item to the third party and select the Process Trans check
box.

15. The third party account field should have defaulted at time of ship line creation if
the disposition rules were set up correctly. You cannot change the account if the line
is set to automatically book. Click the Ship radio button.

16. Click the Process button. Item is shipped to the third party for repair and the status
of the line shows Shipped.

17. Receive the item from third party using third party RMA line. Item is received from
third party and the status of the line changes to Received.

18. Ship the item back to customer through regular ship line.
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Invoice Third Party

Depot Repair allows sending repair invoices to a different party from that which logged
the service request. Invoices can be sent to multiple parties for a single repair order.

Updating the Invoice Third Party Flow
1. Navigate to the Depot Workbench and query for a repair order.

2. Click the Repair Actuals tab. The tab displays the following information:

e The Total column reflects the total charges associated with the repair order if
the Actual Lines are billed to more than one party.

Datais Logistice Diagnostics Repair Estimate  Repar Jnbs Rapair Actuals
Duatauli Bill To Summary of Aciual Charges:
Accaunt 160 Matanisl (0] Cumency US dollar
Paty Business Warld Lkt L]
Address 2391 L Street  San Jose CA US 35106 Expenzs 1] Tonal [

Billing Conbract Pricing Attributes Orvmidle Mo
Corchar Catagary Seal PO Mum Prica | Uit Chasge Change
Mum | tar [ P | List Oty LiC Price Charge

l Manual Mgl Material Compeorate [ 1 m - 5.00

® The Default Bill To Account, Party, and Address default from the information
entered on the Service Request.

® You can change the default information. Changing the Default Bill To Account,
Party, and Address will not impact the already created lines. It will impact the
lines created after the change.

3. Click the Line Details button to navigate to the Actual Line Details page.
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f Is
Source Order Billing Serial PO Cantract  Price Unit Override Mo

Type Mumber  Category  ltem Mumber  Mumber  Number  List Gty JOM Price.  Charge Charge Charge
Manual Material AS54888 GWC_Onlir Corporate 1 |Each 1599.00 | B39.60 i

Material AS54868 GWC_Onlir Corporate 1|Each 1599.00 | B38A0

Actual Line Details Contract Information

Source Type Manual ltem |AS54855 Price List burpurate Mumber (GYC_Online
Source Mame Description |Sentinel Sta Pricing Attributes | ] Description Gold Coverage (24x7)
Order Mumber Revision Quantity 1 Discount 959.40
Ordler Line Num Instance UOM Each I Overide Charge
PO umber | Serial Number Unit Price 1582.00 Met Discount 959,40 [ No Charge
Billing Category Material Lot Mumber Extended Price 1689.00 Charge B39.60
Billing Type Material Locatar ' Warranty Claim Bill To
b Account 1608
Resource Mumber

Party Business YWorld
Replaced ltem SEtis
Address (2391 L Street San Jose CA

Dave l Cloge )

The Actual Line Details page displays the following information:

e Bill To Account, Party and Address details for each corresponding line, default
from Actuals tab.

*  You can update the Bill To Account, Party or Address fields if you choose to bill
a different party, account, or address than that specified on the Service Request
for a specific charge line.

Supplier Warranty Claims

Organizations performing repairs on products manufactured by other companies need
a mechanism for reporting and settling warranty claims with the Original Equipment
Manufacturers (OEM) or suppliers. The mechanism consists of the following:

¢ Send Claim to Supplier

Depot Repair enables you to capture claim data and trigger the claim submission
workflow. Multiple claims can be made against multiple vendors per repair order.
The OM Line Flow is used as the mechanism for triggering communications
between a repairer and a supplier. The standard Accounts Receivable invoice that
OM generates is used for settling third party claims.

e Track Approval Status and Claim Number from Supplier

Depot Repair provides fields to capture the supplier warranty claim number and
warranty claim status from the supplier's claim management system. Multiple
claim numbers and statuses can be tracked per repair order.
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Capturing Warranty Claim Information

1. Navigate to the Depot Repair Workbench and query for a repair order.
2. Click the Repair Actuals tab.
3. Click the Line Details button to navigate to the Actual Line Details page.

4. To capture warranty claim information, select the Warranty Claim checkbox in the
Actual Line Details region.

5. Enter the Number and Status for the warranty claim. These fields are non editable if
you do not select the Warranty Claim option.

6. Select a Replaced Item from the list of values. Replaced item shows list of items
belonging to the Organization. The replaced item information is sent along with the
warranty claim information.

7. Click Save.

Execute Outside Processing

A depot repair technician can trigger the creation of a purchase order for outside
processing by completing an Outside Processing (OSP) operation in the Repair
Technician Module. See: WIP Implementation Guide, for more information about
setting up OSP operations.

Select Repair Parts from Dynamic Repair BOM Window

Depot Repair provides a new region in the Repair Technician module to enable a
technician to view any bill of materials, or alternate bill of materials. This module also
enables the technician to choose a routing. The technician can check off the removed,
replaced, or repaired parts. You can add the selected parts first to a repair estimate, and
then create a job from the estimate.

Select Repair BOM

The Dynamic Repair BOM screen enables the technician to quickly capture the parts
required for a repair. Upon completion of the inspection, the selected parts are
automatically added to the repair order estimate.

1. Navigate to the Depot Repair Workbench and query an item.
2. Click the Repair Estimate tab on the Repair Order page.

3. Select the Select Materials button to navigate to the Expanded BOM window.
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4. In the Search region, enter a valid BOM item in the Item field or select an item from
the list of values. You can also select an Alternate BOM from the list of values.

5. Click Go. The Select From BOM Hierarchy regions displays those items in the BOM
hierarchy which have billing type as Material defined in Inventory Item Master.

6. Select the BOM components required in the repair. These materials appear as new
estimates lines on the Repair Estimates tab at completion of triage.

CcLE Depot Repair

Repair Number 10657 Diagnostics Preferences Close Window
Search
Save Routing(0) | | Save and Process(1) |
Enter valid BOM item in the Item field or select an item from the LOV.
*Item |75100001 Q
Alternate BOM Q
ficad
Select From BOM Hierarchy.
Select All | Select None | Expand All | Collapse All
<
Select Focus Item Description Qty vom
Il = 75100001 Printer Mechanism 1 Each
¢ 75100002 8/W Cartidge Carrier 1 Each
& 75100003 B/W Cartidge 1 Each
& 75100004 Faper Carrier 1 Each
O | < 75100003 Colour Cartidge 1 Each
0| < 75100006 Colour Catridge Carrier 1 Each
Select Additional Items
Enter an ltem and corresponding quantity required for repair. Add any items which are not in the Bill of Materials(BOM).
Select Item Description Qty uom
No Lines Entered
Add Another Row
Select a Routing
Select a routing to associate with the Repair Estimate. IF selected this will be used as default routing to create the WIP job.
Routing Reference
Save Routing(0) | | Save and Process(1) |

Diagnostics Preferences Close Window
About this Page  Privacy Statement Copyight (9 200, Oracie. Al ights reserves

7. The Select Additional Items region enables you to enter an Item and corresponding
quantity required for repair. Add any items which are not in the existing BOM.

8.  You can select a routing to associate with the Repair Estimate in the Select a
Routing region.

Note: You can save only a single Routing at one time, and that
Routing can only be viewed on the Select Material window. You
can modify the saved routing if required. The routing is used to
create a job from estimate.

9. Click the Save and Process button to commit the selection of desired components.
Close the window.

10. Click OK on the alert to trigger the refresh in the Estimate tab.

1. The following values default for Estimate lines created from the Expanded BOM
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window:

® Source Type: Repair BOM
¢ Billing Category: Material

* Contract Number: Use the contract associated to the repair order if a contract
exists

e Price list: Default the Price lists selected on the Details tab

Source Billing Contract Pricing Attributes Estimated Cvarride Mo
Type Category [term Murnher Price List | Oty LOM LInit Price Charge Charge  Charge

Ilanual Lahor Lahor Corporate b 1 |Hour 150.00 150.00 =
l Repair BOM lateria 75100002 Corporate b 1 |Each 10.00 10,00

Repair BOM  |Material 75100003 Corporate 1 |Each 10.00 10.00 -

Add Lines from Diagnostics Select Materials Create Joh Save Estimate

Create Job from Estimate

Once the repair estimate is created, a repair manager works with the customer to
approve the estimate. After the approval of the estimate, the repair manager initiates
the repair by generating a repair job from the estimate.

To create job from estimate

® Select the Create Job button on the Repair Estimate tab.

Clicking the Create Job button initiates and follows the process flow outlined in the
section Repair Jobs tab, page 2-30.

Note: The Submit Job button and the Select Materials button appear
only if the function to view these buttons is granted.

Print Traveler Document

Depot Repair provides an out-of-box traveler document to enable the repair technicians
to scan in maximum data thereby reducing the time consumed in data entry. Traveler
documents allow easy identification and disposition of items in the repair shop. Bar
coded serial numbers and repair order numbers allow technicians to quickly find repair
records without typing.

To print a traveler document:

1. Navigate to the Depot Repair Workbench.
2. Create a Repair Order or retrieve an existing repair order.

3. Select the Print Traveler option from the Data menu.
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File Edit View Folder Tools §EEIEN Window Help
=) % xS @ o &b ¢ Senice History

A civity
Quick Menu

Service Request Informat =
Wigw Current'Workflow

HSED D5

Custorner Type |Orga t Type | Relation - Installed Iterns Only Request Mum 1844
Reserve Serial Number
Customer [Worle ontact Andrea Butler-Wc ltem | AST2111 Computeris =
Unraserve Serial Number Summary .
Account 1000 5 onship | Contact Far Revision not hooting
Phone |[1-703 View Service Bullatins act D PARTY REL-100° Instance Request Type Customer Call
Bill-To Phane Serial Num Severity High
Ship-To Email Opened 04-0CT-2000 16:( Status Closed
Mew Contact... Cloged 26-MAY-2005 09 Owner Abhott, Ms Rhaon
Repair Crder Infarmation Repair Estimate
Repair Murm Repair Type Item ltem Description Uokd Oty Status Approved
l 10040 Repair and Return - Non |EEESEReARN| Ervoy Deluxe Laptop Each 1|Closed Approved =

Details Logistics Diagnostics Repair Estirnate Repair Jobs Repair Tasks Repair Actuals
Repair Mum |10040 Installed Site Prablem Description =
lterm |AS72111 Default Contract -
Revision Currency |US dollar Priority
Instance Default Price List Date Created 04-OCT-2000 16:08:553
Serial Nurm Default PO Murm Resolve By Date
Linit Mum Repair Org  |Repair Center-Morth Promige Date (0B-OCT-2000 00:00:00
Lot Mum Repair Owner Date Closed
Repair Mode WP Project Automatically Enter and Book RMA
Escalation Froject Task Estimate Approval Required I |
MNotes |Depot Repair =2 Go Wiew Configuration Update Counters Update RO Status.

This command prints the traveler.

Depot provides a standard traveler format, and also a barcoded traveler, both of which
can be tailored to a customer's preferences using XML Publisher.

View Service Bulletins using Depot Repair Workbench

Depot Repair automatically links a service bulletin to a repair order based on customer

defined service bulletin rules. A number of pre-defined bulletin types are seeded in the
product. You can add any additional bulletin types to fit your business needs. You can
view service bulletins from the Depot Repair Workbench.

The Depot Repair Workbench enables the repair managers, coordinators, billing clerks,

and other users to view service bulletins. The Depot Repair Workbench is enhanced to
allow a user to view the service bulletins associated with a repair order from the

Workbench.

To view a service bulletin from the Depot Repair Workbench:

1. Navigate to the Depot Repair Workbench.

2. Create a Repair Order. Alternatively, you can search and retrieve an existing repair

order.

The Repair Orders page opens.
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3. Click the View Service Bulletins option from the Data menu.

File Edit View Folder Tools gREIEN window Help

ERNCEE Y ZE0 D5

‘© Repair Ord 0 ati Aﬂ!ww
Service Request Informat Q_L“CRME”U
Custorner Type |Orga =% Cumentiondlony rope [ pefation - [ Installed fterns Only Request Num 1344
Reserve Serial Number
Customer |Warle . ontact Andrea Butlerye ltem |AS72111 Computeris =
Unreserve Setial Murmber Summary =
Account 1000 by Traveler Cantact For Revigion not booting
Phone |1-703 ice Bulleting PARTY REL-100¢ Instance Request Type |Customer Call
Bil-To Serial Num Severity |High
Ship-To Opened 04-0CT-2000 16:( Status |Closed
Mew Contact... Closed [26-MAY-2005 09 Owner Abhaott, Ms. Rhon
Repair Order Information Repair Eaifiee
Repair Numn Repair Type ltem ltern Description Ok Qty Status Approved
l 10040 Repair and Return - Mon |IEES=fes ARl Envoy Deluxe Laptop Each 1 |Closed Approved =
m Logistics Diagnostics Repair Estimate Repair Johs Repair Tasks Repair Actuals
Repair Mum 10040 Installed Site Froblem Description =
ftem [AS72111 Default Contract -
Revision Cutrency |US dollar Priority
Instance Default Price List Date Created |[04-0OCT-2000 16:05:53
Serial Murm Default PO Mum Resolve By Date
Unit Nurm Repair Org |Repair Center-hlarth Promise Date 0B-OCT-2000 00:00:00
Lat Mum Repair Owner Date Closed
Renair Mnda WYIF Proiert Autornatically Enter and Book RhA

The Service Bulletins page opens.

4. The Service Bulletins page displays the existing service bulletins if the Retrieve
Service Bulletins concurrent program is running. Click Retrieve New Service
Bulletins button to display any additional new service bulletin.

ORACLE"

Preferences Close Window

Service Bullstins

Last Retrieved on

Type Go

Select Details llame Description Type Mandatory Attachment Viewed
[ @ ShowReqular Com Test Bulletin o i

Preferences Close Window

Privacy Statement ‘Copyright () 2000, Cracie. Al righs reservec

5. Select the service bulletin and click Show to display the service bulletin details.

Related Topics

Define Triggers for Service Bulletins

View Service Bulletins from the Repair Technician Module
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View Read Only Workbench

Oracle Depot Repair provides the ability to launch the Depot Workbench in read-only
mode. The Depot Workbench provides numerous data and functionality that is not
specific to any specific user type. It provides functions to repair managers, service
representatives, receiving clerks, shipping clerks, billing clerks and many more. The
read-only mode allows the users to access data that they need but restricts them from

performing functions outside of their purview.

To view the Depot Workbench in read-only mode, set the profile option, CSD: Read

Only Workbench, to Yes.

To Access a Read-only Depot Workbench:

1. Navigate to the Depot Workbench. The Workbench launches in read-only mode.

You can only view data, but not execute any functions.

2. The read-only mode allows you to click certain buttons and view menu options.

The disabled functions/buttons are:

Create new service request

Create new contact

Create new repair order

Create Note - Details Tab

Change Status - Details Tab

Counters - Details Tab

Configuration - Details Tab

Process Transaction Checkboxes - Logistics Tab
Process Transaction Through Checkbox - Logistics Tab
Process button - Logistics Tab

Receive - Logistics Tab

Ship - Logistics Tab

Create Job - Repair Jobs Tab

Create Task - Repair Tasks Tab
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e Capture Quality Plan - Repair Tasks Tab

* Create Estimate, Estimate Line - Repair Estimates Tab
¢ Create Job from Estimate - Repair Estimates Tab

¢ Submit Actuals - Repair Actuals Tab

The disabled menu items are:

e Reserve/Un-reserve Serial Number

e Split Repair Order
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5

Overview

Repair Manager Portal

This chapter outlines the broad set of capabilities that a repair manager performs in the
course of normal repair center operations.

This chapter covers the following topics:

Overview

Repair Manager Portal Page

Using the Repair Order Backlog region
Using the Quality Event Watchlist region
Using the Advanced Search page

Using the Create Repair Order page
Setting Up Aging Threshold

Setting Up Quality Threshold

The Repair Manager Portal provides the ability to monitor and manage the return
center from a single screen. The Portal provides instant visibility to bottlenecks and
process exceptions and allows you to manage the exceptions quickly. It allows a
manager to:

Monitor and report product quality issues:

Managers set quality thresholds for an item regarding the number of repairs during
a specified time. The system triggers workflow notification when the quality
thresholds exceed.

Monitor and manage work backlog and resources:

Managers allocate resources to ensure that the highest priority work is done first
and all the work is completed on time. Managers set aging thresholds for how long
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repairs are open or in the same status without changing. System triggers
notification for the ones passed aging thresholds and due dates.

* Monitor and manage processing exceptions and escalations:

Managers monitor work orders needing attention or approval and drill down to the
details of respective repair orders. Managers update repair orders to remove
escalations, change ownership, change priority, and so on.

* Create, update and search repair orders:

Managers create new repair orders and/or update existing repair orders. Managers
can perform a mass-update of ownership, priority, due date, and other values on
repair orders. Additionally, they can search existing repair orders and save the

search queries, if required.

Repair Manager Portal Page

The header of the Repair Manager Portal page is the Repair Order Backlog region and
the footer is the Quality Event Watchlist region. Additionally, you can use the Shortcuts
section to navigate to the Search Repair Orders page, Create Repair Orders page, and
Manage Service Bulletins page.

Shortcuts

Repair Manager Portal
Personalize Bulleted List

R ir Order Backl
epair Order Backlog « Search Repair Orders
Personalize "Repoir Order Backiog" « Create Repair Orders

* Manage Service Bulletins

View Inventory Org |Seattle Manufacturing | @

Personalize Advanced Table: ( RiY)
owner | Total ions| Past Due| Aging

[ 0 o 0
0 o 0 0

On Hold

Anderson, Steve 5
Hopkins, Jack 5

Quality Event Watchlist

Personalize "Quality Event Watchlist"
View Inventory Org |Seattle Manufacturing | @
[oo]
Personalize Advanced Table: (QualityTrendsTbIRN)
Item | Totalluom | Threshold| Variance|  Trend
CSD002 11 Each 7 4 EN
CspooL 2/Fach 7 -5 v

Diagnostics Home Logout Preferences Personalize Page
Copyrigh (< 2008, Gracle. Al ighis eservec.

About this Page _ Privacy Statement

For more details on the regions, select one of the following;:

¢ Using the Repair Order Backlog region, page 5-2

* Using the Quality Event Watchlist region, page 5-3

Using the Repair Order Backlog region

5-2

A Repair Order Backlog region is a summary table that indicates for each of the
resources how many repair orders they own, how many are escalated, past due, aging
or on hold.

The Repair Order Backlog region displays the following information:
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View Inventory Org: Displays the default organization to which you belong based
on your user profile organization. You can choose other organization if required.

Owner: Displays the resources that are assigned the repair orders.

Total: Displays the number of repair orders for the owner in total.
Escalations: Displays the number of escalated repair orders for the owner.
Past Due: Displays the number of past due repair orders for the owner.
Aging: Displays the number of aged repair orders for the owner.

On Hold: Displays the number of repair orders for the owner that are on hold.

All the non-zero numerical entry in the columns mentioned above is hyperlinked. Click

any hyperlink to navigate to drill down to a details table for any resource or category

combination.

Using the Quality Event Watchlist region

A Quality Event Watchlist region is summary table that indicates how many of each

item type are returned for a selected organization and time period. Additionally, this
region indicates a pre-set threshold for returns in a selected period and an indicator of
whether the number of returns is trending upward or downward from the prior period.
You can drill down to a details table for any item.

The Quality Event Watchlist region displays the following information:

View Inventory Org: Displays the default organization to which you belong based
on your user profile organization. You can choose other organization if required.

View Period: Defaults to 7 days. You can select any value for the view period.
Item: Displays the items returned.

Total: Represents the number of repair orders for the item during the selected
period.

UOM.: Unit of measurement of the item.

Threshold: Displays the quality threshold for each item as defined in the Quality
Threshold Setup table. As the period changes the threshold updates to match the
selected period.

Variance: Indicates the difference between Total and Threshold. Has plus or minus
pre-fix. Red for plus, green for minus.
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e Trend: The indicator displays whether the number of repair orders has increased,
decreased or stayed the same relative to the prior time period. Red arrow indicates
increase, green arrow indicates decrease, and black line indicates same as prior

period.

Using the Advanced Search page

The Advanced Search page provides advanced search capability to search repair orders
using dynamic queries with many different search criteria.

Repair Manager Portal >
Repair Orders

el arch: (AdvancedSearchRN,

Specify parameters and values to filter the data that is displayed in your results set.
@© show table data when all conditions are met.

© show table data when any condition is met.

rem  [is v Q
Status s v Q
Priority s v Q
Repair Number s - Q

Go | | Clear |add Another | External Reference v | | Add

nali

'RO Search Results Table"

Savesearch

Select Details Repair Number [rtem |item Description RO Status |Ro Owner Promise Date |Ro Priority
] cspooz Standard Ttem with Serial Control open Anderson, Steve
] cspooz Standard ltem with Serial Control Open Anderson, Steve
] cspooz Standard Ttem with Serial Control open Anderson, Steve
[} cspooz Standard Ttem with Serial Control Open Anderson, Steve
@ cspooz Standard Ttem with Serial Control open Anderson, Steve
m] cspoot Standard Ttem with No Control open Anderson, Steve

Mass Update Selected Repair Orders

Personalize "Mass Updal Repair Orders"
Personalize Table Layou oTbleRN)

Clear || update Selected Repair Orders |

Repair Type Q Priority Q
Repair Status Q Owner Q
Repair Org @, Escalation Code v

Personalize Defauit Double Column: (NotesRN)

Note Type | Callback v visibiity [public [

Personalize Default Single Column: (MoteHolder)

You can navigate to the Advanced Search page in the following ways:

From the Repair Order Backlog region:

Click any numeric hyperlink on the Total, Escalations, Past Due, Aging, or On Hold
columns to navigate to the Advanced Search page. This page displays
pre-populated data for the Owner/column combination you choose. Click a repair
order hyperlink to drill down to the Repair Technician module and see the details
of that repair order.

From the Quality Event Watchlist region:

Click the numeric hyperlink on the Total column to navigate to the Advanced
Search page. This page displays pre-populated data for the Item/column
combination you choose. Click a repair order hyperlink to drill down to the Repair
Technician module and see the details of that repair order.

From the Shortcuts panel:
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Click the Search Repair Orders link on the right hand panel on Repair Manager
Portal to navigate to the Advanced Search page.

The Advanced Search page enables you to perform a search using the following criteria:

e Jtem
e Status
* Priority

® Repair Number
* Repair Owner
® Service Request

e External Reference

Mass Update Selected Repair Orders region

The Mass Update Selected Repair Orders region enables you to select one or more
repair orders and perform mass update of attributes like ownership, priority, due date,
and other values on repair orders.

Mass Update Selected Repair Orders

Personalize "Mass Update Selected Repair Orders"
Personalize Table Layout: (UpdateRoTbleRN)

Clear || update Selected Repair Orders |

Repair Type Q Priority Q
Repair Status Q Owner Q
Repair Org @ Escalation Code v
Personalize Default Double Column: (NotesRN)
Note Type | Callback v|  visbilty [Public |v
Personalize Default Single Column: (NoteHolder)
Hote
Personalize Default Single Column: (A 1)
Attachment Title
Description
Category | ADI Kiosk Default Logo v
Personalize Table Layout: (Atta )
Type @ File

QUuRL
OText

Cancel Save Search

The Mass Update Selected Repair Orders region displays the following information:

® Repair Type: Contains a list of values of the user-defined Repair Types. Repair type
requires that both the old and new repair type allow the current repair order status.

® Repair Status: Status of the Repair Order. Repair Status can only be updated to a
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status which has a valid transition defined from the current repair order status on
the repair order.

* Repair Org: Enter the organization to search.
¢ Priority: Priority of the repair order.

* Owner: Service depot resource responsible for execution and completion of the
repair.

e Escalation Code: Indicates whether the repair order is escalated, and if so, what
type of escalation it is.

* Note Type: Limited to Repair Order Note Types.

* Visibility: Indicates whether the Note is public or private.

* Note: Enter the desired note.

e Attachment Title: Title of the attachment.

¢ Description: Description of the attachment.

* Category: Indicates the category to which an attachment belongs.
e Type: Type of attachment.

To mass update selected repair orders:

1. Select the repair orders you want to update from the Advanced Search results table.
2. Enter the changes in the Mass Update Selected Repair Orders region.
3. Click Update Selected Repair Orders button to process your request.

A confirmation message on mass update appears at the top of the Advanced Search
page.
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Repair Manager Portal =

L% confirmation
1. Selected repair orders are successfully updated.

Repair Orders

Cance| | | Save Search |

Personalize Query: (QuervRiN)

Advanced Search

Personalize Advanced Search: (AdvancedSearchRN)

Specify parameters and values to fitter the data that Is displayed in your results set,
@ show table data when al conditions are met.

O show table data when any condition is met.

Item Is |ae] Q

Status is [a| Q

Priority is £ Q

Repair Number is [a] Q

| Go I Clear ‘Add Another | External Reference (| | Add |

Using the Create Repair Order page

The Create Repair Order page enables you to create multiple repair orders at a time.
You create repair orders using bulk serial number capture or quick entry of item and
serial. Defaulting Rules apply to repair orders you create on this page.

Click Create Repair Orders link on the right panel of Repair Manager Portal to navigate
to the Create Repair Order page.

Repair Manager Portal »
Create Repair Orders

Cancel | | View Recently Created Repair Orders | | Process

Party Information

* Account 1001 Q
Party Name American Telephone & Telegraph

Item Information

Serial Number *Item *Quantity UOM External Reference Lot Number  Revision  To Serial Number

pop L p L LR LS
Lopppesp e
plopppeepe e

Lopppepep e
ya)

Returr to Repair Manager Portal, Cancel | [ View Recently Created Repair Orders | | Process

About this Page

This page displays the following information:
¢ Party Information region:

¢ Account: Enables you to query on Party.

e Party Information: Displays the party name for the selected account.

¢ Item Information region:

¢ Serial Number: Enter a single serial number or enter the first serial number in
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the range.
e Jtem: Select the item.
* Quantity: Enter the quantity.
e  UOM: Enter the unit of measurement.
* External Reference: Capture unique external reference number, if any.
e Lot Number: Enter the lot number for a lot controlled item.
e Revision: Enter the revision number for a revision controlled item.

® To Serial Number: Enter the final serial number in the range.

* View Recently Created Repair Orders: Displays the details of the recently created
repair orders. Click this button to navigate to the Advance Search page and view
the repair orders.

® Process: Processes the creation of new repair orders.

Repair Manager Portal > Create Repair Orders >
Repair Orders

Save search

Advanced Search

Specify parameters and values to filter the data that is displayed in your results set.
@ Show table data when all conditions are met.
O Show table data when any condition is met.

tem  [ig v Q
Status is v Q
Priority  [is v Q
Repair Humber i - Q

6o | | Clear |add Another |Extarnal Reference (v || Add

revious [ 1-10  |%| Next 10 &

Select All | Select None

Select Details Repair Number [ttem [rtem Description [Ro status RO Owner [promise Date RO Priority
O cspoot Standard Ttem with o Control Open Anderson, Steve
(] €spog2 Standard Item with Serial Contral Open
O CSD002 Standard Item with Serial Control Open
[m) CSD002 Standard Item with Serial Control Open
O Cspoot Standard Ttem with o Control open
O CsD001 Standard Ttem with Ho Control Open
O CSD002 Standard Item with Serial Control Open
O CsDoot Standard Ttem with o Control Open
(] €spoot Standard Item with o Control Open
O CSD002 Standard Item with Serial Control Open

Mass Update Selected Repair Orders.

Clear || update Selected Repair Orders |

Repair Type Q Priority Q
Repair Status Q Owner Q
Repair Org @, Escalation Code v

Defaulting rules apply to creation of repair orders the same way as it is applied when
creating repair order from Depot Workbench.

Setting Up Aging Threshold

Aging is defined as the amount of time from repair orders creation or the amount of

5-8 Oracle Depot Repair User Guide



time that a repair order is in a specific status. Aging is related to elapsed calendar time
and not to actual repair time. The unit of measure (UOM) for aging is time-bound, for
example, days, hours, minutes, and so on.

To set up aging threshold:
1. Navigate to the Aging Thresholds Setup page from the Depot Repair Setup menu.

2. Select an organization. To search for an existing aging threshold go to step 3 or
continue to step 4 to set up a new aging threshold.

3. Click Go to search for an existing aging threshold in the selected organization.

4. Click the Add Another Row button to enter aging threshold details.

ORACLE’ Depot Repair

7 Navigatorw B Favorites v

Aging Thresholds Setup

Apply | | save search

Simple Search

Note that the ssarch is case insensitivs
O —
Orgarization Q
[ 6o | [ dlear

Age
Threshold
Inventory Org Item Category litem ~ Description Revision |Repair Type Status (Days) Delete

[seattie Marufactring | @, [miscmisc | & |cspoo: | & Standard ttem with o Corral Repair and Rewm-Taskd A, [open | & o]

Add Another Row

Apply | [ save search

About this Page  Privacy

5. Enter the following information:

* Inventory Org: Displays the default organization to which you belong based on
your user profile organization.

¢ Item Category: Select the item category.
e Item: Select the item.
¢ Description: Describes the item.

® Revision: For revision-controlled items, you can optionally specify thresholds to
specific revision number.

* Repair Type: Specifies the repair type for which age threshold applies.
e Status: Specifies the status to which age threshold applies.

¢ Age Threshold (Days) : Specifies the number of days at which a repair is
considered aging. It must be a positive value (>0).

¢ Delete: This icon deletes an aging threshold entry.
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6.

Click Apply to record the new aging threshold.

ORACLE" DepotRepair

T Navigatorv B Favorites v Diagnostics Home Logout Preferences.

Ea Confirmation
Successfully added/updated the aging thresholds. Please requery to view/update it.

Aging Thresholds Setup

Simple Search
Note that the search is case insensitive
= —
Age
Threshold
Tnventory Org Item Category Item - |Description Revision |Repair Type status (Days) Delete
Seattle Manufacturing  MISC.MISC €SDOD1 Standard Ttem with No Control Repair and Retun-Task{ @, [Open Q o

Add Another Row.

Diagnostics Home Logout Preferences

About this Page  Privacy Statement Copyight (c) 2006, Oracle. Al rights reserved

A confirmation message appears on the top of the page.

Setting Up Quality Threshold

Quality thresholds setup page enables you to create item record and corresponding
quantity per day. Use quality thresholds to set how many items can be returned per
day.

To set up quality threshold:

1.

Navigate to the Quality Thresholds Setup page from the Depot Repair Setup menu.

Select an organization. To search for an existing quality threshold go to step 3 or
continue to step 4 to set up a new quality threshold.

Click Go to search for an existing aging threshold in the selected organization.

Click the Add Another Row button to enter aging threshold details.

ORACLE" DepotRepair

Quality Thresholds Setup

Save Search

Simple Search

Mate that the searth is case insensitive

[ a
[ 6o | [ clear
“Inventory Org Category [rtem «. |Description Revision *Threshold Quantity/ Day|uoMm Delete
|seattle Manufacturing_| G [iscrsc S |cspooy ] & Standard ltem with Mo Control Q @

Add Another Row

Apply | | save search

Enter the following information:

¢ Inventory Org: Displays the default organization to which you belong based on
your user profile organization.
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e Category: Select the item category.

e Item: Select the item.

® Description: Describes the item.

* Revision: Active only for revision-controlled item.

e Threshold Quantity/Day: Represents the number of returns per day at which a
repair is considered a quality event. It must be a positive value (>0).

e  UOM: Describes the item's unit of measurement.

® Delete: This icon deletes a quality threshold entry.

Click Apply to record the new quality threshold.

ORACLE’ Dpepot Repair

M Navigator v B Favorites v Diagnostics Home Logout Preferences

[y Confirmation
Successfully added/updated the quality thresholds, Please requery to view/update it.
Quality Thresholds Setup

Apply | [ save Search

Simple Search
Note that the search is case insensitive
O —
Organization aQ
[ 6o | | clear
“Inventory Org Category Item Description Revision “Threshold Quantity/Day UOM Delete
Mo search conducted.
Add Another Row

Apply | [ Save Search

About this Page _ Privacy Statement Copyight (5 2006, Oracle. Al rights resenved

A confirmation message appears on the top of the page.
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Overview

Recalls

This chapter covers the following topics:

Overview

Recall Process Flow

Creating a Recall Event

Using the Details Tab

Using the Items Tab

Using the Corrective Actions Tab
Using the Metrics Tab

Finding a Recall

A recall is an action taken to address a problem with an item that makes it likely to fail,
cause injury, or violate safety laws. A recall is not always an intimation to a customer to
discontinue using the product or return it to the company. It means that the item or
device needs to be checked, adjusted, recharged or fixed. Recalls are also called field
change orders (FCOs), field actions, technical bulletins, and safety alerts.

A recall is of two types depending on where the recall action takes place:

Correction: A correction addresses a problem with an item in the place where it is
used or sold. This is managed by providing information to end customers to fix the
problem, sending replacement part to swap out the defective part, or sending a field
service agent to resolve the issue.

Removal: A removal addresses a problem with an item by removing it from where
it is used or sold. Removals include items in warehouse inventories; spare pools or
parts inbound in transit. A company may ship a replacement product to the
customer or the customer may return the product to a depot for repair. Removals

Recalls 6-1



also include items replaced in the place of purchase.

When a company recalls an item, it contacts the impacted parties, supplies information
on how to correct the problem, and ensures a plan to prevent the recurrence of the
same. Sometimes unsold finished goods are recalled from internal warehouses and
refurbished items are recalled from the exchange pool. In such cases, notification and
corrective action are directed to the appropriate internal parties. In the cases where the
manufacturer issuing the recall is not aware of the end consumers, he only notifies the
distributors and instructs them on the various corrective actions to take.

Recall Process Flow
There are different types of user types involved in a typical recall business flow.

(_ BUSINESS PROCESS FLOW J

GUALITY Legs Frotuet
MAKAGER Seracn Angust

amooueT
MAKAGER:

SERWICE Lausches and
MAKAGER Msnagar Racal

| [ ——— |

RETURKS
COORIIKATOR hareinranll m [

e Size e b Shiga teri L

Sarvica Carnr Sarica. Carmnr

- S P
RECEVING | Fncrams n
BHPAING CLERS Slapes Aot ke s Diserupance: oo

- Pracasses Ancall Mavasac Siages Caghuras Pom &
TRCHNKZIAN ™ ramn ™ Lahor

Quality Manager: Responsible for monitoring customer complaints and the return
stream to determine the potential quality event. The Quality Manager can log a product
service request in Agile to indicate to the product management and engineering teams
that a quality event has occurred.

Product Manager: Works with the Quality Manager to determine if a product service
request indicates a legitimate quality event that requires corrective action. If action is
required, the Product Manager works with the Engineering and Service teams to
determine the best corrective action for the problem.
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Service Manager: Responsible for launching and managing the recall effort. The Service
Manager provides reports on recall progress and cost, and is responsible for ensuring
that service fulfillment is performed.

Returns Coordinator: Works through the queue of recall orders to notify customers of
the recall and next steps. He is also responsible for requesting the movement of
materials from one location within the enterprise to the appropriate processing location.
Additionally, he is responsible for moving materials to another internal or external
location after completion of service processing.

End Customer: Receives notification of recall via phone, E-mail or letter. He is
responsible for shipping the correct item or part to the appropriate location based on
the information provided. He should be able to view details and status for their recalled
product online.

Receiving Clerk / Shipping Clerk: Receiving Clerks receive returned materials at the
receiving dock. They enter returned material information into the system; log
discrepancies between expected and actual returns, and stage material for the next step
in processing. Shipping Clerks pack and ship materials to their next destinations, both
within an organization or external to it.

Service Technician (internal or third party): Responsible for processing recalled items.
This involves performing repair, upgrade, hazardous material removal, part swap, and
retirement processing or recycling. He is responsible for tracking the actions they
perform, the parts that they use and the hours they spend on each job.

Creating a Recall Event

A recall event must be unique. It is described by attributes that makes it clear as to what
event or problem triggered the recall, when it was initiated, who initiated it, and the
actions needed to resolve it. The recall record is linked to all the related service requests,
repair orders, logistics operations, and service operations required to resolve the recall.
These linked connections are required to accurately track the scope, progress and cost of
a recall.

To create a recall event:

1. Navigate to the Search Recalls page and click the New Recall button. The Create
Recall page opens. This page enables you to create a new recall or view and update
the attributes of an existing recall record.
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N Navigator v B Favorites v Diagnostics Home Logout Pref

Search Recalls >
Update Recall:

Apply
Recalls
Recall Number ~ Recall Name
Last Updated Date
Status Q@
=] Hide Additional Details
Classification Reported Date B
Estimate flum of Units Affected Initiation Date B
Consumer Contact Estimated Completion Date B
Recall Hotline Mandated Completion Date B
Recall Website Attachments
Details | Items | Corrective Actions | Metrics
Recall Details
Ttem Category Item Name Description Revision Start Revision End Serial Humber Start Serial Nlumber End Lot Start Lot End Delete
o results found.
Add Another Row
Partner Type Partner Name Partner Location Start Date End Date Delete
No results found.
Add Another Row
Apply

Diagnostics Home Logout Preferences

About this Page  Privacy Statement [ R E e —

2. Enter the following details in the fields provided. Fields marked as * are mandatory
fields.

* Recall Number: System generated unique identifier for the recall. It is not
updateable.

® Recall Name: Unique name of the recall.
e Status: The status of the recall.

3.  Expand Hide Additional Details to enter the following details:
* C(lassification: Codes indicating categorization.

¢ Estimated Number of Units Affected: Estimation of units being affected by the
recall.

* Consumer Contact: Employee or contractor who customers contact with recall
queries.

¢ Recall Hotline: Number that customers call to get details about the recall.

¢ Recall Website: Web site for consumers to find out information about the recall.
¢ Reported Date: Date on which recall is made public.

* Initiation Date: Date on which recall activity starts.

¢ Estimated Completion Date: Date on which recall is anticipated to terminate.
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* Mandated Completion Date: Date on which a regulatory body mandates recall
completion.

¢ Attachments: Represents standard Oracle Applications attachments. You can
link attachments to a particular recall.

4. Click Apply to save the new recall. The Update Recalls page opens.

What's Next

The main body of the Create Recall/Update Recalls page contains four tabs - Details,
Items, Corrective Actions, and Metrics. For more details about these tabs, select one of
the following;:

* Using the Details Tab, page 6-5
* Using the Items Tab, page 6-6
® Using the Corrective Actions Tab, page 6-9

e Using the Metrics Tab, page 6-11

Using the Details Tab

The Recall Details region of the Details tab enables you to update the attributes of a
recall.

Details Items | Corrective Actions Metrics

Recall Details

Revision  Revision
Ttem Category Ttem Name Description Start End Serial Number Start Serial Number End Lot Start Lot End

MISC.MISC @, [cspant @, Standard |5 Q [a Q Q Q Q

Item with Mo
Add Another Row

Contral
Partner Type  Partner Name Partner Location ‘Start Date End Date Delete

Manufacturer | | Il | | B[ |8 @

Row

Importer
Manufacturer
Repairer
Seller

Cancel | | Apply

Copyright (<) 2006, Oradie. Al rights reserved.

Diagnostics Home Logout Preferences
bout this Page  Privacy Statement

The various attributes that can be updated are:

e Item Category: Includes product category, family, or line. You can include multiple
categories in a recall.

* Item Names: Name of the item. You can include multiple names in a recall.

¢ Description: Description of the selected item.
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® Revision Start and End: The iterative value assigned to an item with multiple
design configurations.

¢ Serial Number Start and End: The serial numbers stamped on item instances that
uniquely identify them. Recalls sometimes apply to specific ranges of serial
numbers, or to serial numbers with specific prefixes or suffixes.

® Lot Start and End: Lot numbers tie together groups of items that came from the
same production run, shipment, configuration or other arbitrary association. A
recall may include multiple lot numbers.

¢ DPartner Type: You can filter by specific partners namely:

¢ Importer: Party or parties that imported the finished good into the country of
sale.

* Manufacturer: Party or parties that manufactured a finished good that is under
recall.

¢ Repairer: Party or parties that repaired a finished good that is under recall.

® Seller: Vendor party or parties that sold an item to the end customer.

e Partner Name: Name of the specific partner

® Partner Location: Location of the specific partner
e Start Date: The start date of the recall

e End Date: The end date of the recall

After entering all the required attributes, click the Apply button to save the changes to
the Recall.

Using the Items Tab

The Items tab contains a list of all known item instances impacted by the recall. You can
link each item instance to a service request, repair order and an associated WIP job
during recall execution.

You can click on the Service Request number or Repair Number to drill to the service
request and repair order windows.
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Details  Items Corrective Actions Metrics

Add Multiple Instances

Select All | Select None

Select Serial Number Instance Number Item  Owner “Phase Service Request Service Request Status Repair Number Repair Order Status Delete
] 70158 CSDO01 A. C. Hetwiorks 82 Open 45080 open
70158 CSDO01 Business World Open open
a 70171 CSDO01 Business World Closed Closed
3025143 €SDO01 Vision Corporation 1/62382 Open Open
Generate Recall Work for Selected Records
“TIP Service Request Type is required for generating recall wark
Generate Recall Work
Service Requests and Repair Orders Jobs
* Service Request Type [Depot Repair Q service Code [Replace bonnet
Repair Order Type [Repair and Return-WIP.| &, Upgrade Tem [CSDO02

Accounting Class [Rework

PRPR

Inventory Organization [Seattle Manufacturing

cancel

Diagnostics Home Logout Preferences Help

About this Page  Privacy Statement Copyigit {6200, Orace. Al rghis reservesd

To use the items tab:

1. Click the Add Multiple Instances button to navigate to the Search Item Instances
page. The Search Item Instance page allows you to perform advanced searches
against the Install Base.

2. Specify any one of the mentioned search parameters to query for the required item
instance. To add more search parameters, select a parameter from the Add Another
list and click the Add button.

3. Select the Go button to display the Install Base instances matching your search
criteria.
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Search Item Instances

Advanced Search

Specify parameters and values to filter the data that is displayed in your results set.

@ Show table data when all canditions are met.
© show table data when any condition is met.

Irem s v Q
Ttem Categary MISC.MISC Q
Trem Revision s - [}
Serial Number Start s - Q

[ Go | [ Clear Jadd another [mem  w|[Add |

Select All | Select hone

Select Phase Instance Number Serial Humber Ttem Name Customer

O 11953

Ttem Description

Add To Recall

9 Previous [ 1-10 |9 Next 10 &

Revision Lot Number Supplier Sold Date Last Repaired Date Repair Organization

AS72111  American Telephone & Telegraph Envoy Deluxe Laptop Unassigned
O 58491 CM11222  Business World Battery - Extended Life 21-Feb-2002 Unassigned
O 127998 CM86324  Vision Corporation Packing Material Unassigned
O 128004 CM86324  Vision Corporation Packing Material Unassigned
O 128009 CM86324  Vision Corporation Packing Material Unassigned
O 1072159 AS72111  General Technologies Envoy Deluxe Laptop 09-Dec-2005 Unassigned
O 1073159 AS72111  Business World Envoy Deluxe Laptop 09-Dec-2005 Unassigned
O 39706 AS72111  World of Business Envoy Deluxe Laptop Unassigned
O 1] 26257 AS72111  General Technologies Envoy Deluxe Laptop Unassigned
O 25424 AS72111  United Parcel Service Envoy Deluxe Laptop Unassigned

9 Previous Next 10 &

Done | [ Add To Recall
Diagnostics Home Logout Preferences

4. Select the item instance you want to add or click the Select All option to add all the
item instances.

5. Click the Add to Recall button. A confirmation message appears confirming the
addition of item instances.

(5% Confirmation
The selected tem instances are successfully added to the recall (Recall Number:2001),

Search ltem Instances

Done Add To Recall

Advanced Search

Specify parameters and values to filter the data that s displayed in your results set.

@ Shaw table data when all conditions are met.

O Show table data when any condition is met.
Ttem is v

Q

Ttem Category is ¥ MISC.MISC 4,

Ttem Revision s v Q

serial Number Start is v a,
Go | Clear |add Another |ltem ] [Add |

6. Click the Done button. The Update Recall page appears with the selected item
instance(s).

7. Select one or more instance numbers and click the Generate Recall Work button to
generate service requests, repair orders and/or repair jobs for them. The quantity on
the repair order is directly derived from the quantity specified in Install Base for the
instance.

e If you enter only the Service Request Type and click Generate, it creates a
service request for each selected item instance, or if there are multiple
non-serialized quantities create a single service request for the entire
non-serialized quantity.
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e If you select both Service Request Type and Repair Order Type and click
Generate, it creates a service request and repair order for each item instance,
again consolidating multiple non-serialized quantities.

e If you enter a Service Request Type, a Repair Order Type and a Service Code
and click Generate, it creates a service request, repair type and repair job for
each checked item instance, again consolidating multiple non-serialized
quantities.

¢ Ifno service request exists for an item, you cannot generate repair orders and
jobs. Similarly, if no repair order exists, you cannot generate a job for an
instance. However, if a service request was previously created for an instance,
then you can generate a repair order and job for it at a later time.

e If an upgrade item is specified, and a job is created for the selected instance, the
job is created for the upgrade item and not for the item specified by the
instance. This job has at least one material requirement line with item as the
item of the selected instance.

8. The system generates a service request, repair order, and work order for the specific
item instance.

9.  You can navigate to the Repair Order page of the Technician Portal by clicking on
the Repair Number link generated on the Items tab. The Repair Execution tab
displays the operations, materials and resources specified by the Service Code that
displayed on the Items tab before you clicked Generate Recall Work.

Using the Corrective Actions Tab

When a company recalls an item, it contacts the impacted parties, supplies information
on how to correct the problem, and puts a plan in place to prevent the problem from
happening again. Sometimes unsold finished goods are recalled from internal
warehouses and refurbished items are recalled from the exchange pool. In such a case,
notification and corrective action are directed to the appropriate internal parties. In
some cases, the manufacturer issuing the recall may not know the end consumers, and
notifies their distributors and instructs them on the corrective actions to take.

The Corrective Actions tab stores information regarding the reason for the recall, risk,
discovery and resolution plan.
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Details Items | Corrective Actions Metrics

Problem

Discowery Date |07-Jun2010 | (&

Recall Reason

Problern Description

Discovery Method

Incidents and Injuries

Risk

Consequerce

Resolution

Remedial Actions

Rerall Strateqy Decision

cancel | [ Apply

Diagnostics Home Logout Preferences

hbout this Page

Problem Region

The Problem region enables you to enter the problem details. Enter the following
information in the fields provided:

¢ Discovery Date: The date on which the company realized that a recall is needed.

¢ Recall Reason: Descriptive text describing why a particular recall was made.

¢ Problem Description: Description of the problem that resulted in a need for recall.
* Discovery Method: Description of how the problem was identified.

¢ Incidents and Injuries: Description of notable cases of occurrence, especially those
involving injuries.

¢ Risk: Describes the possible risks introduced if the recall is not made.

* Consequence: Description of the potential impact to customer health, customer
satisfaction, company reputation and company finances.

Resolution Region

Resolution region enables you to enter the details of the remedial actions taken. Enter
the following information in the fields provided:

¢ Remedial Actions: Description of specific actions that need to be taken to resolve
the problem under recall.

® Recall Strategy Description: Description of the plan of action for the recall. This is
required for reporting to regulatory agencies. This includes a description of the
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different phases of the recall.

After entering the problem and resolution details, click the Apply button to save the
changes to the Recall.

Using the Metrics Tab

The Metrics tab provides information regarding how many item instances are impacted,
how many customers are impacted, how many items still require processing, and how
many customers are still impacted.

Additionally, the Metrics tab tracks the accumulated cost of the recall so far and the
estimated remaining cost of the recall.

Recalls
Recall Number 10001 * Recall Name  [june 18-recall-01
Last Updated Date  18-Jun-2010 15:25:27
Status [Draft Q
[ Hide Additional Details
Classification Reported Date )
Estimated Number of Units Affected Initiation Date =8
Consumer Contact Estimated Completion Date =
Recall Hotline Mmandated Completion Date =
Recall Website Attachments More
Details Items Corrective Actions Metrics
Recalculate Metrics
Last Refreshed on  21-Jun-2010 00:01:51
Humber of Recalled Units 4 Estimated Remaining Cost 0
Number of Units Remediated 0 Number of Customers Impacted 3
Number of Units Un-Remediated 4 Number of Customers Remediated 1
Accumulated Cost  2767.19 Humber of Customers Un-Remediated 2
cancel | [ Apply

Diagnostics Home Logout Preferences Help

About this Page  Privacy Statement ‘Copyright {c) 2006, Oracle. All rights reserved.

The various fields in the Metrics tab display the following information:

*  Number of Recalled Units: Derived from the number of item instances linked to a
recall. If item instances have multiple quantities, the total quantity is aggregated.

*  Number of Units Remediated: Derived from the quantity of Install Base (IB)
instances linked to the recall with closed service requests. If an IB instance with
multiple quantities is linked to a service request, and the service request is still
open, the system considers the entire quantity un-remediated. If the service request
is closed, the system considers the entire quantity remediated.

¢ Number of Units Un-remediated: Derived from the number of item instances linked
to a recall for which no closed service request exists. In cases where item instances
linked to the recall have no service request, these instances are included as
un-remediated.

e Accumulated Cost: The calculation for accumulated cost factors in the cost of issued
material and transacted labor time for jobs linked to the recall.

¢ Estimated Remaining Cost: Derived as, (Accumulated cost till date / Number of
units used for calculation of accumulated cost) * Number of item instance quantities
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that are eligible but not yet costed

Number of item instances that are eligible but not yet costed, represent all the
instances that do not have a positive cost yet, minus the closed service requests
(SR). Since a closed SR is a remediated unit, you must not consider it for the
calculation of estimated cost remaining.

Example
A recall has 4 instances linked to it and the quantity for all the instances in Install
Base (IB) is 1.

Instance 1 has SR, RO and WIP job created and some part and labor costs are
recorded against it. Assume the cost is $100.00

Instance 2 has SR, RO and WIP job created but no part of labor costs recorded
against it.

Instance 3 has SR and RO created but no WIP job created against it yet.
Instance 4 has only SR created and the SR is closed.
The Estimated Remaining Cost: in this case is (100/1)*2.
¢ Number of Customers Impacted: Derived from the unique number of customers

linked to the recall. This is determined from the install base instances linked to the
recall.

¢ Number of Customers Remediated: Derived from the unique number of customers
linked to the recall for which all service requests are closed.

*  Number of Customers Un-remediated: Derived from the unique number of
customers linked to the recall whose service requests are not all closed.

e (lick the Recalculate Metrics button to refresh the Recall Metrics.

Finding a Recall

On the Search Recalls page, you can retrieve Recall records from the database. A search
in Oracle Depot Repair enables you to retrieve Recalls based on parameters related to a
Recall. You can use a combination of these parameters to restrict your search so as to
retrieve only the Recall that you want.

To find a recall:
1. Navigate to the Search Recalls page.

2. Enter any one of the following search parameters:

e Recall Number
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e Recall Name

e Recall Status

e Creation Date
¢ Jtem Category
e Item

¢ Item Revision

e Initiation Date

Click the Go button. The results area displays the recall record matching your
search criteria.

ORACLG’ Depot Repair

M Navigator v Favorites ¥ Diagnostics Home Logout Preferences

Search Recalls

Search Recalls

Note that the search is case insensitive
Recall Number (2001 Ttem Category

Recall Name |Parts Recall Tem

pPP
L PP

Recall Status Ttem Revision

Creation Date I:| @ Initiation Date |:| =]
6o | | Clear
New Recall

Recall Number Recall Name Recall Status Initiation Date Creation Date Update
2001 Parts Recall Draft 08-Jun-2010 7

Diagnostics Home Logout Preferences
Copyright (c} 2006, Oracie. All righis reserved

About this Page  Privacy Statement
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7

Overview

Returns Dashboard

This chapter covers the following topics:

¢ Overview

® Returns Business Intelligence Page Overview
* Using the Returns Tab

e Using the Eco-Impact Tab

Returns Dashboard enables the organizations to monitor its return streams to reduce
returns processing costs, recover value from returned assets, build better products, and
minimize its impact on the environment. Returns Dashboard also helps to adhere to
various environmental regulations such as WEEE and ROHS. These laws require
organizations to take back products that a customer no longer wants, take back
packaging materials, track the recycling programs and scrap contributions, and remove
hazardous materials from returns and dispose them properly. Organizations require
tools to help manage these new requirements, minimize their costs and provide the
reporting necessary to comply with the legislation.

The Returns Dashboard enables you to perform the following:

¢ Monitor how much material is being returned through each return stream: Returns
dashboard helps to monitor how much material is returned from customers and the
value of that material. This helps to reduce the overall number of returns, monitor
the return stream to react quickly to rapidly increasing returns, and create
programs to increase the recovery of higher-value assets.

®  Monitor how much scrap and hazardous material comes from returns: Companies
have legal and ethical responsibility to monitor and mitigate their impact on the
environment. In addition to energy consumption and carbon emissions,
manufacturing and retail companies produce significant amounts of scrap and
hazardous waste. Returns Dashboard provides the capability to monitor how much
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of the return stream ends up in scrap so that effective ways are developed to re-use
and recycle materials and to build products that create less waste and hazardous
material.

Returns Business Intelligence Page Overview

The Returns Business Intelligence page displays current Returns Streams and Material
Disposition metrics. The header of the Returns Business Intelligence page enables you
to select the time period and organizational scope for which you want to see data.

Returns Business Intelligence

* Period | Last 7 Days v
Operating Unit Q Inventory Organization

* Weight UOM  |POUND Q * Currency |US dollar

P p

Returns | Eco-Impact

® Year to Date displays data for the current year.

*  Quarter to Date displays data for the current quarter of the selected year..
¢ The Last 7 Days allows you to pick the last seven days (inclusive).

* Choosing a specific date displays data only for that date.

® Choosing the current date, month, quarter or year, the Dashboard displays data for
that period-to-date.

You can view metrics for across all operating units and also view metrics for any
operating unit if the profile option, CSD: Returns Dashboard Visibility Level, is set to
Enterprise level. If you have operating unit visibility, and MOAC is enabled, the
Operating Unit field in the Returns Dashboard header requires you to pick an operating
unit you have access to via MOAC setup, in order to query Returns metrics. If MOAC is
not enabled and the profile is set to Operating Unit, then the operating unit field in the
Returns Dashboard is not updateable and is set to the operating unit specified by the
profile MO: Operating Unit.

To view the relevant return streams, enter the fields mentioned above and click the Go
button. The Returns tab and Eco-Impact tabs populates with the information of the
specified period.

The body of the Returns Business Intelligence page contains two tabs - Returns and
Eco-Impact. For more details about these tabs, select one of the following:

e Using the Returns Tab, page 7-3

* Using the Eco-Impact Tab, page 7-4
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Using the Returns Tab

The Returns tab displays a consolidated report of the number of units returned by the
return stream

Returns  Eco-Impact

“TIP Prior Period = Same Period in Pri

Retumn Stream Comparisons

r Year
Units Returned Returned Weight Returned Value

Return Stream |Selected Period Prior Year|Percent Change|Selected Period|Prior Year Selected Period|Prior Year
Cust it 5 150 250

turn For Credit

1 30 906.65
] <50 60 120 100 200
10 300 501

1 30 50

The Return Stream Comparisons region displays the following information.

Return Stream: Return Streams are lookups associated with an Order Management
(OM) return reason code. Returns must have an OM reason code that is linked to a
Return stream in order to be shown in this table.

Units Returned Selected Period: Represents the number of units on RMAs for the
specified return stream within the period of analysis. You can query this from the
Sales Order and Repair Order tables.

Units Returned Prior Year: Represents the number of discrete units returned to the
business that map to the specified return stream during the prior year. Prior year
represents same period of time as the selected period, except in the prior year. For
example, if the selected period is March 1st-31st 2010, then the prior year data is
returns from March 1st-31st 2009.

Returned Weight Selected Period: Represents the total weight of all units returned
that map to the specified return stream. The weight of any item is defined for it in
the Inventory Item Master.

Returned Weight Prior Year: Represents the total weight of all units returned
during the prior year. The weight of any item is defined for it in the Inventory Item
Master.

Returned Value Selected Period: Represents the total value of all units returned that
map to the specified return stream. The value of any item is specified as the
standard cost of that item in Cost Management.

Returned Value Prior Year: Represents the total value of all units returned during
the prior year. The value of any item is specified as the standard cost of that item in
Cost Management.

The Returns by Inventory Organization graph represents the flow of returns for a
particular inventory organization for a selected period and its corresponding previous
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year.

The Returns by Return Stream graph represents the flow of returns for various return
streams for a selected year and its corresponding previous year.

The Returns Trends for Selected Period graph shows the total flow of returns for a
selected period.

The Returns Trends for Prior Period graph shows the total flow of returns for the
previous period.

Returns by Inventory Organization Returns by Return Stream
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Using the Eco-Impact Tab

The Eco-Impact Tab provides a comparative analysis of targeted eco-impacts. The tab
provides the following information:

*  Number of Units by Disposition shows the number of units for each disposition in
the selected period vis a vis the prior period and the percentage change in these
periods. Green threshold indicators indicate that everything is operating within
acceptable limits.

¢ Weight by Disposition shows the total weight of the units transacted for each
disposition in the selected period vis a vis the prior period and the percentage
change. Green threshold indicators indicate that everything is operating within
acceptable limits.

® Percentage of Units by Disposition shows the number of units dispositioned against
the number of units returned in all return streams expressed as a percentage.

® Percentage of Weight by Disposition shows the total weight dispositioned against
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the total weight returned in all return streams expressed as a percentage.

Number of Units by Disposition

Number of Units
@

Hazardous Mateials Recyde Recover
Reuse serap Disassembled

Disposition

Percentage of Units by Disposition

W5eleced Period

Percentage

B
7
B
5
a
3
2
4
0
B

Hazardous Mateials Recyde Recover
Re-use Sasp Disassem bled

Weight by Disposition

WSelected Period
200

180

120

Weight

Hazardous Mateials Reayde Recover
Re-use sarap Disassembled

Disposition

ge of Weight by Di

W5eleced Period
35

30

25

20

Percentage

05

00
Hazardous Materials Recyde Recover
Re-use Saap Disassem bled

Scrap Trends for Selected Period shows time-series trends for weight of material

sent to scrap during the analysis period.

Scrap Trends for Prior Period shows time-series trends for weight of material sent
to scrap during the same period in prior year.

Hazardous Materials Trends for Selected Period shows time-series trends for
weight of material disposed as hazardous materials during the analysis period.

Hazardous Materials Trends for Prior Period shows time-series trends for weight of
material disposed as hazardous materials during the same period in prior year.
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Scrap Trends for Selected Period Scrap Trends for Prior Period

= Selected Peiod Nogra

Weight

olozunrol

Transaction Date

Hazardous Materials Trends for Selected Period Hazardous Materials Trends for Prior Period

No graph gener

Weight

10-Jun-2010 1-Jun2010

Transacon Date

® Scrap by Inventory Organization shows the weight of returned material sent to
scrap for a particular Inventory Organization.

* Hazardous Materials by Inventory Organization shows the weight of returned
material disposed as hazardous materials for a particular Inventory Organization.

Scrap by Inventory Organization ‘als by v

W Selected Perind W Selected Peiod

Weight
N
weight

Seattle Manufactuing Seattle Manufactuing

Inventory Organizaton Inventory Organization

Note: All the Scrap and Hazardous Materials metrics are measured by
the amount/weight of the materials that were WIP negative issued or
returned with a reason code that belongs to the Scrap/Hazardous
Materials dispositions that were setup.
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8

Receiving Returns using the Bulk Receiving

Overview

Module

This chapter describes how to easily receive items into the depot that arrive with or
without an RMA.

This chapter covers the following topics:
e Overview
¢ Entering and Processing Bulk Receive Data

*  Bulk Receive Items Processing Logic

The Bulk Receiving module enables you to record the information required to process
repair order items when they arrive in the depot with or without a return materials
authorization (RMA). This module enables a receiving clerk to process both expected
and unexpected receipts using the same screen.

In general, you use the bulk receiving function to create a batch of items per customer
per shipment. The items can have any of the following attributes: :

® Serialized or non-serialized

® Trackable or non-trackable - the tracking is performed by Oracle Installed Base
* Lot controlled

® Locator controlled

® Revision controlled

All combinations of these attributes are allowed.

The bulk receiving module facilitates the following:
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* For areturned item if a matching RMA exists, the system automatically receives the
item against that RMA. In this case, the receiving clerk does not need to know the
RMA number.

¢ For a returned item if no matching RMA exists but an open RMA exists for that
customer, the system automatically creates a Repair Order (RO) and RMA with the
item received.

e For a returned item if no SR, RO, or RMA exist, the system automatically generates
the SR, RO, and RMA and receives the item against it. The system marks such an
RMA as an unexpected receipt.

e For a returned item, you can capture unique external reference number, if any,
using bulk receiving. You can personalize this field to capture the required external
reference number.

¢ In case of over-receipt, the system automatically receives the material by creating
new RMA lines to match the over-received quantity. Corresponding new ship lines
are also created for repair types that require them, and the system tracks this
material as unexpected for later audit.

® In case of under-receipt, the system automatically receives the materials returned
and then split off separate open RMA lines for the materials pending receipt.

* Few customers log a service request for items they return, but do not specify the
item numbers, serial numbers or quantities. The service request is used to track that
a shipment was sent for service. At receipt, you can open a SR to match the items
received, and have the system automatically create the RO and RMA numbers for
each returned item.

¢ Bulk receiving supports capture of locator, lot and revision controlled items at the
time of receiving.

Bulk Receive Process Overview

8-2

For each batch perform the following operations:

1. Enter either the customer account number, or a service contract number - from
which Oracle Depot Repair derives the account number.

Note: The search criteria in the header region are only used to
uniquely identify a Party and Account. It does not filter the search
to limit serial numbers.

2. For each item, enter as much of the following data as you know:
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e Jtem Name
e Serial Number, for serialized items
*  Quantity (mandatory)

* UOM
If the UOM is not entered, the primary UOM of the item is derived.

3. Click Process to process the batch; if there are any problems with the data entered
for any item, you can correct the data, and then process the batch.

A concurrent request is submitted, whose objective is to create the following objects for
each batch of items:

*  One service request
® A repair order and an RMA for each item

The concurrent request will also attempt to auto-receive the items. When an item is
auto-received, its status in the Return line in the Logistics tab of the Depot Repair
Workbench is set to Received.

The following diagram shows an overview of the Bulk Receive processing, as
performed in two pages, the Bulk Receive page and the Bulk Receive Warnings page.
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Bulk Receive Page

Select an Account — directly or via Contract Number
Enter Item Information details

Glck

No l Yes
Any Warnings?

y

Bulk Receive Warnings Page

Optionally correct the data

L J | J

Concurrent Request Submitted

: '

The concurrent request

Bulk Receive Page with (a) Creates as many of the
confirmation of concurrent

request submission

following as possible:

* Service Request
* Repair Order

You can enter another set e RMA
of items for bulk receiving

(b) Attempts to Auto-Receive
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Entering and Processing Bulk Receive Data

ORACLEM Depot Repair

Bulk Receive

Process (0)

Party Information

* Account 1608

Party Business World

o p

Item Information

serial Number Item *Quantity UOM

I

L plpes s L L L L
L plpperpppe

Add Ten Rows
Process (0)

Diagnostics Home Logout Preferences

About this Page  Privacy ¢

Steps
1. Select the Account or Contract Number.
Oracle Depot Repair uses Contract Number to derive the Account.

The Party is derived from the Account.

2. For each item, you enter as much of the following data as you know:

e Jtem Name
e Serial Number, for serialized items
*  Quantity (mandatory)

e UOM

3. For processing the expected receipts, set the profile option, CSD: Enable Expected
Receipts for Bulk Receiving, to Yes. The Party Information region has Incident
Number that defaults the account details and is used if there are any unplanned
receipts. A new unplanned Repair Order is created against this incident number if it
is entered.
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CORACLE Depot Repair

Diagnestics Home Logout Pref

Bulk Receive
Process (0)
Party Information
Personalzs "Party Information”
Contract Number aQ RMA hurriber Q,
* Account 1004 e
Party  Hilman and Assoclates
Item Information
Personalize Advanced Table: (EnterlteresTh]
Serial Number Ttem *Quantity LOM External Refs Lot Number rision DM Cross Ref ]
ELK-RCW-SN-1002 @, |cspooz a, 1 |Bach @
Q @, @
Y q Q
q Q Y
q 2 q
Q Q Q
Y q Q
q Q Y
q a, CY
Q Q Q
Add Ten Rows ,
Process (0)

To proceed without processing the expected receipts, continue with the following
steps.

4. Click Process.
5. If there are no problems with any of the data, continue at step 9.

6. If there is at least one problem, the Bulk Receive Warnings page appears.

ORACLE’

Bulk Receiva =
Unplanned Recelpts

Process
d Table: (UnplannedReceiptThi)

Lot
Select Warning Message Serlal Number Item Duantity Uom External Reference  Number Revision
[#] Thisis an unplarned receipt 3, 50004 Q, 1||Each Q,

Home Logout Prefi

7. You can optionally edit any of the fields.
8. Click Process.

9. The Depot Repair Bulk Receive Items concurrent request is submitted. A
confirmation message shows the request number and the Transaction number
parameter associated with the request.
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Note: Note down the Transaction number. In case there are any
errors in the processing of the entries, it can be reused in a
subsequent submission of the concurrent request - see step 12.

10. The concurrent request attempts to create the following objects for each data row,
depending on what data has been entered:

*  One service request
¢ Arepair order and an RMA for each item
The concurrent request will also attempt to auto-receive the items.

11. To see the results of the concurrent request, examine the output of the request.
The report shows which objects were created, and also any errors.

12. After you correct the errors, you can explicitly resubmit the Depot Repair Bulk
Receive Items concurrent request, entering as a parameter the same Transaction

number that appeared in the confirmation message at step 8. This resubmitted
concurrent request will attempt to process only the error entries.

Bulk Receive Items Processing Logic
The objects created during the Bulk Receive processing depend on the following;:

* The predefined attributes of each item
*  Whether or not you entered all the required attribute values for the item

e Predefined profile options

Predefined Item Attributes

The item attributes are associated with the item when it is defined in Oracle Inventory.
The item attributes examined by the Bulk Receive processing logic are as follows:

*  Whether the item is trackable by Oracle Installed Base

e Whether the item is serialized, and if so, how is the serial number attached to the
item instance - predefined, at receipt or at sales order issue?

Item Data Entered on Bulk Receive Page

The main consideration for entering bulk receive data is to enter item identification and
serial numbers when required for serialized items.
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If you enter insufficient or mismatching data, you will get warnings on the Bulk Receive
Warnings page.

Note: After you have entered either an Account or a Contract Number,
for each item entry - that is, each data row entered in the Bulk Receive
page - the Bulk Receive processing logic always creates a service
request, which you can edit later.

Use of Profile Options

Default Values

Several fields in the objects created by Oracle Depot Repair derive their values from
profile options.

The profile options used for default service request values are:

® (CSD: Default Service Request Owner for Bulk Receiving
e (CSD: Default Service Request Severity for Bulk Receiving
® (CSD: Default Service Request Status for Bulk Receiving

¢ (CSD: Default Service Request Summary for Bulk Receiving

This provides the Problem Summary for the service request.
e (CSD: Default Service Request Type for Bulk Receiving
e (CSD: Default Service Request Urgency for Bulk Receiving

The profile option used for repair orders is:

® (CSD: Default Repair Type for Bulk Receiving

The profile option used for RMAs is:
e (CSD: Default Subinventory for Bulk Receiving

Ownership Transfer

The profile option CSD: Transfer of Ownership for Bulk Receiving is used when all the
following conditions apply:

e A serial number is entered on a Bulk Receive row.

* Theitem is defined as trackable by Oracle Installed Base.
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e The party associated with the entered serial number does not match the party in the
Bulk Receive batch header.

If an item instance for the serial number does not exist, it is created, else the existing
item instance is updated.

For both item instance creation and item instance update, the item instance owner is set
according to the value of CSD: Transfer of Ownership for Bulk Receiving, as follows:

e If the value of the profile option is Yes; the item instance owner is set to the Bulk
Receive party.

e If the value is No, the item instance owner is set to the party associated with the

entered serial number, with the following Note: "Install base owner will be changed
to the entered Party."

Bulk Receive Processing Logic Table

Note: In this section, the term Internal Party refers to the Party Name
set up in the Oracle Installed Base Install Parameters.

If you do not enter the Item field in a Bulk Receive row, then only a service request is
created, with the following attributes:

e Party = Internal Party
e Note = "No item has been entered"

If you enter an Item in a Bulk Receive row, the table following shows the different
processing options that occur.

Key to the abbreviations in the following table:
® B =Oracle Installed Base

o RMA = Return Material Authorization
® RO = Repair Order
e SN = Serial Number

® SR =Service Request
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IB-trackable
Item?

Serialized Item? Serial Number

Entered?

Other

Processing
Logic

Yes Yes

Yes Yes

Yes Yes

Yes No

Yes No

No Yes

Yes

Yes

Yes

Yes

SN matches the
Item entered

SN does not
match the Item
entered

SN matches the
Item entered

Create SR, RO,
RMA, and
attempt to
Auto-Receive.

New IB instance
and SN created
for the Item.
Create SR, RO,
RMA, and
attempt to
Auto-Receive.

Create SR for
specified party.
If Quantity > 1,
then create RO
in Draft status; if
Quantity =1,
then create RO,
RMA, and
attempt to
Auto-Receive.

Create SR for
Internal Party
with Note =
"Serial number
has been entered
for a
non-serialized
item."

Create SR, RO,
RMA, and
attempt to
Auto-Receive.

Create SR, RO,
RMA, and
attempt to
Auto-Receive.
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IB-trackable
Item?

Serialized Item? Serial Number

Entered?

Other

Processing
Logic

No

Yes

Yes

Yes

Yes

SN does not
match the Item
entered

If SN is
Predefined, then
create SR for
Internal Party
with Note =
"Cannot create
new Serial num
for a Predefined
Serialized item".
If SN is At
Receipt or At
Sales Order
Issue, then create
new SN and
create SR, RO,
RMA, and
attempt to
Auto-Receive.

Create SR for
specified party.
If Quantity > 1,
then create RO
in Draft status; if
Quantity =1,
then create RO,
RMA, and
attempt to
Auto-Receive.

Create SR for
Internal Party
with Note =
"Serial Number
has been entered
for a
non-serialized
item."

Create SR, RO,
RMA (all for
specified party),
and attempt to
Auto-Receive.
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Comments

If you enter a Serial Number for a serialized item, and a Quantity greater than 1, a error
message appears warning you that the Quantity should be 1. Click the link in the error
message to take you back to the error row.

If you do not correct the error and continue to Process, the repair order that is created
will be in Draft status. You can then enter the individual serial numbers through the
standard Oracle Depot Repair facility Tools > Capture Serial Numbers.
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9

Executing Repairs using the Repair
Technician Module

This chapter describes an enhanced set of operations to process repair items.
This chapter covers the following topics:

e Overview

® Searching for Repair Orders

* Repair Order Page Overview

* Using the Evaluation Tab

® Using the Repair Execution Tab

* Using the Debrief Report Tab

* View Service Bulletins from the Repair Technician Module
* Manage ECOs

® Backflush Non Serialized Repair Parts

* Auto-Issue Repair Items to Jobs

e Using Time Clock

Overview

High volume repair is an enhancement to the standard repair and return process. It
automates and facilitates the creation of work orders, procuring and issuing materials,
and assigning resources with minimal input and decision making from a repair
technician. Based on a finite number of possible symptoms and a finite number of
responses to those symptoms, the system can recommend or dictate work to be done,
materials demanded, and resources needed for low complexity repairs based on
symptoms captured by a technician.

The following diagram shows an overview of the high volume repair processing, to be
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performed in two pages, the Repair Order Search page and the Repair Order page.

Repair Order Search page

Search for items

Select item to process

Repair Order page

Evaluation tab

Repair
Execution tab

Debrief Report
tab

Evaluate current problem based on solutions
to problems for same or similar items

Generate repair jobs

Add materials to job operations
Add resources to job operations
Complete job operations

Select root causes of defect
View key performance indicators
View activities

You can view and add Notes in alf the tabs
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Searching for Repair Orders
ORACLEO Depot Repair

Diagnostics Preferences Personalize Page Close Window

Repair Order Search

RMA = Return Material Authorization
RO = Repair Order

SR = Service Request

Note that the search is case insensitive

Save Search

Ttem |CSDOO1 Q Repair Number Q
RO Status O\ RO Owner Q
RO Priarity Q

Go Clear
<) Previous Next 10 &
Show All Details | Hide All Details

Details Repair Humber|Ttem |Ttem Description RO Status|RO Owner |Promise Date |Ro Priority
@ Show(1-1 CSD001 Standard Ttem with Mo Control Closed Abbott, Ms. Rhonda 06-Nov-2002 21:00:00
[® Show|10269 CSD001 Standard Ttem with No Control Closed Abbott, Ms. Rhonda
Show|11030 CSD001 Standard Item with No Control Open
Show|11031 CSD001 Standard Item with No Control Open
11032 CSD001 Standard em with No Control Open
11036 C5D001 Standard em with No Control Open
11037 C5D001 Standard em with No Control Open
11038 CSD001 Standard tem with No Control Open

In the Repair Order Search page, you can search for all non-draft repair orders.
The seeded default search parameters are

e Jtem

® Repair Number

® Repair Order Status
® Repair Order Owner

After filling in one or more search parameters, click Go to perform the search.
In the results area, you can hide or show details about each repair order.

Click the Repair Number link to continue processing a repair order in the Repair Order
page.

Repair Order Page Overview

The top of the Repair Order page contains general information about the item instance
that is being repaired. You can also show or hide repair order details in this region.
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C) ACLEQ Depot Repair

Repa mber 11031

Diagnostics Preferences Personalize Page Close Window
Repair Order Search >
Repair Order: 11031

Cancel | Update Status (0) | Save | Apply |

Item CSDOO1 RO Status Open
Item Description Standard Item with No Control Priority
Quantity 3 Promise Date 11-Jun-2008 23:00:00
Unit of Measure Each Repair Type Repair and Return-WIP
Serial Number Problem Description
Instance 70156 Escalation

Show Repair Order Details
Evaluation Repair Execution Debrief Report

Diagnostic Codes

Code |l|ame Applicable Fi

VLo01 Valve leaks from bonnet (d 0%
Service Codes

Recommend Services (1) | Generate Jobs (2) |

Note: You can view the Recall Number link if it's view is personalized.
Click on the link to drill down to the view-only Recall Details screen.

The main actions to perform in this page are controlled by the buttons: Save, Apply,
Cancel, and Update Status.

The main body of the Repair Order page contains three tabs - Evaluation, Repair
Execution, Debrief Report - where you perform the main repair order processing.

For more details about these tabs, select one of the following:

¢ Using the Evaluation Tab, page 9-4
* Using the Repair Execution Tab, page 9-7
¢ Using the Debrief Report Tab, page 9-12

The Notes region, at the bottom of the page, is to allow you to view and add notes.

=] Motes
Wiew MNote Type I j Go (8)
Add Note (9)
Note Type MNote Logged By Logged Date Update

Mo results found,

Cancel Update Status (0) ‘ Save Apply

Using the Evaluation Tab

The Evaluation tab enables you to examine summary information about previous repair
orders and service requests for the current repair order item instance, and also the
diagnostic codes and service codes associated with the current repair order item. After
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evaluating this information, you can generate one or more WIP jobs.

The first-ever display of the Evaluation tab for a repair order item shows the following;:

¢ All the diagnostic and service codes that have been associated with the repair order
item.

* All the repair orders that reference the current repair order item instance.

e All the service requests that reference the current repair order item instance.

The main tasks to perform in the Evaluation tab are to select - that is, mark as
Applicable - diagnostic codes and service codes to generate WIP jobs with appropriate
bills and routings.

Diagnostic Codes Region

The Diagnostic Codes region displays the diagnostic codes associated with the repair
order item, that is, the diagnostic codes that fulfill at least one of the following
conditions:

¢ The diagnostic code has the repair order item as one of its item domains.

* The diagnostic code has a category domain which is the same as the category of the
repair order item.

Diagnostic Codes

Code Mame Applicable Frequency|
DC4 Diagnostic Code 4 r 0%
DCH Diagnostic Code - 0%
DEMDC2 Demo Diagnostic Code 2 r 0%

For more information, see the topic Setting Up Diagnostic Codes in the Oracle Depot
Repair Implementation Manual.

The frequency indicates the percentage of times that the diagnostic code was marked as
Applicable in all closed repair orders that are for the same repair item.

Using the Diagnostic Codes Region

* Mark one or more of the diagnostic codes as applicable.

The applicable diagnostic codes are used in determining which service codes to use
when you click Recommend Services in the Service Codes region.

Service Codes Region

The Service Codes region initially displays the service codes associated with the repair
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order item, that is, the service codes which fulfill at least one of the following
conditions:

¢ The service code has the repair order item as one of its item domains.

® The service code has a category domain which is the same as the category of the
repair order item.

Service Codes

Recommend Services (1) || Generate Jobs (2) |

Code |name ion 3ob Frequency
RMB-001 Replace Mother Borad 8%

For more information, see the topic Setting Up Service Codes in the Oracle Depot Repair
Implementation Manual.

The frequency indicates the percentage of times that the service code was marked as
Applicable in all closed repair orders for the same repair item.

Using the Service Codes Region

1. Mark one or more service codes as Applicable.

2. Click Recommend Services.

Note: To use this feature, you must have previously set up the
recommendations. See Setting up Service Code Recommendations
in the Oracle Depot Repair Implementation Manual.

After you click Recommend Services, you may get several service codes returned
and automatically marked as Applicable in the Service Codes region, depending on
how you set up your recommendations.

When the profile option CSD: Mandate Service Code Recommendations is set to
Yes, then any service codes returned which had been set up with a
Recommendation type of Always are automatically marked as Applicable and are
disabled. This is to ensure that the service codes are used in any jobs generated
from this region.

3.  Click Generate Jobs.

For each service code marked as Applicable, Oracle Depot Repair generates a WIP
job, with any bills and routings that were previously associated with that service
code.

For more information, see Setting Up Service Codes in the Oracle Depot Repair
Implementation Manual.

4. In the Service Code table, click the hyperlinked Job number to drill into the WIP
Details. The WIP Details page provides information on the available quantity for
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the parts required on a job, the operations which are for outside repair, and other
details that are provided in WIP Jobs.

Using the Repair Execution Tab

The general objective of the Repair Execution tab is to enable you to process and
monitor the WIP jobs that you have generated for a repair order item from the
Evaluation tab of the Repair Order page.

In the Repair Execution tab, you can add materials and resources to jobs. To assist you
in doing this, Oracle Depot Repair provides you with statistics of the most common
materials and resources used in previous repair orders for the same item.

You can complete operations, and even complete jobs.

1. In the Repair Execution tab, you can also create jobs; to add
materials and resources for these jobs, use WIP pages associated
with Oracle Work In Process responsibilities.

2. Oracle Depot Repair provides E-records and E-signature (ERES)
functionality in WIP mode via Oracle WIP.

The following two new profile options are introduced:

e (CSD: Default Current Item Revision for Material Transactions
® (CSD: Default Current Item Revision for Job Completions

When the profile options are set to Yes, the current revision defaults and you are not
prompted to enter a revision. When the profile options are set to No, the revision does
not defaults and you navigate to the Material Details page to choose a revision along
with other required item details.

The two profile options behave independently, so that the revisions default for issuing
materials but not job completions, or the other way round.

Repair Operations Region

The Repair Operations region shows the operations for the current repair order item
instance, whether generated from the Evaluation tab, or created explicitly in the Repair
Execution tab.

Repair Operations

Select Operations: | Complete (1) Action | complete Job v [ %] [ 6o (2) || create 3ob (3)

Select All | Select None | Show All Details | Hide All Details

Select Details Sequence Code Due Date Department Complete  Service Code Job Item Job Status Remove
([ Shor £sD10120 CM66629 Complete
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Using the Repair Operations Region
1. Update operation details - click the Update icon for the operation.

2. Add operations to a job - select one or more operations, select the Action Add
Operation to Job, select the job from the list of values, and click Go.

3. Complete operations - select one or more operations, and click Complete.

4. Complete the job - select the Action Complete Job, select the job from the list of
values, and click Go.

5. Drill into WIP Details — Click the Job link to navigate to the Job Details page to drill
into the WIP details of the job.

Materials Region

The Materials region has two sub-regions:

¢ The general Materials area

e The Most Common Materials Issued area

Materials
Select Materials: Issue (4) Most Common Materials Issued
| Qty = Average Quantity Used
Select All | Select None
: = 3 m = — Select Material Frequency Qty UOM
Select Material Quantity to Issue UOM to Issue Job Operation Issued Quantity UOM  Serial Number Remove

O |cm13139 0 |Ea - 10 1Ea results

AS66629 1 Ea A 0z 10 1Ea

Add Another Row

The first-time display of the Materials area shows the materials automatically added to
a job through service codes.

The Most Common Materials Issued area, if populated, shows which materials were
used in previous similar repair jobs and repair orders.

Specifically, all closed repair orders for the current repair order item with completed or
closed jobs are examined. The Frequency column for a material shows the proportion of
those examined repair orders whose completed and closed jobs used the material. The
Average Quantity Used shows the average units used in all the "matching" repair
orders whose jobs contained the material, rather than in all the examined repair orders.

Using the Materials Region

1. Examine the materials in the Most Common Materials Issued area, and decide if
they are relevant to the current repair order. If so, select one or more materials, and
click Add to Materials.
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Note: You cannot add materials that already appear in the general
Materials area.

The selected materials appear in the general Materials area.

In the general Materials area, you can enter quantity and UOM values for a material
before or after it is issued to a job.

If the quantity to issue is 1 for a serialized item, you must also enter the Serial
Number for the item.

For materials added from the Most Common Materials Issued area, enter and select
values for Quantity to Issue, UOM to Issue, Operation, and Job.

Click Save to save the data you have entered so far.

If you selected an operation and job in the current session, the materials are added
to the job details, but not issued to the job; the Job field displays a link to the job.

To issue materials to a job, select one or more materials, and click Issue.

For materials that require more information, the Material Issue Details page
appears.

For example, if you want to issue more than one serialized item, you must enter the
serial numbers here. Also, if your item has lot control, you must enter the lot
number here.

After you have issued materials, the general Materials area shows the Issued
Quantity and the primary UOM.

You can continue to enter Quantity to Issue values, including negative integer
quantities.

Note: You can personalize the Materials table to enable the hidden
Revision field. The Revision field allows you to enter and transact
revision-controlled items. If the revision field is blank for a
revision-controlled item, you are directed to the Material Issue Details
page at time of issue or at time of operation or job completion for items
with Assembly Pull Supply Type.. If the revision field and all other
required fields are entered then the item is issued immediately.
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Materials

Select All | Select None
Select Material Quantity to Issue UOM to Issue Job ‘Operation Issued Quantity UOM Serial Number Revision

O ass488 1)|Ea Q
O cspoot 1|[Ea Q

Add Another Row

10 Ea
20 Ea

Remove

‘Select Material Frequency Qty UOM
o
resuts
found.

The Revision field defaults to the latest revision for revision- controlled
items if the profile option CSD: Default Current Item Revision for
Material Transactions is set to Yes. When the profile is set to No, the

revision field is not defaulted and it is left blank.

You can personalize the Materials table to display the Request Parts
button that enables a technician to create a purchase requisition for one

or more items on the Materials table.

You can personalize the Materials table to display the Material
Transaction Reason Code column that provides Disposition Code that
is used in the Eco-Impact tab of the Returns Dashboard. For more
information on the Returns Dashboard, please see: Returns Dashboard

chapter.

Resources Region
The Resources region has two sub-regions:

® The general Resources area

e The Most Common Resources Transacted area

Resources
Select Resource(s): | Transact |
Select All | Select Mang

Quantity to UOM to Transacted
Select Resource Employee Transact Transact Operation Joh Quantity LIOM
™ DLLBRz | e 0 HR 10 DEN10460 1 HR

Most Common Resources Transacted
ltern  CSDO02

Select Resourceis): | Add 10 Resources ",|
SelectAll | Select Mone

Average
Quantity
Select Resource Fregquency Used UOM
e LBR- 1 1 HR
LTASSY
T OLLBRZ ns 1 HR

The first-time display of the Resources area shows the resources automatically added to

a job through service codes.

The Most Common Resources Transacted area, if populated, shows which resources

were used in previous similar repair jobs and repair orders.

Specifically, all closed repair orders for the current repair order item with completed or
closed jobs are examined. The Frequency column for a resource shows the proportion of
those examined repair orders whose completed and closed jobs used the resource. The
Average Quantity Used shows the average units used in all the "matching" repair
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orders whose jobs contained the resource, rather than in all the examined repair orders.

Using the Resources Region

1.

Examine the materials in the Most Common Resources Transacted area, and decide
if they are relevant to the current repair order. If so, select one or more materials,
and click Add to Resources.

Note: You cannot add resources that already appear in the general
Resources area.

The selected resources appear in the general Resources area, with the Employee
field set to the value of the profile option CSD: Default HR Resource.

In the general Resources area, you can enter quantity and UOM values for a
resource before or after it is transacted to a job.

You can select a new employee.

For resources added from the Most Common Resources Transacted area, enter and
select values for Quantity to Transact, UOM to Transact, Operation, and Job.

Click Save to save the data you have entered so far.

If you selected an operation and job in the current session, the resources are added
to the job details, but not transacted to the job; the Job field displays a link to the
job.

To transact materials to a job, select one or more resources, and click Transact.

After you have transacted resources, the general Resources area shows the
Transacted Quantity and the primary UOM.

You can continue to enter Quantity to Transact values, including negative integer
quantities.

Note: When you transact the resources in the Repair Technician Portal
either by Work In process (WIP) move or manual transact, the records
are put into WIP interface tables. A WIP concurrent program then
processes it. The control comes back immediately to Repair Technician
Portal page. However, the actual transaction data is not posted to the
WIP tables immediately. Thus, if we try to import the repair actuals
from WIP immediately after completing the job, the actuals may be
incomplete at times.
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Using the Debrief Report Tab

The Debrief Report tab enables you to view certain post-repair details, such as activity
events, summary activity statistics, and key performance indicators, such as time to
repair.

You can also select one or more defect types to associate with the repair order.
Root Cause of Defect Region

Evaluation Repair Execution | Debrief Report

Root Cause of Defect

Applicable Defect Code Description
r BATTCORR Battery Carrosion
r HODELECT Hard Drive - Electrical Failure
r HODMECH Hard Drive - Mechanical Failure
r MBOMGD Motherboard Damaged
r NTF Mo Trouble Found
r RAMDMGD FA4M Module Damaged

The Root Cause of Defect region lists the defects that you can associate with the repair
order. You can optionally select one or more of the defects as applicable to the repair
order.

Defect code domain setup enables you to link each root cause code to specific items or
item categories. The Repair Technician module displays only the root cause codes that
match the item or category of the item on the repair order.

Refer to Oracle Depot Repair Implementation Guide for details on Setting Up Defect
Code Domains.
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Key Performance Indicators and Activities Regions

Key Performance Indicators

Fepair Start 19-0ct-2004
Repair Complete 19-Cct-2004
Time to Repair 0 Hours 0 Minutes

Promise Date
Late Completion

Activities
Date Event
19-0ct-2004 11:27:21 Fepair Order Status Updated
DE-How-2002 13:39:45 Shipment Completed
O&-Moy-2002 13:31:32 Job Completed
0&-Mov-2002 13:30:10 Job Submitted
D5-How-2002 13:29:15 Estimate Status Updated
05-Moy-2002 22:00:00 R4 Received

The view-only Key Performance Indicators and Activities region provides statistics
about the repair order, including a history of the repair activity events.

View Service Bulletins from the Repair Technician Module

Depot Repair automatically links a service bulletin to a repair order based on customer
defined service bulletin rules. A number of pre-defined bulletin types are seeded in the
product, but you can add any additional bulletin types to fit your business needs.
Service bulletins provide information to repair managers and technicians regarding:

® Recalls

e ECOs, FCOs, or Supercessions

® Regulatory Compliance - WEEE, RoHS, International Laws

e Parts Shortages

e Up-sells and Cross-sells

® Special Customer Entitlements, Priority, or Expedited Processing

* Processing Exceptions - Late Repair Orders, RMAs, Loaners, or Vendor Shipments
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To view service bulletins:

1. Navigate to the Repair Technician module. Query the repair order number for the
item to associate the service bulletin.
ORACLEH Depot Repair
Repair Order Search
RMA = Return Material Authorization
RO = Repair Order Save Search
SR = Service Request
Note that the search is case insensitive
Item |CSDOOL Q Repair Number Q
RO Status Q RO Owner Q,
RO Priority Q
Go Clear
<) Previous Next 10 (&
Shows All Details | Hide All Datails
Details Repair Number[Item _[Ttem Description |RO Status|RO Owner |Promise Date |RO Priority
Show1-1 CSDO01 Standard Item with Mo Control Closed Abbott, Ms. Rhonda D6-Now-2002 21:00:00
Show 10269 CSD001 Standard Item with Mo Control Closed Abbott, Ms. Rhonda
Show 11030 C5D001 Standard Ttem with Mo Control Open
Show 11031 CSD001 Standard Ttem with Mo Control Open
Show 11032 CSDO01 Standard Item with Mo Control Open
Show 11036 CSD001 Standard Item with Mo Control Open
Show 11037 C5D001 Standard Ttem with Mo Control Open
Show(11038 C5D001 Standard Ttem with Mo Control Open
2. Click on the repair order number link to navigate to the Repair Order page. The
Repair Order page displays the detailed information of the corresponding repair
order number.
ACLE" DepotRepair
Repair Number 11031 Diagnastics Prefer Window
Repair Order Search >
Repair Order: 11031
‘ Cancel | | Update Status (0) ‘ ‘ Save ‘ ‘ Apply ‘
Ttem CSDOO1 RO Status Open
Trem Description Standard Ttem with No Control Priority
Quantity 3 Promise Date 11-Jun-2008 23:00:00
Unit of Measure Each Repair Type Repair and Return-WIP
Serial Number Problem Description
Instance 70156 Escalation
Show Repair Order Details
Evaluation Repair Execution Debrief Report
Diagnostic Codes
Code |llame Applicable Frequency
VLOO1 Valve leaks from bonnet (il 0%
Service Codes
Recommend Services (1) ” Generate Jobs (2) ‘
3. In the Service Bulletins region, click Retrieve New Service Bulletins to display the

newly created service bulletins. You can view a service bulletin by Type. For

example:

You can retrieve multiple service bulletins within one repair order. In this case,

one repair order triggers multiple service bulletins.
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® You can retrieve service bulletin for Chronic Repair Order. Set the profile CSD:

Number of Days in Quality Check period to use this feature.

Note: The Depot Repair Service Bulletin Retrieval concurrent
program checks the set of applicable repair orders and links any
service bulletins which apply to them and have not already been
linked. This supports business scenarios that need to check all open
repair orders for service bulletin applicability. This concurrent
program scans a selected set of open repair orders based on
parameters such as:

e Service Bulletin Type

® Repair Order Status

® Repair Order Inventory Organization
® Repair Organization

* Repair Order Item

4. Select a service bulletin and click Show to display the following details:

=| Service Bulletins

Last Retrieved on  11-Jun-2008 20:55:35

Type || Go

Select Service Bulletins: | Mark as Viewed |w|| Go | | | Retrieve New Service Bulletins |

select All | Select None

Select Details Name ‘Descript'mn Type Mandatory | Attachment | Viewed
[0 [=Hide Demo Service Bulletin Demo Service Bulletin Bulletin ¥ T v

Viewed By Mr. Phillip C. Taylor
Viewed Date 11-Jun-2008

Service Code Name Description

RBO11-A Repair bonnet Valve leak in bonnet - Repair
[] @ Show NS Test 1 Bulletin i}
O @ sho Regular Com Test Bulletin
[ 2 Show Test 2 Bulletin
[0 [®Show ECO Service bulletin with attachment ECO Service bulletin 2 ECO 'ﬁ
[J @ 5how service Bulletin Late Repair Order Service Bulletin Late Repair Order Notification

P p

The Mandatory flag represents that the service bulletin is marked as mandatory
in the setup stage. This also indicates to the repair technician that this service
bulletin is mandatory.

The Attachment icon represents that an attachment is added to the service
bulletin. Click the attachment to download the attachment.

The Viewed flag represents you have selected the service bulletin to Mark as
Viewed from the list of values at the time when the service bulletin was set up.
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You can view who has viewed the service bulletin and the date of viewing. You
can mark a service bulletin as unviewed by selecting Mark as Unviewed.

It enables a service organization to capture whether or not a technician has
viewed and complied with a bulletin that contains an instruction. No
enforcement for this exists within the application, but this provides a tracking
mechanism if you choose to enforce it.

® The Service Code represents that a service code is linked to the service bulletin.

5. Navigate to the Service Codes region. The selected Applicable checkbox represents
that a service code is linked.

These service codes are attached to the service bulletin on the setup page. When
you retrieve the service bulletin and attach it to an RO, if any of the service codes
linked to the service bulletin at time of bulletin setup are valid for the repair item
and inventory organization then the Applicable checkbox on the Service Codes
region of the Evaluation tab is checked.

6. At this point, repair technicians can generate jobs from these service codes by
clicking Generate Jobs. Once you generate a job, the job number displays in the Job
column and the Applicable checkbox is disabled.

Service Codes
Recommend Services (1) | Generate Jobs (2)
Code |Name | Applicable ‘Rec dation |Job Frequency

RHD-001 Replace Hard Drive ] 0%
RBO11-A Repair bonnet CSD11209 0%

Manage ECOs

Engineering Change Orders (ECO) occur when a product has a fault, or when the
technical team designs a better way to build it, finds better parts, or regulators specify
that certain parts cannot be used anymore. Under these circumstances, the technical
team creates a new revision of the master plan for the parts included, the technique to
manufacture, or repair an item. Technically, this process requires the creation of new
bills of material, route and/or service code.

In Depot, the following two steps occur in the processing of an ECO:

® A Service Bulletin notifies the repair technician that an ECO exists for the item (the
repair technician pushes the Check ECO button).

¢ The service bulletin automatically applies the specific service code to the repair for
taking the ECO.

Note: If the ECO is applied already, the profile stops the notification
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from triggering each time, assuming you have already applied the ECO
the first time you were notified. This prevents you from receiving
constant notifications.

When a repair job is created from the Evaluate tab of the Repair Tech Portal, it uses the
service code from the bulletin. Thus when the repair technician goes to the Execute tab
in the Repair Tech Portal, he will see the parts and operations that the ECO requires.

Backflush Non Serialized Repair Parts

Backflushing implies automatically performing an inventory material transaction
whenever an operation is completed or whenever a job is completed. There are two
Supply Type setup options in Inventory/BOM that allow backflush:

¢ Assembly Pull: Assembly Pull issues the material to the job when the job is
completed

®  Operation Pull: Operation Pull backflushes the item when the Operation is
completed.

If either of these values are chosen for the supply type, then the item backflushes, if its
non-serialized. This function reduces the repair technician clicks on jobs where
components are not tracked serially.

Auto-Issue Repair ltems to Jobs

The high volume repair centers mostly create a single job for any item they repair.
When an item is repaired using a WIP job, the item must be issued to that job, and when
the job is completed the same item is transacted to the WIP completion subinventory.

Auto-issue repair item to jobs feature enables a depot to automatically add the repair
item as material demand for a job, thus freeing repair technicians from additional data
entry.

Using Time Clock

A repair technician works on repairs from his queue. To begin work, a technician selects
the next physical item on the cart or shelf, takes that item to work area, and queries the
repair order in the system by scanning or entering the serial number. One option is to
start the clock automatically once a repair order opens and the other option is to punch
in work starts. The Time Clock functionality enables a technician to clock in and clock
out the time for a repair. The system tracks the amount of time a technician spends
clocked in on a repair and automatically capture that time as a resource transaction. The
technician need not manually track time spent on a job or enter information into the
system. The technician can pause the clock when taking breaks and allocate time to

Executing Repairs using the Repair Technician Module 9-17



different operations.
Time clock facilitates a repair technician in the following ways:

¢ It enables the technicians to mark the start time of a repair. This time is logged in
the system. This is triggered by opening the repair or by manually clocking in.

® It enables the technicians to clock out a repair. You may clock out for various
reasons: lunch break, resource shortage, missing parts, and the like. Clock out stops
the clock but no other actions are triggered. This time is logged in the system.

*  When a repair is finished, technicians perform many actions like: complete
operations, complete jobs, log labor hours, transact resources, issue materials,
change repair status, or kick off a workflow. The Complete Work button enables
them to stop the clock and trigger these actions automatically.

The Repair Technician page contains a header level bin named Time Clock that
facilitates clock in and clock out.

Repair Ordar Search »
Repair Order: 10989

Cancel Complete Work Update Status (0) Save Apply

Personalize Stack Layout: (MainRIy
Personalize 'Repair Orcler Context Region”
Personalize Table Layout: (ROCantextinfoThiLayoutRhy
Time Clock

Personalize Stack Layout: (ContextinfStackl ayoutRN; Personalize Flow Layout:

m CSDO01 RO Status Open (TimeCiockFormyalRi)
Item Description - Standard Item with No Control Priority
Quartity 1 Promise Date Current Job [CSD10347 Q
Unit of Measure Each Repair Type Repair and Return-wip
Serial Number Problem Description CCEtg 10 Q
Instance 2020078 Escalation work Startect
) ie Repair Order Detalls Lesticlemiesl i
External Reference Number RO Owner  Anderssan, Miss Lena st Cllad iz it
Repair Number 10989 Repair Orgarization Repair Center-west Clock In
SR Nurnber - 52780 Problem Code

Probiem Code Description Personalize Flow Layout:

(TimeClockStatsFor myalR)

The Time Clock bin has the following layout:
Operation

e This field defaults to the first operation on the Operations table.

¢ If no operation exists, this field is left blank but defaults to operation 10 when
creating Resource lines. You can select different operation from the list of values but
you cannot select an operation outside of the Operations table.

*  You can update the Operation LOV before you clock in your time. You cannot
update an operation once you clock in as the clock in time operates against a

specific operation.

® Operation LOV displays operations sequentially.

Work Started
e Work Started field displays the first clock in time for a technician.

* You can view the work-started time for your repair order only.
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Last Clocked In

¢ This timestamp displays the last recorded clock in time and date for the current
technician.

e This field is blank for the first time the technician opens the repair order.
®  When you clock in the time, this field reflects this new clock in time.

*  When you clock in the second time, the original clock in time is overwritten with
the new time.

Last Clocked Out

e This timestamp displays the last recorded clock out time and date for the current
technician.

¢ This field is blank of you are clocking out for the first time.
*  When you clock out, this field reflects this new value.

*  When you clock out the second time, the original clock out time is overwritten with
the new time.

Clock In and Clock Out
® Clock In and Clock Out are same buttons with toggled text.

e This button displays Clock In when the clock is stopped and Clock Out when the
clock is running.

* You can clock in / clock out against a particular job multiple times.

¢ Clock In button creates your record in the Resource Time table for the repair order,
resource item, resource name, operation, and clock in time.

e Clock Out button updates the clock out time for your record in the Resource Time
table for the repair order, resource item, resource name, operation and clock out
time.

*  You can clock in and clock out when there is no job or operation. The system
assumes that all the time accrues to the first job created.

Note: If you fail to clock in or clock out you can notify the manager.
The manager then opens the repair order and adjusts the total labor
on the Resources table and updates the repair order status. This
assumes that personalization is used to restrict access to the
Resource table. In the absence of this personalization, you can add
or remove resource time from the table.
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Next

This button permits to clock out from current operation and clock in to the next one.

The button is enabled when you clock in the first time and it is disabled when you
clock in to the final operation for a repair order.

This creates a new resource record in the Resource table. The Operation LOV gets
updated to the next operation in the sequence. If more than one operation exists, the
sequence is to complete all operations on the lowest job number first, then the next
lowest job number operations and so on.

A new clock in record is also created for the resource item, resource name and new
operation.

The Repair Technician page contains a header level button named Complete Work that
enables you to stop the clock and trigger various actions like: complete operations,
complete jobs, log labor hours, transact resources, issue materials, change repair status,
or kick off a workflow.

This button is enabled using personalization.

When you click this button, materials, resources, operations, and jobs are processed
first. Then the status is updated which triggers the workflow.

Clicking this button automatically clocks out the technician if it is not done already.

When issuing serialized items, you have to manually capture the serial number
before clicking Complete Work button.

This button processes only the un-issued items, transacts only the un-transacted
resources and completes the un-complete operations or jobs.

Note: Both the Time Clock bin and Complete Work order button
are enabled by personalization.
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Booked, status, 2-14, 2-17
A business process flows, 1-6

access Depot Repair, 2-2

accounting class, field, 2-33 C
Actual Qty for Tasks, 2-37 charge line
Actual UOM for Tasks, 2-37 add new, 2-27
additional item, ship, 4-69 delete a charge line, 2-27
advanced exchange edit, estimate, 2-27
repair type, 1-4 estimate details, 2-28
Advanced Scheduler, integration with, 1-11 Charges, integration with, 1-15
advance exchange close
process, 3-6 repair order, 4-121
all contracts, 2-45 service request, 4-122
approval Closed, field, 2-7
forced, 2-11 Completion Transactions window, 4-90
obtain customer, 4-63 concurrent program
Assignment Manager Customer Profile Engine, 4-4
icon, 2-37 contact
integration with, 1-12 create customer, 4-9
audit enabling creation of, 2-38
history log, 2-38 Contact, field, 2-6
track task update, 4-97 Contact ID, field, 2-6
Audit, 2-38 contact information, service request, 2-5
Auto-Issue contract
repair items, 9-17 default repair order, 2-29
auto-receive, 4-69 end date, 2-46
entitlement, 2-45
B selected at service request level, 2-46

start date, 2-46

view active, 2-45

view all, 2-45

view coverage of service, 2-46

Backflush

non serialized repair parts, 9-17
billing category, 2-25
Bills of Material, integration with, 1-12

Index-1



Contract Num, field, 2-46
Contracts, integration with, 1-12
counter, history issues, 1-13
Counters, integration with, 1-12
coverage, field, 2-46
create

customer contact, 4-9

manual ship line, 4-103

notes, 4-37

repair order, 4-17

repair task, task template, 4-94

repair task manually, 4-92

repair tasks, 4-90

RMA manually, 4-26

WIP repair job, multiple orders, 4-85

WIP repair job, single order, 4-80
Created, status, 2-14, 2-17
currency

field, 2-10

in estimate, 2-26

single, in repair order, 2-27

support within service request, 2-27
customer

approval, obtain, 4-63

contact, create a, 4-9

data store, about, 1-3

information, service request, 2-5

invoice, 4-120

management, about, 1-2

profile, 1-2

profile, engine, 1-15

profile, integration, 1-15

profile, open service request, 4-4

profile, review, 2-3

profile, view, 2-42, 4-4
Customer Care, integration with, 1-15
Customer Profile, integration with, 1-15
Customer Profile Engine concurrent program, 4-
4

D

date closed
field, 2-10
repair order field, 2-47
service request field, 2-47
Date Created, field, 2-10

Index-2

date opened

repair order field, 2-47
service request field, 2-47

debrief

invoice based on, 4-98
prepare repair tasks, 4-98

Debrief button, 2-37
Default check box, 2-45
Default PO Num

field, 2-10

Define Triggers

service bulletins, 2-55

Dependencies, 2-38
Depot Repair

customer management, 1-2
key features, 1-2

manage processes, 4-3
relationship management, 1-2
whatis, 1-1

Depot Repair Workbench

about, 1-2, 2-3

Diagnostics tab

about and using, 4-39

Dynamic Repair BOM

E

select repair parts, 4-131

end date

contract or warranty, 2-46

Entered, status, 2-14, 2-17
escalated service request, 4-4
estimate

approval statuses, 2-8

create repair, 4-57

currency, 2-26

default repair order contract, 2-29
detail worksheet, 2-27

editable fields, 2-28

edit charge lines, 2-27

enable or disable, 2-24

expenses required, 2-26

fields of repair, 2-24

forced approval step, 2-11

freeze, 2-41

in repair process, 1-1

in repair resolution management, 1-6



labor required, 2-26

launch worksheet of, 2-24

line details area, 2-28

logistics and maintenance, 1-7

no charge, 2-26, 2-30

notes, 2-27

override charge, 2-26, 2-29

profile option, repair, 2-24

reason code, 2-25

recommended entry of charges, 2-16

repair, multi-record fields, 2-25

repair charges, 4-54

required material, 2-26

revise repair, 4-62

save, 2-30

save header and charge lines, 2-27

statuses, 2-24

summary of charges, 2-26

totals, 2-26

transactions to complete repair, 2-24
Estimate Approval Required, 2-11
Estimate Approved, field, 2-8
estimated charges fields, 2-26
Estimate Qty for Tasks, 2-37
Estimate UOM for Tasks, 2-37
Event, 2-48
exchange

process, 3-5

process advance, 3-6

repair type, 1-4
Execute Repair, 2-58
expense

billing category, 2-25

captured to complete task, 2-37

debrief a job, 4-98

enter required information, 4-100

required in estimate, 2-26

subtotal of estimated, 2-26

tab, in Debrief Report, 4-99

total in estimate, 2-26

F

Field Service, integration with, 1-13
Find Discrete Jobs window, 4-89
freeze estimate

See also frozen estimate., 2-41

specify, 2-41

G
General Ledger, integration with, 1-13

H

history
audit log, 2-38
audit of tasks, 4-97
counter issues, 1-13
detailed service, 1-3
message, repair order, 4-103

message, view, 2-42
note about Installed Base product service, 4-7
product service, 2-2, 4-7
view message, 2-42
view product service, 4-7
window, service, 2-46
HRMS, integration with, 1-13

IB Ref Num, field, 2-7
Installed Base
display of product information, 2-45
note about product service history, 4-7
Installed Base, integration with, 1-13
Installed Products Only, check box, 2-5
Installed Site, field, 2-10
Instance, field, 2-9
Instance number, in service request, 4-13

integration with other Oracle modules, 1-11
internal repairs business flow, 1-7
inventory

logging service request for products in, 4-13
Inventory, integration with, 1-13
invoice

about, 1-1

based on debrief value, 4-98

create with loaner, 1-4

customer, 4-120

repair and return, 1-4

use with Order Management, 1-14
iSupport, integration with, 1-14
item

auto-receive, 4-69
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receive general, 4-65
receive refurbishment, 4-70
ship, 4-105

ship refurbishment, 4-109

J

job status, field, 2-33

K

Knowledge Management
database, about, 1-3
integration with, 1-14

L

labor
billing category, 2-25
captured to complete task, 2-37
charging and invoicing, 1-1
debrief a job, 4-98
enter required information, 4-100
log using the Debrief Report, 1-16
required in estimate, 2-26
subtotal of estimated, 2-26
tab, in Debrief Report, 4-99
total in estimate, 2-26
transfer for invoicing, 1-7

Launch Workflow, 2-37

loaner
about invoicing customer, 1-4
repair and return, process, 3-3
repair and return repair type, 1-4
repair type, 1-4

logistics maintenance
with call center business flow, 1-6
without call center business flow, 1-7

Lot Num, field, 2-10

maintain
notes, 4-37
manage
repair process, 4-79
Manage ECO, 9-16
mandatory for repair process, 4-12
material

Index-4

billing category, 2-25
captured to complete task, 2-37
debrief a job, 4-98
enter required information, 4-100
required in estimate, 2-26
subtotal of estimated, 2-26
tab, in Debrief Report, 4-99
total in estimate, 2-26
message
history, view, 2-42
view history of, 2-42
messaging
workflow-based, 4-103
Move Items Internally, 4-29
multiple order
create WIP repair jobs, 4-85
process WIP repair jobs, 4-88

N

no charge, estimate, 2-26, 2-30
note

create, 4-37

display, 2-12

estimate, 2-27

maintain, 4-37
Notes, integration with, 1-14
number, service request, 2-47

(0

Opened, field, 2-7
order

WIP, create repair job, 4-80

WIP, process single repair job, 4-83
Order Management

integration with, 1-14

invoice customer, 1-14

status of order number, 2-14, 2-17
Outside Processing

execute, 4-131
override charge, estimate, 2-26, 2-29

P

Parameters
setup, 1-7
Phone, field, 2-6



prepare, repair tasks debrief, 4-98
Price List

field, 2-10
Pricing, integration with, 1-14
product

coverage, view information, 4-5

field, 2-7

log service request for, 4-13

service, view history of, 4-7
Product Description, field, 2-8
profile

customer, 1-2

tool, 2-42

view customer, 4-4
Promise Date, field, 2-10
Purchasing, integration with, 1-15

Q

Qty Completed in WIP, 2-48
Qty Received, 2-48

Qty Shipped, 2-48

Qty Submitted to WIP, 2-48
Quantity, field, 2-8

R

Recalls

corrective actions tab, 6-9

create, 6-3

details tab, 6-5

find, 6-12

items tab, 6-6

metrics tab, 6-11

overview, 6-1

process flow, 6-2
Receivables, integration with, 1-15
receive

auto-receive, 4-69

general item, 4-65

refurbishment item, 4-70
Recurrences, 2-38
Reference, 2-38
refurbishment

process, 3-8

receive, 4-70

ship, 4-109
refurbishment repair type, 1-5

Relationship, field, 2-6
relationship management, about, 1-2
Released, status, 2-14, 2-17
repair
and return, process, 3-1
charges, estimate, 4-54
create manual ship line, 4-103
create task from task template, 4-94
create task manually, 4-92
estimates, create, 4-57
estimates, revise, 4-62
invoice customer, 1-14
invoicing with repair and, 1-4
loaner and return process, 3-3

order. See repair order or repair job., 4-102

prepare task debrief, 4-98

tasks, create, 4-90

WIP, create job single order, 4-80

WIP, create multiple repair orders, 4-85

WIP, process multiple repair orders, 4-88

WIP, process single order, 4-83
repair and return
repair type, 1-4
repair depot, manage processes, 4-3
repair estimate
fields, 2-24
multi-record fields, 2-25
See also estimate., 2-24
statuses of, 2-24
repair job
management, tasks, 1-5
management, WIP, 1-5
See also repair order., 2-49
submit, 2-49
Repair Manager Portal
Advanced Search, 5-4
overview, 5-1
Quality Event Watchlist, 5-3
Repair Manager Portal page, 5-2
Repair Order Backlog, 5-2
setting up aging threshold, 5-8
setting up quality threshold, 5-10
using the create repair order page, 5-7
Repair Num, field, 2-8
repair order
Activity window, 2-48
Actuals tab, 2-38
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close, 4-121
Coverage window, 2-45
create, 4-17
created against service request, 4-17
currency support, 2-27
Details tab, 2-9
Diagnostics tab, 2-21
fields, 2-47
Find Repair Orders for Job Submission, 2-49
information area, 2-8
link, 2-46
Logistics tab, 2-12
message history, 4-103
Repair Estimate tab, 2-24
Repair Jobs tab, 2-30
Repair Tasks tab, 2-35
Service History window, 2-46
show history, 4-8
split, 4-76
status, 2-10, 2-12
update concurrently, 4-102
view related activities, 4-100
window tools, 2-41
Repair Owner, field, 2-10
repair process
manage, 4-79
mandatory service request, 4-12
repair resolution management, 1-6
repair status, field, 2-8
repair type
about, 1-3
advanced exchange, 1-4
exchange, 1-4
field, 2-8
loaner, 1-4
loaner, repair and return, 1-4
processing, 1-3
refurbishment, 1-5
repair and return, 1-4
replacement, 1-5
standard, 1-5
replacement
process, 3-7
repair type, 1-5
request information, service request, 2-5
Request Num, field, 2-7
Request Type, field, 2-8
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Resource Manager, integration with, 1-15
Resources, 2-38
return and repair process, 3-1
return materials authorization. See RMA., 1-4
Return only repair
process, 3-10
return product
option, 2-13
Returns Dashboard
BI page overview, 7-2
eco-impact tab, 7-4
overview, 7-1
returns tab, 7-3
Revision, field, 2-7
revision status, 2-11
RMA
automatically enter and book, 2-11
book a, 2-12
Charges, 1-15
completion of line, 1-7
create, manually, 4-26
create and view lines, 2-12
displays number, 2-14
internal repairs, 1-7
loaner, 1-4
loaner, repair, and return, 1-4
option, action to receive, 2-13
Order Management, 1-14
partial quantities, 4-83
quantity received, 2-48
repair and return, 1-4
repair job without, 4-80

S

search
job submission, 2-49
Send Message tool, 2-42
Serial Num, field, 2-7
serial number
changes to, 1-13
for serialized products, 4-14
of repaired item, 2-9
product information field, 2-7
service
detail history of, 1-3
field, 2-46



history of product, 2-2
history window, 2-46
product, history of, 4-7
view contract coverage, 2-46
Service Bulletins
view using Depot Repair Workbench, 4-134
view using Repair Technician Module, 9-13
service history
view, 2-46
service history window, 4-8
service request, 4-12
access knowledge repository, 1-14
apply contract, 4-98, 4-112, 4-116
assigns by owner, 2-8
automatically create, 2-3
builder, 1-3
close, 4-122
contact for, 4-9
contact information fields, 2-5
contract selected, 4-5
create, 4-12
currency support, 2-27
customer information fields, 2-5
details, 4-6
escalated, 4-4
fields, 2-47
filter view of notes, 2-12
for products in inventory, 4-13
in business flow, 1-7
information area, 2-5, 4-13
Instance reference number, 4-13
internal repairs, 1-7
key management processes, 1-3
linked repair order field, 2-48
log, 1-2, 4-3
management, about, 1-2
new contact, 4-10
note about profile, 4-13
number, link, 2-46
open, 1-2, 4-4
override selected coverage, 2-45
quick menu, 2-2
repair orders created against, 4-17
Repair Orders window, 4-13
request information fields, 2-5
save, 4-15
selected contract at level of, 2-46

show details, 4-99

SR Owner field, 4-14

view activities against, 4-23
view all, 4-7

Service Requests, integration with, 1-15

severity

field, 2-8

service request field, 2-47
ship

additional items, 4-69

item, 4-105

refurbished item, 4-109
Shipped, status, 2-14, 2-17
single order

create WIP repair job, 4-80

process WIP repair job, 4-83
split repair order, 4-76
SR Owner, field, 2-8
standard repair type, 1-5
start date

contract or warranty, 2-46
status

active Order Management order number, 2-14,

2-17
Booked, 2-14, 2-17
change replaced product, 1-5
Created, 2-14, 2-17
current task, 2-36
Entered, 2-14, 2-17
estimate approval, 2-8
field, 2-8
Issued, 2-14, 2-17
Job Status, 2-33
query order, 1-2
Received, 2-14, 2-17
Released, 2-14, 2-17
repair order, 2-10
repair order (RO), 2-12
repair order field, 2-47
revision, 2-11
service request field, 2-47
Shipped, 2-14, 2-17
WIP repair job, 2-30
Summary, field, 2-7

T
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task
audit trail (history), 4-97
create repair, 4-90
create repair, manually, 4-92
current status, 2-36
enter and update details of, 4-96
prepare repair, debrief, 4-98
repair job management, 1-5
track update (audit), 4-97
Task Manager, integration with, 1-16
task template, create repair task from, 4-94
TeleService
APIs, 1-15
TeleService, integration with, 1-15
Third party flows, 4-124
Third Party Repair
process, 3-10
Time Clock, 9-17
Traveler Document
print, 4-133
type
field, 2-47
repair order field, 2-47
service request field, 2-47

U

unit of measurement. See UOM., 2-8
Unplanned Returns
receive, 2-58
UOM, field, 2-8
Update Counters, 2-11
Update RO Status, 2-12
urgency
service request field, 2-47
Use Template, 2-37

\'

view, 2-45
active contracts, 2-45
activities related to repair order, 4-100
coverage, service contract, 2-46
customer profile, 4-4
product coverage information, 4-5
product service history, 4-7

View IB Config, 2-11

View Message History tool, 2-42

Index-8

warranty

end date, 2-46
start date, 2-46

Warranty Status, field, 2-10
WIP

create repair job, multiple orders, 4-85
create repair job, single order, 4-80
process repair job, multiple orders, 4-88
process repair job, single order, 4-83
repair job, current status, 2-30

repair job management, 1-5

WIP Jobs and Schedules window, 4-90
WIP Material Transaction Find window, 4-89
workflow

messaging, based on, 4-103

Work in Process

integration with, 1-16
See also WIP., 1-5



	Oracle Depot Repair User Guide
	Preface
	Introduction to Oracle Depot Repair
	What is Oracle Depot Repair?
	Oracle Depot Repair Key Features
	Business Process Flows
	Setup Parameters
	Integration with Other Oracle Modules

	Overview of Using Oracle Depot Repair 
	Accessing Oracle Depot Repair
	The Depot Repair Workbench
	The Service Request Information Area
	The Repair Order Information Area
	Details Tab
	Logistics Tab
	Diagnostics Tab
	Repair Estimate Tab
	Repair Jobs Tab
	Repair Tasks Tab
	Repair Actuals Tab
	Drill into Order Management
	Depot Repair Workbench Tools Menu 
	Depot Repair Workbench Data Menu 
	Find Repair Orders for Job Submission Window
	Submit Repair Jobs for Repair Orders Window
	Define Triggers for Service Bulletins
	Receive Unplanned Returns
	Execute Repair

	Oracle Depot Repair Business Scenarios
	Process a Repair and Return
	Process a Loaner, Repair and Return
	Process an Exchange
	Process an Advance Exchange
	Process a Replacement
	Process an Internal Order Refurbishment
	Process a Third Party Repair
	Process a Return Only Repair

	Depot Workbench
	Overview of Managing Business Processes
	View Customer Profile
	View Coverage Information
	View Service History
	Determine Contract and Price List Defaults at Repair Order Creation
	Create a Customer Contact
	Create a Service Request
	Find a Customer for an Installed Base Item
	Create a Repair Order in the Depot Repair Workbench
	Create a Repair Order Starting From Oracle TeleService
	Create a Repair Order Starting From Oracle Order Management
	Update the Repair Order Status
	Update the Repair Type of a Repair Order
	Create and Book a Return Line Manually
	Move Items Internally
	Find Service Requests and Repair Orders
	Transfer Install Base Ownership
	Create and Maintain Notes
	Use the Diagnostics Tab and Oracle Knowledge Management
	Manage Diagnostic Codes in the Diagnostics Tab
	Search Oracle Knowledge Management
	Manage Solutions in the Diagnostics Tab
	Manage Service Codes in the Diagnostics Tab
	Select Service Codes Manually in the Service Codes Area
	Activate and Deactivate Service Codes in the Service Codes Area
	Delete Service Codes in the Service Codes Area
	Estimate Repair Charges
	Create a Repair Estimate
	Revise a Repair Estimate
	Obtain Customer Approval for a Repair Estimate
	Receive a General Item
	Ship Additional Items
	Auto-Receive an Item 
	Receive an Item for an Internal Order Refurbishment 
	Split a Repair Order
	Manage the Repair Process
	Create and Process WIP Repair Jobs
	Create a WIP Repair Job for a Single Repair Order
	Process a WIP Repair Job for a Single Repair Order
	Create a WIP Repair Job Across Multiple Repair Orders
	Process a WIP Repair Job Across Multiple Repair Orders
	Create and Process Repair Tasks 
	Create a Repair Task Manually
	Create a Repair Task Using a Task Template
	Enter and Update Task Details
	Prepare the Repair Tasks Debrief
	View Activities Related to a Repair Order
	Update Repair Orders Concurrently
	Send and View Workflow-Based Messages
	Create a Ship Line Manually
	Ship a General Item
	Ship a Refurbished Item
	Record Billing Data in Repair Actuals
	Add WIP Summary to Repair Actuals
	Add Task Debrief to Repair Actuals
	Add Estimate to Repair Actuals
	Create Manual Charges in Repair Actuals
	Book Repair Actuals
	Invoice a Customer
	Close a Repair Order
	Close a Service Request
	Create and Process an Internal Party Refurbishment
	View Repair Orders in Oracle iSupport
	Third Party Flows
	Execute Outside Processing
	Select Repair Parts from Dynamic Repair BOM Window
	Print Traveler Document
	View Service Bulletins using Depot Repair Workbench
	View Read Only Workbench 

	Repair Manager Portal
	Overview
	Repair Manager Portal Page
	Using the Repair Order Backlog region
	Using the Quality Event Watchlist region
	Using the Advanced Search page
	Using the Create Repair Order page
	Setting Up Aging Threshold
	Setting Up Quality Threshold

	Recalls
	Overview
	Recall Process Flow
	Creating a Recall Event
	Using the Details Tab
	Using the Items Tab
	Using the Corrective Actions Tab
	Using the Metrics Tab
	Finding a Recall

	Returns Dashboard
	Overview
	Returns Business Intelligence Page Overview
	Using the Returns Tab
	Using the Eco-Impact Tab

	Receiving Returns using the Bulk Receiving Module
	Overview
	Entering and Processing Bulk Receive Data
	Bulk Receive Items Processing Logic

	Executing Repairs using the Repair Technician Module
	Overview
	Searching for Repair Orders
	Repair Order Page Overview
	Using the Evaluation Tab
	Using the Repair Execution Tab
	Using the Debrief Report Tab
	View Service Bulletins from the Repair Technician Module
	Manage ECOs
	Backflush Non Serialized Repair Parts
	Auto-Issue Repair Items to Jobs
	Using Time Clock

	Index


